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Peachtree Software License Agreement
The following states the license agreement that governs your use of this product. You 
acknowledge and accept this agreement by proceeding with the installation of this 
computer software from disks or CD-ROM.

LICENSE

PLEASE READ CAREFULLY THIS LICENSE AGREEMENT BEFORE CLICKING THE 
ACCEPT BUTTON BELOW. PROCEEDING WITH THE INSTALLATION OF THIS 
COMPUTER SOFTWARE INDICATES YOUR ACCEPTANCE OF THE TERMS OF 
THIS LICENSE. IF YOU DO NOT AGREE WITH THESE TERMS, YOU SHOULD 
CANCEL THE INSTALLATION PROCESS AND RETURN THE PACKAGE AND ITS 
CONTENTS TO PEACHTREE SOFTWARE WITHIN SIXTY (60) DAYS, AND YOUR 
MONEY WILL BE REFUNDED.

Peachtree Software, Inc. ("Peachtree"), provides the computer software program(s) and 
documentation (printed manuals, guides, bulletins, and/or online Help) contained in the 
package and any modifications, updates, revisions, or enhancements received by you 
from Peachtree or its dealers (the "Program") and licenses its use under the terms 
below.

a. You are granted a nontransferable license to use the Program under the terms 
stated in this Agreement for personal use in your business or profession. Title and 
ownership of the Program and of the copyright in the Program remain with 
Peachtree.

b. You may not make copies, translations, or modifications of or to the Program, 
except you may copy the Program into a machine-readable or printed form for 
backup purposes in support of your use of the Program. You must reproduce the 
copyright notice on any copy of the Program or portion of the Program merged into 
another program. All copies of the Program and any portion of the Program merged 
into or used in conjunction with another program are and will continue to be the 
property of Peachtree and subject to the terms and conditions of this Agreement.

c. If you purchased a single-workstation license of the Program, this license is for use 
of the Program on one workstation. You must purchase a license to use the 
Program for each additional workstation on which the Program will be installed or 
accessed.

d. If you purchased a multiple-workstation license of the Program, this is a single-site 
license. The Program may be placed on a local network system, which connects 
multiple workstations located at a single site. Use of the Program at additional sites 
requires the purchase of additional site licenses. 

e. You may not assign, sell, distribute, lease, rent, sublicense, or transfer the Program 
or this license or disclose the Program to any other person. You may not reverse-
engineer, disassemble, or decompile the Program or otherwise attempt to discover 
the source code or structural framework of the Program.

f. This license terminates if you fail to comply with any provision of this Agreement. 
You agree upon termination to destroy the Program, together with all copies, 
modifications, and merged portions in any form, including any copy in your 
computer memory or on a hard disk.

LIMITED WARRANTY

Peachtree warrants that the Program substantially conforms to the specifications 
contained in Peachtree’s packaging and promotional materials for a period of sixty (60) 
days from delivery as evidenced by your receipt, provided that the Program is used on 
the computer operating system for which it was designed. Peachtree further warrants 
that the media on which the Program is furnished will be free from defects in material or 
workmanship for a period of sixty (60) days from delivery. All warranties stated in this 
Agreement apply only when the Program is used within the United States of America 
and its territories. Peachtree’s sole obligation and liability for breach of the foregoing 
warranties shall be to replace or correct the Program so that it substantially conforms to 
the specifications or to replace the defective media, as the case may be. 



Any modification of the Program by anyone other than Peachtree voids the foregoing 
warranty. NO OTHER WARRANTIES ARE EXPRESSED AND NONE SHALL BE 
IMPLIED. PEACHTREE DOES NOT WARRANT THAT THIS SOFTWARE IS FREE OF 
BUGS, VIRUSES, IMPERFECTIONS, ERRORS, OR OMISSIONS. PEACHTREE 
SPECIFICALLY DISCLAIMS AND EXCLUDES ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. SOME 
STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE 
FOREGOING MAY NOT APPLY TO YOU.

Support

Peachtree will support the current version of this software and any previous versions 
that Peachtree elects to support. However, due to the constantly changing environment 
of personal computer technology, previous versions may become inoperable or 
incompatible with current operating systems, hardware, or other technologies. For you 
to continue to operate successfully, it may be necessary to purchase an upgrade. Free 
support is provided for thirty (30) days after Product registration. Any subsequent 
support requires purchase of a support option, as outlined in the package or on our web 
site.

Tax Updates

Likewise, changes in state, federal, or local tax laws may render this software, or 
previous versions, obsolete. To continue to operate successfully, it may be necessary 
for you to purchase an update. In addition to these fees, Peachtree may require you to 
purchase an upgrade to a current version of the Program as tax laws change. Peachtree 
does not update versions of the Program that are not shipping at the time of a change 
in tax laws.

RECOMMENDED ENVIRONMENT

This Program has been designed to work optimally in the environment documented 
within the system requirements. Any defects, inconsistencies, or issues arising out of 
operating outside the parameters set forth therein may require the licensee to pay 
additional maintenance/upgrade costs to Peachtree to support and/or rectify.

LIMITATION OF LIABILITY

IN NO EVENT SHALL PEACHTREE’S LIABILITY TO YOU FOR DAMAGES 
HEREUNDER FOR ANY CAUSE WHATSOEVER EXCEED THE AMOUNT PAID BY 
YOU FOR USE OF THE PROGRAM. IN NO EVENT WILL PEACHTREE BE LIABLE 
FOR ANY LOST PROFITS OR OTHER INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM 
EVEN IF PEACHTREE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.

U.S. Government Restricted Rights

The Program is provided to the Government with RESTRICTED RIGHTS. Use, 
duplication, or disclosure by the Government is subject to restrictions set forth in 
subdivision (c) (1) of The Rights in Technical Data and Computer Software clause at 
252.227-7013. Contractor/Manufacturer is Peachtree Software, Inc., 1505 Pavilion 
Place, Norcross, GA 30093. 

This Agreement is governed by the laws of the state of Georgia. In the event that any 
provision of this Agreement is found invalid or unenforceable pursuant to judicial decree, 
the remainder of this Agreement shall be valid and enforceable according to its terms. 
PEACHTREE and PEACHTREE SOFTWARE are registered trademarks of Peachtree 
Software, Inc.
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Introducing and Installing Peachtree Accounting
Getting Started Guide1
• Introducing and Installing 
Peachtree Accounting •

Introducing Peachtree Complete Accounting Release 7

Welcome to Peachtree Complete Accounting—the award-winning 
accounting solution for small business success. Peachtree Complete 
Accounting contains all the powerful accounting features of Peachtree 
Accounting plus more complex accounting tools such as Job Costing, Fixed 
Assets and Time & Billing. Peachtree Complete is the advanced accounting 
solution for companies that want to better manage their time, books, and 
business.

About This Guide

This guide and the User’s Guide refer to Peachtree Complete Accounting as 
Peachtree Accounting.

Before you begin using Peachtree Accounting, be sure to read this guide for 
installation instructions, conversion instructions (if you have existing data), 
and other important issues. This guide includes the following information:

• System requirements for installation

• Instructions for installing Peachtree Accounting

• Installation troubleshooting tips

• Information about converting existing data

• Instructions for setting up a new company

• Hands-on tutorials that demonstrate common features of Peachtree 
Accounting using sample data

• Instructions for converting existing Quicken and QuickBooks data
2



Introducing Peachtree Complete Accounting Release 7
System Requirements
System Requirements

To install Peachtree Accounting, you need the following hardware and 
software:

• 100% IBM PC compatible computer with a 486 processor (or 
higher)

• 12 MB (megabytes) of RAM (random access memory); 16 MB or 
higher is recommended

• Microsoft Windows 95, Windows 98, or Windows NT 4

• Hard disk with the following free space requirements:
 

Note: The recommended Peachtree Accounting memory 
requirements are in addition to the memory required by your system 
software and memory used when entering company data.

*Peachtree Fixed Assets is automatically included if you choose the 
Standard setup option while installing Peachtree Complete 
Accounting from the Peachtree Complete Accounting compact disc.

• MPC compatible CD-ROM drive (if you intend to use the compact 
disc version of Peachtree Accounting and multimedia features)

• VGA or SVGA monitor that can display a minimum of 256 colors; 
SVGA monitor is recommended if using the compact disc version

Do not use large fonts—Peachtree will not display properly.

• 8-bit or 16-bit SoundBlaster compatible sound card (if using 
multimedia sound enhancements included on the compact disc)

• Printers supported by Microsoft Windows 95 or Windows NT 4

• Mouse or compatible pointing device

Installation Component Diskette
Install

Compact 
Disc Install

Peachtree Complete Accounting 42 MB 44 MB*

Peachtree Fixed Assets 2 MB 2 MB*

Peachtree Online Tutorial 7 MB 42 MB

Adobe Acrobat Reader 3.02 and 
online manuals

N/A 15 MB
3
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Getting Started Guide1

Contents of the Peachtree Accounting Package

The Peachtree Accounting software package includes the following items:

• Peachtree Complete Accounting Release 7 Compact Disc

For a complete description of the Peachtree compact disc contents, 
see the following section.

Note: Diskettes are included in some upgrade versions of Peachtree 
Accounting, if requested. If you purchased a new product, only the 
compact disc version is included. A Floppy Disk Order Form is 
included if you require this type of media.

• Peachtree Complete Accounting Getting Started Guide

• Peachtree Complete Accounting User’s Guide

• Peachtree Fixed Assets User’s Guide

• PeachLink 2.0 Compact Disc and PeachLink User’s Guide

For a complete description of the PeachLink compact disc contents, 
refer to the PeachLink User’s Guide.

• Peachtree Products and Services Brochure (including information 
about Technical Support options, Peachtree Tax Service, Peachtree 
Training services, and additional products)

• Peachtree Business Checks & Forms Catalog

Contents of the Peachtree Accounting Compact Disc

The Peachtree Accounting compact disc includes the following items:

• Peachtree Complete Accounting Release 7

This package includes the Peachtree Complete Accounting setup 
program, the Peachtree Complete Accounting program, Peachtree 
Fixed Assets program, Peachtree Accounting Help, standard 
Peachtree Accounting forms, online tutorial, and sample company 
data.

• Online versions of the Peachtree Accounting manuals

• Adobe Acrobat Reader 3.02

This program allows you to open electronic documents in Portable 
Document Format (PDF). You must have Adobe Acrobat Reader 
installed before viewing the online versions of the Peachtree 
Accounting manuals. 
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Installing Peachtree Accounting
Contents of the Peachtree Accounting Compact Disc
Installing Peachtree Accounting 

The following instructions explain how to perform a standard (or upgrade) 
installation of Peachtree Accounting. If you are using a network, refer to 
“Installing Peachtree Accounting on a Network” on page 8.

1 Turn on your computer and start Windows.

Peachtree Accounting setup requires Windows 95, Windows 98, or 
Windows NT 4.

2 Exit all programs and disable virus-protection and screen saver programs on 
your computer.

This frees up memory and avoids interference with the Peachtree 
Accounting setup process.

3 Insert the Peachtree Accounting compact disc in your CD-ROM drive; or, 
insert Peachtree Diskette #1 in the diskette drive.

If you are installing from compact disc, the Welcome menu appears. 
Click Install Peachtree Accounting, and continue with the next step.

If you are installing from diskettes or the Welcome menu does not 
automatically appear onscreen, do the following: Select Start, then Run. 
Type A:SETUP and select OK. (Substitute the appropriate drive letter 
for your diskette or CD-ROM drive.)

4 Follow the onscreen instructions until the Peachtree Accounting Setup 
window appears. Review the installation instructions and select Next.

5 Read the Licensing Agreement, and select Yes if you accept the terms.

The Select Setup Type window offers up to four setup choices depending 
on if you are a new or previous user. 

6 Click an installation option button, and follow the instructions displayed, 
clicking Next to continue.

• Standard: Installs everything you need to begin running Peachtree 
Accounting. You cannot change the location where the program will 
be installed if you select this option.

• Upgrade: This option upgrades you from a previous version of 
Peachtree Accounting, maintaining your existing setup settings.

• Custom: You can set a different path for the program or data files 
using this option, or choose which components of Peachtree 
Accounting you want to install.

• Network: This option allows you to install program and data files in 
a network environment.
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7 In the Select Peachtree Accounting Program Folder window, change the 
name of the Peachtree Complete Accounting program folder, if necessary. 
Click Next to begin installing.

If you are installing from diskette, follow the prompts and insert 
additional diskettes as needed.

8 A final window displays, indicating the successful completion of 
installation.

• Read: Select this to view the Peachtree Accounting Release Notes file.

• Begin: Select this option to launch Peachtree Accounting.

• Return: Select this option to return to Windows.

After installing Peachtree Accounting, you can optionally install the online 
manuals. For more information, see “Installing Online Documentation” on 
page 7. 

When finished with the setup process, you can set up a new Peachtree 
Accounting company, explore sample company data, or convert existing 
company data from a previous version of Peachtree Accounting. For more 
information on what to do after installing Peachtree Accounting, see “What’s 
Next?” on page 17.
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Installing Online Documentation
Electronic versions of the Peachtree Accounting manuals are included on the 
Peachtree Accounting compact disc. To display or use these documents, you 
must have Adobe Acrobat 3 (or higher) installed on your computer.

Use the following procedure to install Adobe Acrobat Reader and Peachtree 
Accounting online manuals.

1 If proceeding after installing Peachtree Accounting from the compact disc, 
select Install Online Documentation from the Welcome menu.

— OR —

1 If you completed the Peachtree installation earlier and now want to load 
the online manuals, do the following:

• Exit all programs and disable virus-protection and screen saver 
programs on your computer.

• Insert the Peachtree Accounting compact disc in your CD-ROM 
drive.

• A Welcome menu displays. Select Install Online Documentation, 
and continue with the next step.

If the Peachtree Welcome menu does not display, select Run from the 
Start menu. Type D:\DOC\SETUP and select OK. Substitute the 
appropriate drive letter for your CD-ROM drive.

2 Follow the prompts to install the online manuals and Adobe Acrobat 
Reader (if necessary). 

Displaying the Peachtree Accounting Online Manuals

1 From the Start menu, select Programs, and then point to the Peachtree 
Accounting folder (or the name of the program folder you chose during the 
Online Documentation setup).

2 Select the manual you want to read.

• Getting Started Guide: the online version of the Peachtree Complete 
Accounting User’s Guide (PCWGS.PDF)

• User’s Guide: the online version of the Peachtree Complete 
Accounting User’s Guide (PCWUG.PDF)

• Fixed Assets User’s Guide: the online version of the Peachtree Fixed 
Assets User’s Guide (PCWFAUG.PDF)

For complete information on using Adobe Acrobat Reader, refer to the 
Online Guides installed with the Acrobat Reader program.
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Installing Peachtree Accounting on a Network 

A network connects all types of computers and computer-related devices, 
such as hard drives, printers and CD-ROM drives. Computers that share 
devices with other computers are called servers.

Peachtree Accounting comes network-ready and multiuser; it is ready to 
install on a network for use at your company. Peachtree Accounting will run
on two basic types of networks: peer-to-peer, such as Windows 95 
Networking, and client/server, such as Novell 4.x or above. Before you install 
on your network, you must know whether you have a peer-to-peer network 
or a client/server network.

Peer to Peer

This is a network that allows each connected computer to act as a server and/
or a workstation. Each computer can share its hard drive, printers, or other 
devices with all other computers in the network. This makes each computer 
on the network equal to the other computers, or a “peer.” However, when you 
are sharing data (such as accounting information), you want to designate one 
computer as the primary server for the data. In other words, you don’t want 
the data on everyone’s computer, only the primary server (such as the 
administrator’s computer).

Examples of peer-to-peer networks are Artisoft’s LANtastic or Windows 95 
Networking. 

Client/Server

This is a network with a traditional server acting as a central unit (the primary 
server) with several workstations connecting to it. The server is where you 
store the data that will be shared by the workstations.

Network Considerations

Peachtree Accounting can be operated on any network software that supports 
Microsoft Windows and NetBios. However, there are certain considerations:

• Your data must reside on a network drive (either on the server or the 
administrator’s machine for a peer-to-peer network).

• If you install the program files on each workstation, it enhances 
performance. Make sure you have full access (administrative rights) 
to the drive you are installing Peachtree Accounting.

• When you receive an upgrade to Peachtree Accounting, you must 
install the update the same way as you installed the original program.

• Real-time posting is recommended for better performance and fewer 
conflicts. 
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Installing on a Client/Server Network 

Use the following instructions to install Peachtree Accounting on a client/
server network, such as Novell 4.x or above. Use the same instructions to 
install Peachtree Accounting on each workstation, specifying the server as the 
location for data files and the local hard drive as the location for program files. 
Installing the Peachtree Accounting program files to each workstation’s local 
hard drive (for example, C:\PEACHW) improves performance and speed.

Before beginning this procedure, it is assumed that you have a shared network 
drive established and that workstations are mapped to this network drive.

1 Exit all programs and disable virus-protection and screen saver programs on 
your computer.

2 Insert the Peachtree Accounting compact disc in your CD-ROM drive; or, 
insert Peachtree Diskette #1 in the diskette drive.

If you are installing from CD-ROM and the Welcome menu displays, 
click Install Peachtree Accounting and continue with the next step.

If you are installing from diskettes or the Welcome menu does not 
display onscreen, do the following: Select Start, then Run. Type 
A:SETUP and select OK. (Substitute the appropriate drive letter for your 
diskette or CD-ROM drive.)

3 Follow the onscreen instructions until the Peachtree Accounting Setup 
window displays. Review the installation instructions and select Next.

4 Read the Licensing Agreement and select Yes if you accept the terms.

The Select Setup Type window offers up to four setup choices depending 
on if you are a new or previous user. 

5 Select the Network setup type.

Note
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6 The Select Location window displays. Enter a program and data path, then 
click Next.

The default location or path for the program files is the directory 
PEACHW on drive C. We recommend leaving this path as the default to 
increase speed and performance. If the workstation you are installing 
does not have a hard drive, you will need to change this location to the 
network drive. Select Browse next to the Program Path field to change 
the path for the files. If you know the name of the path, you may type the 
path into the field.

Make sure the Data Path is set to the proper network drive (for example, 
F:\PEACHW). Do not set the data path to a network root directory (for 
example, F:\). Change the location of the data files by selecting Browse 
next to the Data Path field.

7 A window displays for you to select which Peachtree Accounting 
components you want to install. Choose the components to install and click 
Next to continue.

8 In the Select Peachtree Accounting Program Folder window, change the 
name of the Peachtree Accounting program folder, if necessary. Click Next 
to begin installing.

If you are installing from diskette, follow the prompts and insert 
additional diskettes as needed.

9 A window displays, indicating the successful completion of installation. If 
any of your system files were modified during installation, you will see 
different options.

• Read: Select this to view the Peachtree Accounting Release Notes file.

• Begin: Select this option to launch Peachtree Accounting.

• Return: Select this option to return to Windows.

When installation is complete, see “About Record and File Locking” on 
page 14.
10



Installing Peachtree Accounting on a Network
Installing on a Peer-to-Peer Network
Installing on a Peer-to-Peer Network 

You must first install the software on the computer where data files will be 
located. This is probably the network administrator’s computer (the primary 
server). Then install Peachtree Accounting on each workstation, specifying the 
network administrator’s computer as the location for data files, and a local 
drive (usually C:) for the program files.

Before beginning this procedure, it is assumed that you have at least one 
shared drive established (possibly on an administrators computer) and that 
workstations are mapped to this drive.

Installing on the Network Administrator’s Machine 

Follow these steps to install Peachtree Accounting on the network 
administrator’s computer, or the primary server, before installing on any 
workstations. The network administrator’s computer is where the data files 
will be located.

1 Exit all programs and disable virus-protection and screen saver programs on 
your computer.

2 Insert the Peachtree Accounting compact disc in your CD-ROM drive; or, 
insert Peachtree Diskette #1 in the diskette drive.

If you are installing from CD-ROM and the Welcome menu displays, 
click Install Peachtree Accounting and continue with the next step.

If you are installing from diskettes or the Welcome menu does not 
display onscreen, do the following: Select Start, then Run. Type 
A:SETUP and select OK. (Substitute the appropriate drive letter for your 
diskette or CD-ROM drive.)

3 Follow the onscreen instructions until the Peachtree Accounting Setup 
window displays. Review the installation instructions and select Next.

4 Read the Licensing Agreement and select Yes if you accept the terms.

The Select Setup Type window offers up to four setup choices depending 
on if you are a new or previous user. 

5 Select the Network setup type.

Note
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6 The Select Location window displays. Enter a program and data path, then 
click Next.

Install the program and data files to the same path—the network 
administrator’s (or primary server’s) hard drive. The default location or 
path for the program and data files is the directory PEACHW on drive 
C.

7 A window displays for you to select which Peachtree Accounting 
components you want to install. Choose the components to install and click 
Next to continue.

8 In the Select Peachtree Accounting Program Folder window, change the 
name of the Peachtree Accounting program folder, if necessary. Click Next 
to begin installing.

If you are installing from diskette, follow the prompts and insert 
additional diskettes as needed.

9 A window displays, indicating the successful completion of installation. If 
any of your system files were modified during installation, you will see 
different options.

• Read: Select this to view the Peachtree Accounting Release Notes file.

• Begin: Select this option to launch Peachtree Accounting.

• Return: Select this option to return to Windows.

10 Next, continue with the following section, “Installing on a Workstation.”

Installing on a Workstation 

First, install Peachtree Accounting on the network administrator’s computer. 
Then, follow these steps to install Peachtree Accounting on each workstation. 
Make sure you know the drive and directory of the data files located on the 
network administrator’s computer before you begin installation.

1 Exit all programs and disable virus-protection and screen saver programs on 
your computer.

2 Insert the Peachtree Accounting compact disc in your CD-ROM drive; or, 
insert Peachtree Diskette #1 in the diskette drive.

If you are installing from CD-ROM and the Welcome menu displays, 
click Install Peachtree Accounting and continue with the next step.

If you are installing from diskettes or the Welcome menu does not 
display onscreen, do the following: Select Start, then Run. Type 
A:SETUP and select OK. (Substitute the appropriate drive letter for your 
diskette or CD-ROM drive.)
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3 Follow the onscreen instructions until the Peachtree Accounting Setup 
window displays. Review the installation instructions and select Next.

4 Read the Licensing Agreement and select Yes if you accept the terms.

The Select Setup Type window offers up to four setup choices depending 
on if you are a new or previous user. 

5 Select the Network setup type.

6 The Select Location window displays. Enter a program and data path, then 
click Next.

The default location or path for the program files is the directory 
PEACHW on drive C. We recommend installing the program files to the 
local hard drive to increase speed performance. If the workstation does 
not have a hard drive, change the location of the program files to the 
network. To change the location of the program path, select Browse next 
to the Program Path field.

Make sure the Data Path is set to the proper network drive (for example, 
F:\PEACHW). Do not set the data path to a network root directory (for 
example, F:\). Change the location of the data files by selecting Browse 
next to the Data Path field.

7 A window displays for you to select which Peachtree Accounting 
components you want to install. Choose the components to install and click 
Next to continue.

8 In the Select Peachtree Accounting Program Folder window, change the 
name of the Peachtree Accounting program folder, if necessary. Click Next 
to begin installing.

If you are installing from diskette, follow the prompts and insert 
additional diskettes as needed.

9 A window displays, indicating the successful completion of installation. If 
any of your system files were modified during installation, you will see 
different options.

• Read: Select this to view the Peachtree Accounting Release Notes file.

• Begin: Select this option to launch Peachtree Accounting.

• Return: Select this option to return to Windows.

10 Repeat these instructions for each workstation.
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About Record and File Locking

If you install Peachtree Accounting to run on a network, sharing data with 
more than one person, you could have more than one person entering 
invoices, payments, orders, etc. for the same company at the same time. 
Peachtree Accounting uses Record and File locking to ensure that data is 
properly protected and updated. A record is one group of information, 
composed of related fields. For example, the fields in one customer’s 
window—Name, Address, Phone, etc.—go together to form that customer’s 
record. Likewise, all customer records go together to form the customer file.

If two people were making changes to the same customer, without record and 
file locking, two things could happen:

• The information could get jumbled, combining each person’s 
changes.

• Person #1, working on the same customer information as Person #2, 
saves his changes first. Person #2 finishes their changes and saves the 
record a few minutes later. Person #2’s changes will be the only 
changes saved, since Person #2 was the last person to save the record.

To eliminate either possibility from occurring, Peachtree Accounting uses 
“locks” to prevent a particular record or file from being accessed by more than 
one person at a time. In the example above, when the second person attempts 
to change the customer record the first person is using, Peachtree Accounting 
will wait for the first person to finish, then allow the second user to begin. In 
special cases when Peachtree cannot wait, it will display the following 
message:

“That record in file ‘Customer.DAT’ is currently in use. Please try again 
when it is available.”

Peachtree Accounting uses two different types of locks: Record Locks, and 
Exclusive File Locks.
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Record Locks 

A record lock prevents more than one user from working on the same data 
record, such as customer information, at the same time. This ensures that 
record information does not become jumbled, and changes are processed 
correctly. 

For instance, when you select Maintain Customers/Prospects and choose a 
Customer ID, Peachtree Accounting “locks” that record. Other users who 
attempt to access the same customer record will first experience a waiting 
period to allow the first user to finish. Once Peachtree completes the first 
user’s task, Peachtree will begin the second task. In special cases, you may 
receive a message indicating that the record is currently locked. Once the first 
user has saved changes and closed the record, Peachtree Accounting removes 
the lock, allowing other users to access the record. Other users will still be able 
to perform functions such as entering invoices and printing reports, but no 
one else will be able to update the customer information until the first user has 
finished and closed the record. 

For example, if you are using real-time posting and changing a customer 
record, and a second user is simultaneously posting a receipt for the same 
customer, the second user’s posting will experience a waiting period while 
Peachtree saves your customer changes. Then, Peachtree will post the second 
user’s receipt.

Exclusive File Locks 

An exclusive file lock prevents more than one user from accessing the same 
file at the same time. During critical processes, an exclusive file lock is placed 
on all of your company’s files. These processes include

• Backing up

• Restoring

• Changing the period 

• Closing the payroll (calendar) year

• Closing the fiscal year

• Posting (From Tasks menu, System, Post)
only in Batch mode

• Unposting (From Tasks menu, System, Post)
only in Batch mode

• Maintaining user IDs and passwords

• Purging data
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When you attempt to perform any of these processes, if another user has the 
company open, even if only at the main screen, the following message 
displays:

“You are attempting to access an area that another user is also using, or 
you are attempting to perform a process that requires single-user access. 
Please try again when no other users are attempting the same operation 
or accessing Peachtree Accounting.” 

Once no one else is using Peachtree Accounting, try the process again.
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What’s Next?
Now that you have successfully installed Peachtree Accounting, you’re ready 
to get started using the program. One of the best ways to get familiar with 
Peachtree Accounting is to open the program and look around.

If you need assistance starting the program or navigating within Peachtree 
Accounting, refer to the “Basics” chapter of the User’s Guide.

Registering Peachtree Accounting 

Register your copy of Peachtree Accounting as soon as possible after installing 
the program. Registration is very important because it ensures you of timely 
program updates and upgrade offers, exciting new product information, 
payroll tax service information, technical support options, and a variety of 
other benefits.

You can only use the software a limited number of times before you must 
register. Also, if you are operating on a network, you must purchase and 
register a licensed copy of Peachtree Accounting for each workstation. For 
more information on multiuser licensing, open Peachtree Accounting Help 
and search for “multiuser” in the online index.

1 Start Peachtree Accounting. If your product is not registered, a window 
appears asking you to register.

If Peachtree Accounting is already running, select Peachtree Registration 
from the Help menu.

2 In the initial Register Peachtree Accounting window, select Register Now.

3 Enter your Peachtree Accounting Serial Number.

Your serial number is located on the inside cover of this manual, the 
Getting Started Guide.

Note
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4 Enter the Registration Unlock Code.

To obtain an unlock code, do one of the following:

➤ Call Peachtree Software toll free at 1-800-718-1592. International 
customers can call 612-906-3201. Please have your serial number, 
company address, and telephone number available before speaking with a 
Peachtree Customer Service representative. The Customer Service 
representative will then give you an unlock code.

➤ Visit Peachtree Software’s Internet web site at 
http://www.peachtree.com/register/. After answering a few questions, 
you will be given an unlock code.

5 When finished entering your registration information, click OK to start 
using Peachtree Accounting.

If you select the Register Later button, you can use Peachtree Accounting 
a limited number of times before you need to register. A message will 
show the remaining number of uses before continuing. If you have no 
remaining uses left and choose not to register, Peachtree Accounting will 
shut down. If you start Peachtree Accounting again, you will be 
prompted to register again.

Write down your serial number and registration unlock code and keep 
them in a safe place in case you ever need to reinstall the product.

Practicing with Sample Data and Tutorials

Before you begin setting up your company in Peachtree Accounting, it is 
highly recommended that you explore the sample company data installed 
with Peachtree Accounting. You can practice adding records or transactions 
without using your own data. 

Note
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Exploring Sample Company Data

Peachtree Accounting includes the following sample company data:

• Bellwether Garden Supply. This is a retail and service company that 
demonstrates Peachtree’s extensive inventory and job tracking 
capabilities. The Peachtree Accounting system date is set at 
March 15, 2003.

• Pavilion Design Group: This is a graphic service company that 
demonstrates Peachtree’s Time & Billing features. To view data 
effectively, you must set the Peachtree Accounting system date to 
January 10, 2000 (as described in the written tutorial in this guide).

If you do not have sample company data installed, you can reinstall Peachtree 
Accounting, select the Custom installation option, and choose to load sample 
company data only.

Following Online and Written Tutorials

Peachtree Accounting offers you two tutorials to get acquainted with the 
software.

• Online Tutorial: This is a multimedia introduction of the basics and 
new features of Peachtree Accounting. If you installed Peachtree 
Accounting from compact disc, you have the option of running the 
tutorial from your hard disk or the compact disc. The compact disc 
version of the tutorial offers additional sound options.

• Written Tutorial: This is a hands-on demonstration of Peachtree 
Accounting. It uses sample company data, allowing you to enter 
fictitious data and explore many features included in Peachtree 
Accounting. To begin, see “Tutorials” on page 49 of this guide.

Creating a New Company

If you are ready to begin setting up a new company in Peachtree Accounting, 
see the “Creating a New Company “chapter in the User’s Guide. This chapter 
walks you through initial setup decisions using the New Company Setup 
program included with Peachtree Accounting.
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Converting Existing Company Data

If you are upgrading from a previous release of Peachtree Accounting, First 
Accounting, or Peachtree Complete Accounting, you can convert existing 
company data to the new format and continue using it.

➤ To convert existing Peachtree company data, see “Upgrading from 
Previous Versions” on page 29 of this guide.

If you used Quicken or QuickBooks/QuickBooks Pro, you can convert 
existing data to the Peachtree Accounting format.

➤ To convert existing Quicken data, see “Converting Quicken Data to 
Peachtree Accounting” on page 213 of this guide.

➤ To convert existing QuickBooks or QuickBooks Pro data, see 
“Converting QuickBooks Data to Peachtree Accounting” on page 245 of 
this guide.
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Peachtree Technical Support 
Help is as close
as your phone,

fax, or online
computer.

We make every effort to ensure that our software, online Help, and user 
manuals are as complete and easy-to-use as possible. However, questions 
sometimes do come up. If you require technical assistance, take a moment to 
read about various Client Support options included in the Peachtree Products 
and Services brochure that came with your software package. 

Peachtree Software offers several methods for getting help including a 
searchable database of technical tip documents at our Internet web site at 
http://www.peachtree.com, PeachFax (fax-on-demand service), one-to-one 
or group training at authorized Peachtree Support Centers, and various 
telephone support options, where you will receive quality technical support 
from trained support professionals.

We’ll get you
started off

right!

Your first 30 days are free! That’s right—to make sure you get up and running 
quickly on your Peachtree software, we offer 30 days of support available free 
of charge to our new clients. The free support is under your Peachtree 
warranty and begins the day you register your Peachtree product. Whenever 
you have a question just call the appropriate number provided and one of 
Peachtree’s support specialists will happily assist you. 

Prior to obtaining technical support, we ask you to register your product. 
After registering your product, you will be provided information on how to 
receive technical support.

➤ To register your Peachtree Accounting product, call 1-800-718-1592.

➤ For more information on support plan memberships, call 1-800-247-3224.

Peachtree Software Internet Web Site

Peachtree also offers technical support services at our Internet web site at 
http://www.peachtree.com. You can view information on each Client 
Support option as well as other Peachtree Software product information.

Peachtree Technical Support rates and information mentioned in Peachtree 
Accounting manuals, the Peachtree Products and Services brochure, and 
Peachtree Accounting Help are subject to change without notice.Note
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Before Contacting Technical Support

There are a couple of options you need to try before contacting Peachtree 
Software Client Support:

• Register your Peachtree Accounting product, if you have not already 
done so.

• Read the section in the User’s Guide that documents information 
about the procedure you are doing, or refer to Peachtree 
Accounting’s online Help.

• Consider examining technical tips and frequently asked questions 
Peachtree Software publishes at the Peachtree Software web site.

• Attempt to duplicate the error in one of the sample companies 
provided with your software.

The Peachtree representative answering your call will need certain 
information to assist you. To help the representative provide you with the best 
service, please do the following:

1 Be at your computer and have your manuals available.

2 Know the telephone number you have registered your product under or 
have your product serial number available.

Your serial number is located on the inside cover of this manual, the 
Getting Started Guide.

3 Know the name and product number of your program. To determine your 
product information, select About Peachtree Accounting from the Help 
menu.

4 Write down the steps you performed prior to the problem occurring.

5 Write down the exact error message(s) displayed on your screen.

6 From the Help menu, select Technical Support Information. Enter the 
appropriate information and click the Print button. This information will 
assist Peachtree Client Support technicians when resolving your problem.

If you are operating on a network, please provide the name of your network, 
the location of the Peachtree Accounting program (program path), and the 
location of your Peachtree Accounting company data (the data path).

If you are experiencing problems printing a report, form, or financial 
statement, please provide the name of your printer and possibly the printer 
driver used. 
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For printing errors, consider printing to an alternate printer to help isolate the 
problem. If you designed a custom report, form, or financial statement, try 
printing the standard (predefined) version. Also, open the sample company 
and try printing the same report, form, or financial statement. This helps 
determine if the problem is specific to your customized design or company 
data. 

Uninstalling Peachtree Accounting 
If you need to remove Peachtree Accounting, use the Uninstall program 
included with Peachtree Accounting when it was initially installed. 

When you uninstall Peachtree Accounting, all components (including 
program files, pre-defined reports and forms, and sample company data) are 
removed from your system. Your personal company data will remain on your 
hard disk.

To delete Peachtree Accounting program files, do the following:

1 Turn on the computer and start Windows.

2 From the Start menu, select Settings, Control Panel, then Add/Remove 
Programs.

3 Select Peachtree Complete Accounting from the program list, then click 
Add/Remove.

4 Select Yes to confirm that you want to remove Peachtree Complete 
Accounting program files.

Once the program has been removed and the process has finished, 
choose to return to Windows.

Note

Note
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Troubleshooting Installation 

Below are frequently asked questions that may help you resolve errors during 
or errors when starting Peachtree Accounting.

Frequently Asked Questions

When I attempt to install Peachtree Accounting, I received the 
error, “You must have full administrative rights to your 
computer.” What’s wrong?

This message can appear on Windows NT and Windows 2000, especially if 
you are operating in a network environment. In order to install Peachtree 
Accounting on your computer, you must have full access (administrative 
rights) to your local hard drive. This allows Peachtree Setup to install the 
program files and make the proper entries to the Windows Registry. Please 
exit and log into Windows as a user who has full administrative rights and try 
again. Or, contact your system administrator to change your user rights.

What will happen to my existing Peachtree company after I 
install the upgrade?

Your data will be converted to the new Peachtree Accounting format the first 
time you open your company. Once you convert your company to the new 
release, you cannot use your data with any prior releases of Peachtree 
Accounting. For that reason, we strongly suggest that you back up your data 
to diskettes before converting your company files. For more information, see 
the next chapter in this guide, see “Upgrading from Previous Versions” on 
page 29.

What will happen to my custom reports, forms, and financial 
statements?

They will be converted for use in the new Peachtree Complete Accounting 
format. For more information, see “Conversion Issues” on page 35.
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I tried opening Peachtree Accounting, and received an error that 
read “Btrieve initialization failed due to invalid transaction file. 
Please delete the Btrieve.trn file, exit Windows and retry.” What 
happened? 

Btrieve, the underlying database structure used by Peachtree Accounting, has 
a limit of approximately 50 characters in the directory path name. For 
instance, you could install Peachtree Accounting to a directory called

C:\BUSINESS\ACCOUNTS
but you could not install it to a directory called
C:\BUSINESS\FINANCES\ACCOUNTS\PEACHW\GROUPA\PCHTREE

The length of the path to your files would cause a Btrieve error. Correct the 
data path, then go to your Windows directory and delete the file MKDE.TRN. 
Then restart Windows. (For Windows 95 users, please see next question.)

I’m not using a network now, but I plan to in the future. How 
should I install Peachtree Accounting? 

Install Peachtree Accounting now as a normal stand-alone computer, not 
attached to a network. When it’s time to change to a Network Installation, 
reinstall Peachtree Accounting on all machines, using the Network setup. If 
you decide that the data files should reside on a different computer, you will 
have to copy your company directory to the other computer. For more 
information, see “Installing Peachtree Accounting on a Network” on page 8.

I get an error message during installation that says it can’t read 
or copy a file. What should I do? 

Your computer is having difficulties installing one of the files from a compact 
disc or diskette. Try installing the program on another computer. Turning off 
screen savers and virus checkers may also help. If you suspect that a compact 
disc or diskette is damaged, please contact Peachtree Technical Support for 
replacements.
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I’m getting a message that says “Setup initialization error due to 
insufficient memory” or the message “Cannot find Status.dat” 
and/or “Options.dat.” How can I correct it? 

Peachtree either does not have enough memory to load these files or it cannot 
find the files to load. If Peachtree is on a network, check your network 
connections. You may have to restart your computer to establish the 
connection to remote network drives.

Peachtree Accounting requires that you have a minimum of 12 MB of physical 
RAM installed on your computer. Restarting your computer will also reset 
your memory.

Why am I getting a “Btrieve version 5.10 is too old” message 
when I attempt to start Peachtree Accounting? 

Peachtree Accounting currently uses the Btrieve database engine (version 
6.15). When other programs, using an older version of Btrieve (such as 
version 5.10), are loaded into memory first, you will get this error when 
attempting to start Peachtree Accounting. To correct this error, start 
Peachtree Accounting before starting other programs using Btrieve. For more 
information, dial our PeachFax service at 1-800-719-3216 and request 
document #36535 or search for this document number at the technical 
support area of Peachtree’s Internet web site.

I’m having problems using Peachtree Accounting and my large 
system fonts.

Peachtree Accounting does not support large system fonts in your Windows 
display settings. To use Peachtree Accounting, please switch your system fonts 
to the small font typically used in Windows.
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I’m starting Peachtree on a workstation across the network, and 
I’m receiving the message “Cannot open F:\PEACHW\STATUS.DAT 
or OPTIONS.DAT.” What do I need to do to correct it? 

Peachtree either does not have enough memory to load these files or it cannot 
find the files to load. First, check your network connections. You may have to 
restart your computer to establish the connection to remote network drives. 
Restarting your computer will also reset your memory. 

If you are running on the following two networks, you may need to update 
your networking software. Novell Netware Lite: you may need to acquire two 
patch files from Novell, L11DO3.exe and L11U05.exe. Invisible LAN: you 
need to be running version 3.52 or greater.

I’m installing on a Novell Network version 3.12 or higher 
workstation, and am getting a “could not remove file” message. 
Why is Peachtree Accounting not installing on my network? 

The problem can be resolved by updating your Novell VLM version to 1.2 or 
higher. As a work-around, you can remove the read-only attributes of the files 
in the \PEACHW directory, before you install on the network workstations.

I’m running Peachtree Accounting on a network, and I frequently 
receive the message “The record in file ‘Customer.DAT’ is 
currently in use. Please try again when it is available.” What can I 
do about this? 

When running in a multiuser environment, such as a network, Peachtree 
Accounting uses Record and File Locks to prevent more than one person 
working with a record at a time. This makes your data more secure and 
prevents problems with data being improperly saved. For more information 
see “About Record and File Locking” on page 14. To help reduce the number 
of conflicts of this type, we suggest you use the real-time posting method, 
rather than batch posting. See the User’s Guide for more detail.
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• Upgrading from Previous
   Versions •

Installing the Upgrade
If you are upgrading from a previous release of Peachtree Accounting, 
Peachtree Complete Accounting, or First Accounting, install the updated 
program in the existing Peachtree Accounting directory (usually \PEACHW, 
unless you changed it to a different name during the previous installation). 
During the installation process, select the Upgrade setup option. This option 
upgrades your program files from a previous version of Peachtree 
Accounting, maintaining your existing installation and registration settings. 
For more information, see “Installing Peachtree Accounting” on page 5.

If you elect to use a new or alternate directory name, you will be prompted for 
the Release 7 serial number and registration unlock code. For more 
information, see “Registering Peachtree Accounting” on page 17.

Using Existing Data

If you are upgrading and attempt to open your established company data for 
the first time, a window displays asking you to convert your data to the new 
format. This is required if you intend to use your company in the new release 
of Peachtree Accounting.

The purpose of this chapter is to explain how to convert existing Peachtree 
Accounting data to the new Peachtree Complete Accounting Release 7 
format. It will inform you of conversion issues you may encounter when 
attempting to use existing Peachtree Accounting data.

Before you begin converting Peachtree Accounting company data, be sure to 
read this chapter completely and carefully.
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Converting Existing Company Data
The company data conversion is used only for companies that used prior 
releases of Peachtree Complete Accounting (for Windows), Peachtree 
Accounting, or First Accounting. This process does not convert company data 
from Peachtree Complete Accounting for DOS. The MS-DOS conversion 
requires a separate utility available from Peachtree Software. To order the 
Peachtree Complete Accounting for DOS conversion utility, please call 
1-800-247-3224.

Before You Begin

Before you proceed in converting your data, we recommend you turn off all 
screen savers, disable virus-protection software, and close all other 
applications. This will speed up the conversion and avoid any errors.

Also, make sure you have ample hard-disk space available where your data is 
located before converting your company. The conversion may require up to 
2.5 times the size of your company data to convert successfully depending on 
the version you are converting. For example, if your company is 2 MB, you 
should make sure 6 MB of hard-disk space is free. This does not mean your 
company will triple in size. Peachtree uses the extra space temporarily while 
converting.

In some cases your company data may increase in size after the conversion.

Starting the Data Conversion

To begin the conversion process, follow these instructions:

1 Open your company by selecting Open Company from the File menu.

If your company is in a prior format (Peachtree Complete Accounting, 
Peachtree Accounting, or First Accounting), a Conversion window will 
display. You have three options: Backup, Continue, and Cancel.

2 Select Backup to begin the process of making a backup of your company 
data prior to conversion. Once the backup is complete, you return to the 
Conversion window.

Note
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We strongly recommend you make a backup before converting your 
company data to the new Peachtree Complete Accounting format. This way 
if something failed or there was a power outage, you could restore the backup 
and convert again. Also, it’s a good idea to back up your old company data to 
diskette which can be filed away for audit purposes. For more information on 
backing up data, refer to the “Company Administration” chapter of the User’s 
Guide.

3 Select Continue to begin the conversion process. Once the conversion is 
complete, you return to the main Peachtree Accounting window. 

The conversion process may take some time depending on the prior 
release the program is converting and the amount of memory in your 
computer. 

• If you are converting a company from Peachtree Complete 
Accounting Release 4 or 6, Peachtree Accounting Release 3.5 or 5, 
or Peachtree First Accounting, the process should move quickly (5 
to 30 minutes), depending on the size of your company data and 
computer memory.

• If you are converting a company from Peachtree Accounting 
Release 3.0 (or lower), the conversion make take a long time 
depending on the size of your company data. For example, if you are 
converting a 4 MB company, this may take between 15 minutes to 1 
hour (depending whether you use inventory or not). If this is the 
case, we recommend you begin the conversion before lunch or at the 
end of the day.

IMPORTANT: Do not interrupt the conversion process. Companies with 
large amounts of data could take a long time to convert.

Once you convert your company to the new format, you cannot use your data 
with any prior releases of Peachtree Accounting or First Accounting.

Warning
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Troubleshooting the Conversion

Companies with large amounts of data could take a long time to convert. If 
you are sure the conversion has stopped before it is complete, but no error 
message displays, try these steps before calling Technical Support:

1 Restore your (existing) company data manually using the same method in 
which you backed up the data. This means completely replacing the 
partially converted company data with the pre-existing copy.

Note: You cannot backup or restore data through the Peachtree 
Accounting facility at this point.

If the data conversion to Release 7 fails, if you are forced restore a backup 
of your company data, and if you used Peachtree’s Simple Copy backup 
method in Release 4, 5, or 6, you can manually restore your company 
backup without having to reinstall the older version of Peachtree 
Accounting. For detailed instructions, please refer to PeachFacts 
document 30027 within the Peachtree Knowledgebase at http://
www.peachtree.com or call the PeachFax service at 1-800-719-3216 and 
request this document number.

2 Turn off memory-resident programs (including screen savers and virus 
protection programs), and remove any applications from the Startup folder. 
Before attempting the conversion again, make sure all other applications 
are closed.

3 Exit Windows, and reboot your computer.

4 Check for available disk space. You will need approximately 2.5 times the 
amount of current space in your data directory. Company data directories 
are sub-directories of \PEACHW that use respective short names for each 
company.

5 If you get the error message, “This transaction refers to a non-existing 
invoice for customer/vendor XXXX, reference XXXX” during conversion, 
please refer to PeachFacts document 31038 within the Peachtree 
Knowledgebase at http://www.peachtree.com or call the PeachFax service 
at 1-800-719-3216 and request this document number. This document 
gives detailed instructions for correcting the error.

6 Try the conversion again.
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Troubleshooting Data Conversion on a Network

If you are operating Peachtree on a Novell network and experience “Lock 
Table Full” errors, increase the maximum locks per connection on your 
network, then try the conversion process again. If this does not work or you 
are on a experiencing “Lock Table Full” errors on other networks when trying 
to convert data, copy your company data to a workstation and perform the 
operation directly on that workstation. When the process is complete, copy the 
data back to the network drive.

If you are unclear as to how to set the number of locks, refer to your network 
manual or see a network administrator. You can also visit the PeachFacts 
Technical Library at our Internet web site at http://www.peachtree.com for 
information correcting the error.

If you have an automatic backup routine enabled on your network and run 
the conversion or purge process overnight, you should disable this routine. It 
can be re-enabled after the purge or conversion process has completed.

If you still run into errors while converting existing data, consider 
examining technical tips and frequently-asked questions that Peachtree 
Software provides through our PeachFax (fax-on-demand) service and 
PeachFacts documents available at the Peachtree Software web site or contact 
Peachtree Software Client Support. For more information, see “Technical 
Support” on page 22.

Note
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Conversion Issues
This section contains important information if you are upgrading from an 
earlier version of Peachtree Complete Accounting, Peachtree Accounting, or 
First Accounting. For complete instructions on converting your company 
data, “Converting Existing Company Data” on page 35.

Features in Release 7 that May Impact Conversion

The following is a short list of the features in Release 7 that may or may not 
impact your conversion of existing data. For a complete list of new features in 
Release 7, refer to Peachtree Accounting’s online Help. In the Contents tab of 
the help Topics window, select “What’s New.”

Year 2000 Compliant

Peachtree Accounting and Peachtree Complete Accounting Release 7 are both 
“Year 2000 compliant.” They will process, calculate, store, and display date 
data into the year 2000. This means that the program, when used in 
accordance with its associated documentation, will use four-digit years on 
input and output where appropriate. This includes viewable four-digit dates 
on screen and within reports. For two-digit year processing, years [51] 
through [99] are assigned a 19xx date, and years [00] through [50] are 
assigned a 20xx date. The standard date format is MM/DD/YYYY. 

To illustrate this, open the sample company, Bellwether Garden Supply. This 
Peachtree Accounting company is set up with a March 15, 2003, system date; 
it has data entered in 2003 and 2004.

For more information on Peachtree Software’s Year 2000 policy, visit our web 
site at http://www.peachtree.com.

User/Password Security

Peachtree Accounting can allow custom access for different individuals. You 
can set up user profiles (records) for each person who will be using Peachtree 
Accounting. Each user record is set up with a user ID and password that will 
be required before opening and working with company data. Setting up users 
also enhances security and personal accountability when the Use Audit Trail 
option is activated (see below).

You can also set up user rights (control levels) to various program areas of 
Peachtree Accounting. You can choose to allow users access to a complete 
major program area (for example, Accounts Receivable) or limit access to a 
particular window (for example, Sales/Invoicing).
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When user IDs and passwords are set up, Peachtree prompts you for a user ID 
and password when you open a company. If you know the password, you can 
access the areas of the program to which you have rights.

Passwords from previous versions of Peachtree Accounting Releases 5 (or 
lower) are converted to user records in which the user ID and password are 
the same value. For example, if you set up the password “peach” in Peachtree 
Accounting Release 5, enter peach as the user ID and password. To 
personalize the new user records and take advantage of the new limited access 
features, select Users from the Maintain menu. Only passwords set up in 
previous versions with access to the “Passwords” window have access to the 
new Maintain Users window.

User IDs and passwords are case sensitive. Therefore, make sure you type the 
user ID and password exactly as set up in the user record when opening your 
Peachtree Accounting company. For example, Password, PASSWORD, and 
password, are all different. If you're sure you have the right user ID and 
password, but Peachtree isn't accepting them, check to see if your CAPS 
LOCK key is on. 

For more information, see the “Company Administration” chapter of the 
User’s Guide.

Use Audit Trail

Peachtree Accounting has several methods to track information. For example, 
the General Ledger, journals, reports, and financial statements can be used to 
trace transactions and balances for audit purposes. However, if you want to 
track when an action is performed in your company data, you can now 
activate Peachtree Accounting’s audit trail. This is a security option that logs 
when a person enters data, maintains (edits) existing data, and removes data. 
Audit trail provides accountability of users, deters users from fraudulent 
activity or mistakes, and tracks transaction history. The Audit Trail report can 
trace fraudulent activity and other accounting adjustments you may not know 
were completed.

If you intend to have Peachtree maintain an audit trail log, it is strongly 
recommended that you set up users in your company. When the Use Audit 
Trail option is activated and users/passwords set up and implemented, data 
security will be increased substantially. The Audit Trail report can associate 
user IDs with each data and system activity performed as it occurs and 
establishes personal accountability. 

For more information, see the “Company Administration” chapter of the 
User’s Guide.
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Hide G/L Accounts

Peachtree has added a new global option in which you can elect to not display 
G/L account fields on certain task windows. This allows simplified and faster 
data entry for common transactions. When the General Ledger accounts 
fields are not visible, it is assumed that the default accounts you have set up 
will be used when recording the transaction. However, you can still change G/
L accounts, if needed, by selecting the new Accounting Behind the Screens 
button (see below).

When converting from a previous version of Peachtree Complete Accounting 
or Peachtree Accounting Release 3.5 (or lower), this option is not activated.

For more information, see the “Company Administration” chapter of the 
User’s Guide.

Accounting Behind the Screens

This exciting new feature allows you to actually look at the journal entry prior 
to posting or saving a transaction. When you select the Journal button in 
various task windows, the Accounting Behind the Screens window displays. 
This window displays the corresponding transaction’s journal entry. You can 
modify the journal entry by changing the account IDs for each line item in the 
transaction. Depending on what type of task is open, the Accounting Behind 
the Screens window displays the Journal tab(s) that correspond to the 
particular transaction.

Accounting Behind the Screens is available in the following task areas:

• Accounts Receivable: The Quotes, Sales Orders, Sales/Invoicing, and 
Receipts windows

• Accounts Payable: The Purchase Orders, Purchases/Receive 
Inventory, and Payments windows

• Payroll: The Payroll Entry window

When converting from a previous version of Peachtree Complete Accounting 
or Peachtree Accounting Release 3.5 (or lower), this option is not activated.

For more information, see the “Basics” chapter of the User’s Guide.
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Peachtree Accounting Color Schemes

You can choose from five color schemes that change the appearance of 
windows and dialog boxes used in Peachtree Accounting. Each scheme uses a 
different combination of colors. When you select a color scheme preference, 
this default affects all companies in the Peachtree Accounting data path that 
are accessed by this computer. You can change color schemes at any time. If 
you operate on a network, each workstation can set up its own color scheme 
preference.

Peachtree Accounting color schemes only apply to windows and dialog boxes 
within the Peachtree Accounting program, not other Windows applications 
or the Windows desktop.

Choose from one of the following color schemes:

• Classic: This scheme uses Peachtree’s traditional white tabs and 
white color backgrounds throughout the program. If you are 
upgrading from a previous version of Peachtree Accounting, this 
color scheme is initially set up.

• Professional: This scheme uses light gray tabs and gray 
backgrounds. If you are new to Peachtree Accounting, this color 
scheme is initially set up.

• Splash: This scheme uses light pastels similar to the folder colors 
displayed in the Navigation Aids. 

• Sand: This scheme uses light and dark tan colors throughout the 
program.

• Vibrant: This scheme uses bright and bold colors similar to the 
folder colors displayed in the Navigation Aids.

To change a Peachtree Accounting color scheme, do the following:

➤ From the Options menu, select Global. In the Maintain Global Options 
window, select the General tab and choose a color scheme option.

If you change a color scheme preference and select OK, you must close 
and restart Peachtree Accounting for the color changes to take effect.

Note
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Time and Expense Ticket Descriptions

You can now insert ticket or item descriptions easily when applying tickets to 
a sales invoice. There are two new fields to manage detail information in the 
Time Tickets and Expense Tickets windows.

• Ticket Description for Invoicing: You can enter a short description 
describing the ticket in either the Time Tickets or Expense Tickets 
window. You can enter up to 160 characters. Typically this 
description is used for billing purposes. When applying tickets to 
customer invoices, you can choose to display the ticket description 
entered here or the activity or charge item description set up in 
Maintain Inventory (provided the tickets are not consolidated).

• Internal Memo: You can enter notes on how time was spent 
performing this activity. The Memo field is included for internal 
purposes only and is used to help identify the time ticket. Memos 
cannot be added to a customer invoice or employee paycheck; 
however, they can be displayed in reports. You can enter up to 2000 
characters.

Ticket memos converted from Peachtree Complete Accounting Plus Release 
4 become the internal memos. The Ticket Description field will be blank. To 
apply ticket descriptions to sales invoices, you must enter a short phrase in the 
Ticket Description field for each existing time and expense ticket.

For more information, see the “Basics” chapter of the User’s Guide.

From Peachtree Complete Accounting Release 4

If you are converting from a previous version of Peachtree Complete 
Accounting (Batch 3 or lower), you should consider the following items. If 
you are converting from Peachtree Complete Accounting (Batch 4) or 
Peachtree Complete Plus Release 4, this section does not apply.

Events

Once an invoice is paid in Peachtree Accounting it is now cleared from the 
Events log in Action Items. Therefore, after the conversion, you may notice 
that the number of events and the size of the EVENT.DAT file will be 
considerably smaller.
39



Upgrading from Previous Versions
Getting Started Guide2
Payroll Reports

In Maintain Employees, additional fields have been added to the Pay Info tab. 
These new fields determine how the employee will be paid during payroll 
entry. Pay method replaces what was Pay Type option in previous version of 
Peachtree Accounting. An Hours Per Pay Period field has been added if you 
are paying the employee a standard number of hours per pay period.

For explanations of the these new fields, refer to the Peachtree Complete 
Accounting User’s Guide or the Peachtree Accounting online Help.

Because of the new field additions, if you customized an Employee List report, 
field order from your custom reports may be affected after converting to the 
new version of Peachtree Accounting. If you rebuild these custom reports 
from the new Employee List format, the field order will be corrected.

From Peachtree Accounting Release 3.5 (or lower)

If you are converting from Peachtree Accounting Release 3.5 (or lower), you 
should consider the following enhancement considerations:

• Purchase Orders

• Quotes

• Inventory Item Description

• Freight

• Jobs

• Forms

• Reports

Purchase Orders

The new Purchase Order system has been expanded to maintain history of all 
purchase orders entered in Peachtree Accounting. The conversion process 
will update your purchase transactions to give you this new functionality.

• If there are any existing purchase transactions that were marked at 
one time as a PO, a separate purchase order transaction will be 
created and added to the new Purchase Order Journal. These PO’s 
will be marked as “closed”. Depending on the number of purchase 
orders you previously entered, this may slightly increase your 
company data size.

• The date of these new PO transactions will be the same date as the 
purchase invoice it is attached to.
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• The information entered on the purchase order will be identical to 
the original purchase invoice. Note that if you have printed copies of 
a previous PO, and the purchase invoice was later modified, the 
items on the new PO may be different than your printed PO. The 
advantage to this is the ability to reprint existing purchase orders.

• If you enter duplicate PO numbers for the same vendor, then the 
conversion process will append the numbers by one so that no 
duplicates exist. You cannot have duplicate purchase order numbers 
for the same vendor in Peachtree Accounting.

Job Costing

The Job Costing system has been significantly enhanced to include phases and 
cost codes. All jobs entered in a previous version will be converted to new job 
IDs which do not use phases or cost codes. You can add phases and cost codes 
to existing jobs after the conversion if you want to take advantage of this new 
powerful feature. 

Before you begin the conversion, make a note of your existing job IDs 
which have commas in them. If the conversion encounters a comma in a pre-
existing job ID, it will replace the comma with another character, effectively 
changing the ID name.

After the Conversion

Purchase Orders

The new PO transactions created during the conversion are now accessed in 
the new Purchases Order task window. 

➤ To edit previous purchase orders, or to create new purchase orders, from 
the Tasks menu, select Purchase Orders.

The PO numbers will also display in the new Purchases/Receive Inventory 
window. You can drill-down on these PO transactions from many report 
windows. For more information, see the “Accounts Payable” chapter of the 
User’s Guide.
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Quotes

If you entered customer quotes in the previous version of your company data, 
these are now accessed in the new Quotes task window. 

➤ To edit previous quotes, or to create new quotes, from the Tasks menu, 
select Quotes/Sales Orders, then select Quotes from the submenu. 

For more information, see the “Accounts Receivable” chapter of the User’s 
Guide.

Inventory Item Description

Peachtree Accounting now allows you to have two detailed descriptions for 
inventory items, one for purchases and one for sales. The item description 
that converts will be saved as your description for sales. If you want to add a 
new detailed description for purchases, you can enter this in the Maintain 
Inventory Items window.

Freight

Peachtree Accounting has added a freight field to quotes, sales orders, and 
sales invoices. In order to use this new field, you need to set up the default 
G/L freight account.

➤ From the Maintain menu, select Default Information, then Inventory Items 
from the submenu. Enter the G/L Freight Account to credit when you post a 
sales invoice.

Peachtree-compatible pre-printed forms work with the new freight field. If 
you use pre-printed quotes or sales invoices and enter a freight charge, these 
transactions add the new freight amount on your form. When using freight, 
you should select one of the forms labeled “w/Freight” to include the new field 
on your pre-printed form.

If you have customized quotes and sales invoice forms and decide to use the 
new freight field, you will have to add the Freight Amount data object to your 
custom form. Otherwise, your totals may print incorrectly.

Forms

The standard forms included in Peachtree Accounting have been changed, 
dropping the “R3” from the end. These are the same forms, only the names 
are different. Some new forms have been added including credit memos and 
packing slips which include items you ship to a customer. Also new quotes 
and sales invoice forms have been added which include the new freight field 
(see above).
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Reports

All your customized report and forms are updated to the new Peachtree 
Accounting format.

In financial statements, Peachtree Accounting has added a new G/L Account 
Summary report. This report summarizes account activity over a period of 
time, essentially summarizing the General Ledger. It can be copied from the 
sample company, Bellwether Garden Supply.

To copy this financial statement into your company, follow these 
instructions:

1 Open your company in Peachtree Accounting.

2 From the Reports menu, select Financial Statements.

3 Select the Copy button. The Copy Report window displays.

4 Type a name for the report in the New Report Name field (for example, G/L 
Account Summary).

5 Select BCS as the Source Company.

This is the sample company. If you do not see BCS, check your data path. 
If the sample company data is not installed, you can reinstall Peachtree 
Accounting. Select the Custom installation option, and choose to only 
install the sample company data.

6 Select <Predefined> G/L Account Summary as the report to copy. Then, 
select OK.

The report is copied into your company under financial statements.

You may also notice Bellwether Garden Supply has some examples of 
customized financial statements. These include

• Consolidated Income Statement

• Income Statement/Budget Variance

• Gross Profit by Departments

These financial statements are designed specifically for Bellwether Garden 
Supply. They demonstrate the use of departments and budgets in the chart of 
accounts. If you copy these into your own company, you need to alter the 
design to reflect your company’s chart of accounts.
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Upgrading Inventory from Peachtree Accounting Release 3.0

Important Note: This section does not apply to users upgrading from 
Peachtree Accounting Release 3.5 or higher.

Peachtree Complete Accounting Release 7 has a new, date-based system of 
inventory costing. This could cause slight differences in inventory-related 
general ledger accounts from previous periods, as reflected on previous-
period reports and financial statements.

During conversion, we save any differences in inventory-related general 
ledger accounts for each accounting period. You can choose to create general 
ledger entries in each period that will adjust for these differences (if any). That 
means the information on previous-period financial statements won’t 
change. 

Whether you create the entries or not, Peachtree does not change inventory 
information for previously closed fiscal years. In general, we recommend that 
you do create these general ledger entries. You can always delete the entries 
later.

When You Would Create the General Ledger Entries:

• If you have used pre-conversion account balances to prepare 
financial statements that you distributed to any outside parties. 

• If you have used pre-conversion account balances to prepare income 
tax returns.

When You Might Not Create the General Ledger Entries:

• If you have not distributed Financial Statements to outside parties, 
and...

• …You have not prepared income tax returns based on pre-
conversion account balances.

If you do create these entries, you can view them through Tasks, General 
Journal Entry, by clicking the Edit button. They are dated the last day of the 
period, with a Reference of Conversion and a Description of Inventory 
Conversion Adjustment.

Also, if you do create these entries, be aware that the ending value of your 
Inventory Valuation Report may no longer match your ending value in your 
Inventory General Ledger Account balance. This is because General Journal 
entries are posted directly to the general ledger but do not update your 
inventory ledger. 
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If Your Inventory Valuation Report is Different in Peachtree 
Complete Accounting

It is possible that the information on your Inventory Valuation Report will be 
different after conversion. Basically, this is because Peachtree Complete 
Accounting Release 7 has implemented a more accurate, date-based costing 
method. In particular, we have improved the method of handling cost of 
goods entries when you sell out-of-stock items, and of accurately recosting 
sales or purchase returns.

If Your Ending Inventory Valuation Report After Conversion Does 
Not Match You General Ledger’s Inventory Account

This could be for the reasons explained in the paragraph above, or it could be 
that a transaction used an incorrect General Ledger account (any journal 
entry to any inventory account). It is also possible that you have made general 
journal entries posted to inventory accounts. These entries only post amounts 
and do not affect quantities; therefore, valuation is not affected by general 
journal entries. 

From Peachtree First Accounting

At the beginning of the install process, Peachtree will search for a copy of First 
Accounting. If detected, you will be prompted to replace the existing 
\PTFIRST directory with Peachtree Complete Accounting Release 7. We 
recommend you install the update into the existing Peachtree First 
Accounting (usually \PTFIRST, unless you changed it to a different name 
during the previous installation). However, you may want to make a complete 
backup prior to installing.

If you elect to use a new or alternate directory name, you will be prompted for 
the original registration number and serial number. Enter your First 
Accounting registration and serial numbers; if you don’t know the number, 
install the update into your existing Peachtree First Accounting directory.

Upgrading Inventory from First Accounting Release 1.0

First Accounting Release 1.0 only allowed “non-stock” and “description only” 
inventory items. Peachtree Complete Accounting Release 7 provides 
additional inventory item types such as “stock items” and “assemblies”. These 
new inventory types can track quantity on hand and unit cost. You cannot 
change a converted Release 1.0 inventory item type. If you want to establish 
inventory quantity and cost, you will have to create a new inventory item and 
assign it the new item type of Stock Item or Assembly.
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Upgrading Payroll from First Accounting Release 1.0

If you are upgrading from First Accounting Release 2.0, this section does not 
apply.

IMPORTANT: If you used payroll in First Accounting, when you convert to 
Peachtree Complete Accounting Release 7 before running payroll, you must 
complete the Payroll Setup Wizard in Maintain Default Information. Please 
refer to the User’s Guide or Peachtree Accounting Help for assistance in 
setting up and modifying the payroll tax and field information.

Please note that after converting to Peachtree Complete Accounting, all of 
your employees who were entered in First Accounting Release 1.0 are 
specified as Hourly pay type employees with a Weekly pay frequency and a tax 
status of Single. To modify these defaults you should first set up payroll in 
Maintain Employee Default Information for Employees and then change each 
employee accordingly in Maintain Employees.

Payroll checks that were entered in First Accounting Release 1.0 cannot be 
edited in Peachtree Complete Accounting because of differences in how 
payroll is processed in the two systems.
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Converting Data from other Products
You can convert data from other products including Peachtree Complete 
Accounting for DOS, Quicken, and QuickBooks.

Peachtree Complete Accounting for DOS

You should use the default settings to install Peachtree Complete Accounting 
for Windows. Do not install Peachtree Complete Accounting for Windows 
over your existing Peachtree Complete Accounting for DOS directory.

The company data conversion is only used for companies which used prior 
releases of Peachtree Accounting or First Accounting. This process does not 
convert company data from Peachtree Complete Accounting for DOS. Those 
conversions require a separate utility from Peachtree Software. To order the 
conversion utility for Peachtree Complete Accounting for DOS Version 7 (or 
higher), please call 1-800-247-3224.

Quicken

You can import existing Quicken data in to a new company set up in 
Peachtree Accounting. Due to basic differences between the two programs, 
some of the Quicken data cannot be imported into Peachtree Accounting as 
it is. Rather, you must redefine how you want the data to be handled as part 
of the import program. Understanding the basic program differences can help 
you decide how you want to redefine Quicken data. 

For more information, see “Converting Quicken Data to Peachtree 
Accounting” on page 213.

QuickBooks and QuickBooks Pro

If you created a company using QuickBooks or QuickBooks Pro, you can 
convert your company data to the Peachtree Accounting format. Peachtree 
will convert most QuickBooks lists (such as accounts, customers, vendors, 
employees, items, and jobs) and current balances. 

Peachtree Accounting can only convert company data created in versions 4 or 
5 of both QuickBooks and QuickBooks Pro for Windows. You cannot convert 
company data from an earlier Windows version of QuickBooks or 
QuickBooks for DOS.

For more information, see “Converting QuickBooks Data to Peachtree 
Accounting” on page 245.

Note
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• Tutorials •
Whether you are new to Peachtree Accounting or an experienced user who 
wants to learn more about the new features, this chapter gives you hands-on 
practice using our sample company, Bellwether Garden Supply. 

Lesson Plan
The tutorials are presented in the following easy lessons:

• Lesson I—Getting to Know Peachtree Accounting

• Lesson II—Basic Procedures

• Lesson III—General Ledger

• Lesson IV—Accounts Payable

• Lesson V—Accounts Receivable

• Lesson VI—Payroll

• Lesson VII—Inventory

• Lesson VIII—Job Costing

• Lesson IX—Company Administration

• Lesson X—Time & Billing

Each lesson is set up as an independent module in which you can practice at 
your own pace. For example, everyone new to Microsoft Windows and 
Peachtree Accounting would benefit from Lesson 1—Getting to Know 
Peachtree Accounting. Lesson II—Basic Procedures is a good introduction to 
general operations, but it can be skipped if you have previously used 
Peachtree Accounting. If Payroll is your primary responsibility, feel free to 
skip to Lesson VI. 
50



Lesson Plan
Before You Begin
Before You Begin

In order to follow along with the tutorials, you must have Peachtree 
Accounting installed along with the sample company data files. If you chose 
the Standard or Upgrade setup option, the sample company data is installed 
and you are ready to begin.

Peachtree Accounting includes the following sample company data:

• Bellwether Garden Supply. This is a retail and service company that 
demonstrates Peachtree’s extensive inventory and job tracking 
capabilities.

• Pavilion Design Group: This is a graphic service company that 
demonstrates Time & Billing features.

If you do not have sample company data installed, do the following: 

➤ Reinstall Peachtree Accounting, select the Custom installation option and 
choose to load sample company data only. For more information, see 
“Introducing and Installing Peachtree Accounting” on page 1.

Which Tutorial Do I Use?

Peachtree Accounting offers you two tutorials to get acquainted with the 
software.

• Online Tutorial: This is a multimedia introduction of the basics and 
new features of Peachtree Accounting.

• Written Tutorial: This is a hands-on demonstration of Peachtree 
Accounting (what you are reading at the moment). It uses sample 
company data, allowing you to enter fictitious data and explore 
many features included in Peachtree Accounting.
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Lesson I—Getting to Know Peachtree Accounting

This lesson helps you start, get to know, and move around Peachtree 
Accounting. You will become familiar with the terms used throughout 
Peachtree Accounting, as well as other Microsoft Windows programs. 

You will learn how to

• Start and quit Microsoft Windows and Peachtree Accounting

• Use basic Microsoft Windows features such as windows and menus 
in the Peachtree Accounting environment

• Learn basic Peachtree Accounting terms

• Use Navigation Aids

• Explore Peachtree Accounting online Help

Estimated Lesson Time: 30 Minutes

How to Start Peachtree Accounting

After you have installed Peachtree Accounting, you are ready to begin. 
Starting Peachtree Accounting is essentially a two-step process.

Starting Microsoft Windows 

➤ If you are using Microsoft Windows 95, Windows normally opens 
automatically when you start your computer. If you have a menu option 
when booting your computer, select Windows 95.

Starting Peachtree Accounting

➤ Click the Start button on the taskbar, and then select Programs. Select the 
Peachtree Accounting folder, and then click the Peachtree Accounting icon.
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The Startup Screen

After you have entered the product serial number and registration access 
code, Peachtree displays the Startup screen.

From the Startup screen, you can open an existing company, set up a new 
company, learn about the program through the online tutorial, explore the 
sample company used in these tutorials, or convert a QuickBooks company 
to Peachtree Accounting.

➤ Select “Explore a sample company” to open the sample company data.

The Select a Sample Company window opens and you can choose the sample 
company you want to use. 

The System Date is set to March 15, 2003.

What If There Is No Startup Screen?

If the Startup screen does not display, then someone has turned off this 
option. Follow these instructions to open the sample company data.

1 From the File menu, select Open Company.

Peachtree displays the Open Company window.

2 Select Bellwether Garden Supply, and then click OK.

The sample company opens and all menus are available.
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Peachtree displays the Startup screen each time if the last company opened 
was Bellwether Garden Supply.

Getting to Know Windows

The following illustrates basic parts of a window.

Below are of some basic windows terms:

Window menu: The window menu is opened or closed by selecting the 
miniature button in the upper left corner of any window. Most of the 
Window menu commands deal with controlling the windows on the desktop. 
Double-clicking this button closes the window and/or application.

Title bar: This is the bar at the top of the window. When a company is open 
in Peachtree Accounting, the name of the company is displayed. You can 
select the title bar with your left mouse button and drag it to move the entire 
window around on the desktop.

Menu bar: This displays all the menu options available in Peachtree 
Accounting. These options may change depending on the particular window 
that is open.

Note

Window menu

Window border

Main Menu
bar

Title bar
Minimize, Maximize/Restore,

and Close buttons

Mouse pointer

Navigation Aids

Status bar
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Menus: When you select a heading from the Menu bar, a menu of options 
appears. You then select one of the menu command options available. You 
can select a menu option without using the mouse by holding down the a 
key and pressing the underlined letter in the menu option. For example, 
a+F opens the File menu. When a menu option is dimmed, either it 
doesn’t apply to your current situation, or is unavailable. For example, if you 
use passwords, you may have limited access to certain areas of the program. 
The areas to which you do not have user/password privileges will be dimmed 
(disabled). 

For more information on menu options, refer to the “Basics” chapter of the 
User’s Guide.

Minimize, Maximize/Restore and Close buttons: Selecting the Minimize 
button reduces the current window to a button on the Taskbar. Selecting the 
Maximize button expands the current window to fill the entire desktop, or 
screen area. The Restore button returns the window to its original size. 
Selecting the Close button closes the current window and/or application.

Scroll bar: If there is too much information to fit in one window, a scroll bar 
displays enabling you to move the window to see additional information. 

Scroll arrow: When selected, the scroll arrow moves the window up, down, 
or sideways to view more information if not all contents can be displayed at 
once.

Scroll box: Selecting the scroll box, you can drag it up or down to quickly 
move through the window contents.

Status bar: The gray bar at the bottom of the Peachtree Accounting window 
shows abbreviated help information about the current field. 

The status bar also shows the current system date (today’s date) and the 
current accounting period. It will display an alarm clock icon when there are 
Alerts due. (Alerts are action items you want to be reminded of; they are set 
up through the Tasks, Action Items option.) You can hide the status bar by 
unchecking the option through the Options menu.

Window border: The window border, when it is thick, can be used to size the 
window. Move the mouse pointer to the border; when you see a double-sided 
arrow, click and hold the left mouse button and drag the arrow until the 
window is the desired size.

Help Information

Alert Notification Current Accounting Period

System Date
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Mouse pointer: This arrow-shaped cursor shows where you are on the screen 
when you have a mouse installed.

Navigation Aids: These are unique Peachtree Accounting tools that offer you 
a graphical alternative to the Main Menu options. The major functions of the 
program are represented as icons or pictures that show you how tasks flow 
through the system. You can use the mouse to select an icon to perform the 
specific task you want.

Navigating in Windows

Navigation Aids

In addition to the Main Menu options, you have another method of opening 
windows in which to perform tasks or data entry. This option is called the 
Navigation Aid and is unique to Peachtree Accounting.

It allows you to click on icons instead of choosing menu options. It also helps 
you understand the task flow of information in certain areas of Peachtree 
Accounting.

To... Do This...

scroll through a window click the scroll bar or scroll arrow, or drag 
the scroll box.

enlarge a window to fill the screen double-click the title bar, or click the 
Maximize button.

restore a window to its previous size double-click the title bar, or click the 
Restore button. When a window is 
maximized, the Maximize button 
changes to a Restore button.

reduce a window to a button on the 
taskbar

click the Minimize button. To display a 
minimized window, simply click its 
button on the taskbar.

move a window drag the title bar.

close a window click the Close button, double-click the 
upper-left miniature button above the 
Window menu, or press q.
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What If You Don’t See the Navigation Aids?

If you don’t see the Navigation Aids, it’s possible someone turned off this 
option. To turn it back on, select View Navigation Aid from the Options 
menu (you will see a check mark beside the menu option when it is turned 
on).

1 If the Action Items window is still open, close it by selecting the Close 
button.

2 Click the Payroll Navigation Aid. This is a folder at the bottom of the 
window, above the status bar.

Notice that the Navigation Aid is divided into three sections: Maintain, 
Tasks, and Reports. These sections correspond to the menu structure in 
Peachtree Accounting. Maintain refers to records or lists that you would 
keep on file. Tasks refer to everyday activities that you perform. Reports 
provide useful information about the selected accounting area. 

3 Click the Employees icon to open the Maintain Employees/Sales Reps 
window.

This is the same window that would display if you were to select 
Employees/Sales Reps from the Maintain menu. 

 

 

Each Navigation Aid
contains pictures to
help you remember

activities that you
perform in Peachtree

Accounting. Click
the icon to go to the

selected area.
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More Peachtree Accounting Terms

Before you begin entering data into your Peachtree Accounting company, 
let’s look at some of the other common terms referred to in Peachtree 
Accounting and Windows.

Let’s take a closer look at the Maintain Employees/Sales Reps window.

❶ Toolbar: The toolbar at the top of most windows shows graphical 
representations of commands and functions accessible from the window.

❷ Folder Tabs: Folder tabs are common in most Peachtree Accounting 
windows (also known as dialog boxes). Each tab stores and organizes 
additional information on the current record. Here, for example, the 
information you can track for an employee is subdivided into five sections 
including General, Custom Fields, Pay Information, Employee Fields, and 
Employer Fields.

❸ Lookup Boxes: Boxes with a magnifying glass icon beside them indicate a 
lookup box for selecting or adding a record. You can click the magnifying 
glass icon, right-click your mouse in the field, or type ? in the field to display 
a list of choices. In addition, you can double-click the field in some windows 
or type a + to add a new record.

❹ Option Buttons: These buttons can be selected by clicking with the mouse 
or pressing the z.

❺ Text Boxes: These are rectangles or fields where information can be 
entered.

❶

❸
❹

❺

❻

❽

❷

❼

❾
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❻ Drop-Down Lists: Fields that have lists of available information choices. 
These fields have an arrow beside the text box. Click the arrow button and 
make a selection. (You can also use the t key to highlight the arrow button 
and press e to open the list.)

❼ Date Boxes: Boxes in which you enter dates have a small calendar icon 
beside them. You can click this icon, or right-click the mouse while in this 
field, to display a pop-up calendar. You can search for and select the date you 
want by double-clicking within the calendar.

❽ Check Boxes: Options that are selected when an X (or check mark) appears 
in the box. To select a check box, click the box with your mouse or press 
z.

❾ Arrow Buttons: These buttons indicate that more information is available. 
Selecting an arrow button generally opens a second window. (In this case, the 
Employee Beginning Balances window opens.)

Getting Help with Peachtree Accounting

When you need information about a procedure or how to use a particular 
feature, the Peachtree Accounting Help system is one of the most efficient 
ways to learn. You can access Peachtree Accounting Help in the following 
ways:

• From most Peachtree Accounting windows, select the Help button: 
This button displays a Help topic pertaining to the particular 
window currently open. You can also press 1 to open a Help topic 
about the currently displayed window.

• Select “Contents and Index” from the Help menu: This option 
opens the Peachtree Accounting Help file where you can explore the 
table of contents, scroll through an index, or search for a desired 
topic. The Find tab searches for every instance of the word or phrase 
you submit. The Ask a Question tab searches for topics related to 
your inquiry.

• Select “What’s This” from the Help menu or press s+1: Your 
mouse pointer will change to a question mark symbol. Click the field 
or object you want information about and a pop-up definition will 
appear. You can also click your right mouse button on an area of the 
window, and then select “What’s This?” from the list.

Right-click in an
area of the

window and select
“What’s This?” to

view the pop-up
definition.
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If you are new to using online Help, select “Using Peachtree Accounting 
Help” from the Contents tab of the Help menu. This gives you a basic 
overview on using the Windows Help engine.

Using Peachtree Accounting Help

The online Help is also a great reference for information in setting up a 
company. Let’s take a look at a list of the sample company charts of accounts 
included with Peachtree Accounting.

1 From the Help menu, select Contents and Index. 

The “Help Topics: Peachtree Accounting Help” window appears with the 
Contents tab selected.

2 With the Contents tab selected, double-click the Reference book.

The Reference book opens and displays all Reference topics available, 
including an Accounting Primer for introduction to basic accounting.

3 Scroll down and double-click the Help for Your Business book.

The Help for Your Business book opens.

4 Double-click the “Sample Charts of Accounts” book.

This opens a Help window displaying a list of sample charts of accounts. 

Note

The Contents tab
acts as a starting
point, displaying

categories of
information

available. The
Contents tab is

similar to a table
of contents.
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5 Scroll through and select any sample business that interests you (for 
example, Construction Company).

The selected company’s chart of accounts appears.

6 When finished, select Exit from the File menu (or click the Close button).

You can also open Help from within an open Peachtree Accounting 
window.

7 Open the Maintain Employees/Sales Reps window. Select the General tab, 
and then press 1.

Peachtree Accounting Help displays a window listing all the topics 
associated with the Maintain Employees/Sales Reps window. (You also 
could have displayed this window by selecting the Help button from the 
toolbar.)

8 Click the “How Do I?” button at top of the Help window.

The “How Do I?” Help window appears. “How Do I?” Help windows 
provide a list of procedural topics related to the program area you are 
currently using. If you select one of these topics, step-by-step 
instructions will be provided. 

9 Select the “Set up an employee” hypertext jump.

Step-by-step instructions appear, explaining how to set up an employee 
record.

10 Close the “How Do I?” and Peachtree Accounting Help windows. You 
return to the Maintain Employees/Sales Reps window.

11 Press q to close the Maintain Employees/Sales Reps window.
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Review of Lesson I

Let’s review some of the things we learned in this lesson.

• When you start Peachtree Accounting, you can optionally have the 
Startup screen display. This option can be turned off from the 
Options menu.

• Press a and the underlined character to choose an option or to 
jump to a text box. On menus, you can press the underlined letter to 
select an option.

• You can have optional elements such as Navigation Aids and the 
Status bar display on your Peachtree Accounting desktop. These 
features can be turned on or off from the Options menu.

• Press 1 or select a Help button from any message window to 
display Help topics.

 Quitting Peachtree Accounting

Now that you have been introduced to Windows and Peachtree Accounting, 
you are ready to go on to Lesson II. If you would like to quit Peachtree 
Accounting or Windows follow the step below.

Quit Peachtree Accounting

➤ From the File menu, select Exit. 

Do not turn off your computer while a company is open in Peachtree 
Accounting. If you exit Windows without quitting Peachtree first, a message 
asks if you are sure you want to close the current company.Warning
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Lesson II—Basic Procedures
This lesson introduces you to the basic procedures for entering data, editing 
records, and working with Peachtree Accounting information.

You will learn how to

• Set up global options

• Back up and restore your company data

• Look up data records

• Enter a sample record

• Move through data entry fields

• Edit data records

• Print a report

• Use action items

Estimated Lesson Time: 30 Minutes

Beginning the Lesson

If you are continuing from Lesson I, skip this section and proceed with the 
lesson.

If you are just starting the Lesson, start Peachtree Accounting and open up 
the sample company Bellwether Garden Supply. If the Action Items window 
appears, close it for right now. 

For more information, see “How to Start Peachtree Accounting” on page 52.

T
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Setting Up Tutorial Global Options

You can set up preferences (global options) that customize how your 
Peachtree Accounting company data appears. These options affect each 
company displayed by the current computer. Other computers displaying 
Peachtree Accounting data may use an alternate set of options.

We will set up options that impact these tutorials.

1 From the Options menu, select Global.
T

2 In the Accounting tab, select Manual Decimal Entry and 2 as the number of 
decimal places.

When entering data, we will manually enter decimals to two places.

3 In the Hide General Ledger Accounts section, select Accounts Payable.

Make sure the Accounts Receivable and Payroll check boxes are clear 
(not checked).

4 In the Other Options section, make sure the following options are selected:

• Warn if inventory item is out of stock

• Recalculate cash balance automatically in Receipts and Payments

5 Select the General tab.

6 Make sure the Line Item Entry Display option is set to two lines.
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7 Select both options for Smart Data Entry.

Make sure there are check marks in the “Automatic field completion” 
and “Drop-down list displays automatically” check boxes.

8 When finished, select OK to close the Maintain Global Options window.

Most of these options will be explained throughout the tutorial lessons. 
Setting them up now will allow your display to match what the tutorial is 
using.

Backing up the Sample Company Data

If you are the first person in your company to work with this tutorial, then you 
have the honor of backing up the sample company data. This step is 
important because we are going to be entering information and posting 
transactions. Others in your office will need a clean copy of the sample data 
so they can enter the same information and encounter the same conditions. 

If you are not the first person to run through this tutorial, you can read this 
section to understand the procedure, and then proceed to the next section, 
“Restoring the Sample Company Data.”

1 From the File menu, select Back Up. The Back Up Company window 
appears.

2 Click the Back Up Now button.

3 In the Save Backup window, specify the path and file name for your backup 
copy. For example, SAMPLE.ptb.

4 Click the Save button. Peachtree displays the estimated size of your backup.

5 Click OK. The system displays the progress of the backup until it is 
complete.

For more information on backing up data, refer to the “Company 
Administration” chapter of the User’s Guide.

Note

Note
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Restoring the Sample Company Data

If you are not the first person to use this tutorial, you must restore the sample 
company data to its original state. Open the company you want to restore.

1 From the File menu, select Restore.

2 Select the backup of the sample company data. (SAMPLE.ptb.)

3 Click the Open button to begin the restore process. The system displays the 
progress of the restore procedure.

You will receive a warning message that you are about to overwrite 
existing data. Select OK to continue.

Entering Information

In order to get accustomed to entering information in Peachtree Accounting, 
you’re going to enter yourself as an employee in our sample company, 
Bellwether Garden Supply. Our sample company uses a variety of coding 
schemes for identifying employees. One method is to use the first letter of the 
first name along with the last name and a sequential two-digit number. If you 
try to use a code already in use, a message will appear. Just pick a different 
code.

For example, if your name was Ellen Adams, you might enter EADAMS-02. 
This is because EADAMS-01 is already used by an employee named Elliot 
Adams.

Because we’re in the sample company, you don’t have to worry about 
accuracy, or about damaging your company records. We’re more interested 
in learning how to move around and save records. Always open Bellwether 
Garden Supply before beginning or resuming any of the lessons in this tutorial.

Note
66



Lesson II—Basic Procedures
Entering Information
Using Data Lookup Lists

1 To begin the lesson, from the Maintain menu, select Maintain Employees/
Sales Reps.

Peachtree displays the Maintain Employees/Sales Reps window.

First, let’s look at a list of existing employee IDs already entered in our 
sample company. 

2 Select the magnifying glass button next to the Employee ID field.

Alternatively, you can right-click your mouse in the Employee ID field or 
type ? while the cursor is in the Employee ID field. All three methods 
display a lookup list of employees.

3 Select any employee on the list by double-clicking the ID.

The employee information appears in the fields. You can select other 
tabs such as custom fields to display additional information on the 
employee. If you selected a sales rep, you may have limited access to 
certain tab areas. For now, return to the General tab.

Entering a New Record

1 Select the New button to clear the window.

2 Type an employee ID for yourself and press e. The cursor moves to the 
Name field.

Case-Sensitive Codes

All ID codes (such as employee ID) are case sensitive. This means that 
JØØ3 and jØØ3 are considered different codes. Capital letters sort 
before lowercase letters.

Cursor Movement

You can use e or t to move forward to the next field (or text box) 
in data entry windows. Use s+e or s+t to move back a field. 
You can hold the a key down and press the underlined letter next to a 
field text box to jump to that field. For example, to jump to the Social 
Security # field, hold the a key down and press C, the underlined 
letter.
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3 Type your name and press e until the cursor moves to the Address field.

4 Type your street address information. There are two lines for the address, so 
you can enter an ATTENTION line or a PO Box number, if necessary. Press 
e to move to the next row of fields (City, ST Zip).

5 Type your city, state, and ZIP Code, pressing t or e after each. After 
the ZIP Code, move to the Country field.

None of the other information is required. We will look at the employee 
fields more closely in the Payroll lesson. 

6 Add any information you would like to add, and then press 5 to save the 
record.

Pressing 5 saves records in Peachtree Accounting windows. You could 
alternatively select the Save button.

You can click on the magnifying glass beside the Employee ID field, to 
display the employee list and see that your name has been added. 

Congratulations! You are an official employee of Bellwether Garden 
Supply!

Editing a Record

One of our employees, Dorothy Beckstrom, just moved to a new address and 
has a new phone number. Let’s make the change.

Using Smart Data Entry

To speed up the process of looking up data, Peachtree has Smart Data Entry 
options. Instead of looking up a known record using the magnifying glass or 
typing in the ID, you can type in the first couple of letters and Peachtree will 
do the rest for you. This option is previously set up in the Maintain Global 
Options window.

1 With the cursor in the Employee ID field type D (capital D) and press e 
to accept the selection.

This demonstrates Smart Data Entry. The Employee ID list appears, with 
Dorothy Beckstrom selected, because hers is the first name in the list 
starting with D.

2 Press e to accept the name. The cursor moves to the Employee Type 
option. 
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3 Press e to skip the Employee Type option and move to the Address 
field. 

Notice that the field text is highlighted.

Dorothy’s new address is:

3588 Atlanta Hwy. 
Apt. E-2
Atlanta, GA 30329-1209

4 Without using your mouse or pressing the D key, start typing 3588 
Atlanta Hwy.

Peachtree deletes the old text for you and adds your new text as you type. 
You can edit any text field in Peachtree Accounting using this method.

5 Press e and type Apt E-2. Press e again.

6 Type Atlanta e GA e 30329-1209 e. 

7 Keep pressing the e key (or t key) until the Telephone 1 field is 
highlighted. Type 404-380-9921 and press e.

You could also press the a key and type 1 to highlight the Telephone 1 
field.

8 Press the Save button or 5 to record the change.

Dorothy’s employee record is now changed. Any future payroll 
transactions will refer to her new address.

9 Close the window by clicking the Close button.
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Displaying and Printing a Report

Now that you have entered and displayed a list of employees, let’s print 
an employee list. If you do not have a printer currently set up, read along 
in the section, following as much as you can.

1 From the Reports menu, select Payroll.

The Select a Report window appears. The Payroll program area is 
highlighted on the left-hand side. A list of payroll reports and forms are 
listed on the right-hand side of the window. The report we want is the 
first item on the list, Employee List.

First, we will display the report. Then, we will print it.

2 Double-click Employee List from the Report List.

The report appears onscreen. You will see your name listed as an 
employee and Dorothy Beckstrom’s new address.

If you want to print the report, select the Print button. The Print 
window appears, notifying you which printer is set up as the current 
default. Select OK to print; otherwise select Cancel. You should return to 
the report displayed onscreen.

3 Press q to close the Employee List report window.

4 Press q to close the Select a Report window.

Using Action Items

Action Items offer you four tools to help manage your business:

• Events: Notes or messages that are generated by everyday 
transactions. For example, when a customer’s invoice is past due, or a 
sales quote is about to expire.

• To Do: Notes to yourself about tasks that you need to perform.

• Alerts: Warnings you create about potential problems or situations 
that merit special attention. For example, you could set up alerts to 
notify you when a customer’s year-to-date sales exceeds a certain 
dollar amount or if an inventory item goes below minimum stock 
level.

• Tips: Helpful hints about using Peachtree Accounting.

For our sample company, Bellwether Garden Supply, the Action Items 
window appears every time you open the company. We previously closed this 
window.
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➤ From the Tasks menu, select Action Items.

Entering a To Do Action Item

1 Select the To Do tab.

2 Click in the Notes column, on the next available line of the To Do list.

3 Enter a brief message, like Make flyers for new promotion and press 
e.

4 You can change the date if you like, but the default (automatically 
displayed date) is fine for our purposes. 

5 This action item will appear on your To Do list until it is marked as 
completed and you delete it.
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Entering an Event Action Item

Let’s create an event to remind us of a meeting tomorrow with one of our 
customers.

1 Select the Event button.
T

2 Select Customer/Prospect as the type of event. In the ID field, type FR (in 
capital letters) and press e. 

Peachtree Accounting automatically continues filling in the field with 
the Customer ID FREEMAN-01. The customer name below the ID field 
displays Freeman Enterprises/Darlene Freeman.

3 Type 3/16/03 as the date and press e.

You can also use the pop-up calendar to enter the date.

4 Now select the Meeting option as the Event Type and press e to move 
to the Note field. Type the Note as 12:00 Lunch meeting with Ms. 
Freeman to go over new contract. Press e.

5 Select the Display in Action Items check box and enter one (1) day before 
the event.

6 Select 5 to save the event. Click the Close button to close the Create 
Event window.

You will now see the event we just created in the Activities section of the 
Events tab. The event is scheduled for tomorrow. We elected to have the 
event appear a day ahead of time to remind us of the meeting. 
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Using the Action Item Log

Action Items can be displayed in many areas of Peachtree Accounting. Let’s 
look at action items using a different method.

1 Close the Action Items window.

2 From the Maintain menu, select Customers/Prospects.

The Maintain Customers/Prospects window appears.

3 In the Customer ID field, type FR and press e to display the Freeman 
Enterprises customer record.

Most of the information in this window will be covered in the Accounts 
Receivable lesson. For now, we want to look at the action items that 
involve this customer.

4 Select the Log button to display the Customer Event Log.

The Customer Event Log displays several events including an invoice 
sent and notification that the invoice was due. You will also see the lunch 
meeting event. Using action items in this manner is an excellent way to 
look at the customer contact activity over a period of time.

5 Press q to close the Customer Event Log window and q again to close 
the Maintain Customers/Prospects window.
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Choosing a Peachtree Accounting Color Scheme

You can choose the colors that display in Peachtree Accounting windows. 
There are five color schemes from which to choose. The color schemes range 
from traditional Windows colors to bright vibrant colors similar to the 
Navigation Aids.

1 From the Options menu, select Global. The Maintain Global Options 
window appears.

2 Select the General tab.

3 Choose an alternate color scheme (for example, Sand) at the bottom of the 
window, and then select OK.

You must restart Peachtree Accounting, to display the new color scheme.

For information on color schemes, see the “Company Administration” 
chapter of the User’s Guide or press the Help button.

4 Exit Peachtree Accounting.

5 Restart Peachtree Accounting and open the sample company, Bellwether 
Garden Supply.

6 Explore various areas of Peachtree Accounting to examine the new look. Try 
several different color schemes to see which one you like best. When 
finished, continue with this tutorial.

Review of Lesson II

Let’s review some of the things we learned in this lesson.

• When restoring company data, you must use the same method and 
destination you used when you backed up the data.

• When looking up ID codes, you can select the magnifying glass in 
the field to display the list.

• All ID codes are case sensitive. This means that JØØ3 and jØØ3 are 
considered different codes. Capital letters sort before lowercase 
letters.

• Press e or t to move forward a field in a window. Press 
s+e or s+t to move back a field.

• To save a record, press 5 or select the Save button.
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• If the cursor activates a field and the text is highlighted, you can 
simply start typing to change the field text automatically.

• With the Smart Data Entry options turned on, Peachtree Accounting 
automatically displays ID codes for you based on partial data entry.

• To close a window, press c+4, q, or select the Close button.

• To close Peachtree Accounting, press a+4 or select Exit from the 
File menu.

• Action items can be entered and displayed in many Peachtree 
Accounting windows.

Now that you have been introduced to basic data entry procedures of 
Peachtree Accounting, you are ready to proceed to Lesson III—General 
Ledger.
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Lesson III—General Ledger

This lesson prepares you for setting up your company. You will learn how to 
set up and maintain your chart of accounts, the basis for the General Ledger. 
Next, you will learn how to enter a transaction that will post to the General 
Ledger.

You will learn how to:

• Enter a new account into the chart of accounts

• Enter a prior year adjustment for an account

• Allocate a budget amount for an account 

• Enter and post a transaction (General Journal entry)

• Change accounting periods.

Estimated Lesson Time: 30 Minutes

Beginning the Lesson

If you are continuing from Lesson II, skip this section and proceed with the 
lesson.

If you are just starting the lesson, do the following:

1 Start Peachtree Accounting and open up the sample company, Bellwether 
Garden Supply. 

2 If the Action Items window appears, close it for right now. 

3 From the Options menu, select Global. The Maintain Global Options 
window appears.

4 In the Accounting tab, do the following:

• Select Manual Decimal Entry and 2 as the number of decimal places.

• In the Hide General Ledger Accounts section, select Accounts 
Payable. Make sure Accounts Receivable and Payroll Entry check 
boxes are clear (not checked).

• Select the “Warn if inventory item is out of stock” option.

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

Tu
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Working with the Chart of Accounts
5 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could have other global options selected as well. However, the above 
options are the only ones that directly affect this tutorial. 

6 When finished, select OK to close the Maintain Global Options window.

Working with the Chart of Accounts

Peachtree Accounting comes with over 75 sample charts of accounts already 
set up that you can choose from to customize or copy into your own chart of 
accounts. You can create your own chart of accounts from scratch. However, 
we recommend you use one of the chart of accounts from the sample 
companies as a template—keeping the basic structure but editing and adding 
individual accounts to suit your needs. You can copy the sample chart of 
accounts when setting up your company during New Company Setup.

Entering an Account

1 From the Maintain menu, select Chart of Accounts.
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After setting up the sample company, we noticed an error in our chart of 
accounts. We forgot to enter a $2000.00 money market fund created at 
the end of last year, and accidentally included the balance in our savings 
account. We want to first create an account for these funds. We can select 
any unused account number, but it is wise to stay within traditional 
account number ranges. For our sample company, all asset accounts are 
in the ten-thousand level (10000 to 19900).

2 In the Account ID field, type 1Ø5ØØ and press e. The cursor moves to 
the Description field.

3 Type Money Market Fund and press e. The cursor moves to the 
Account Type field.

4 Enter or select Cash from the Account Type lookup box and press e.

5 Select Save to establish the account.

Making a Prior Year Adjustment (Beginning Balance)

Normally you would enter beginning balances after entering your chart of 
accounts. However, our sample company has already established the account 
beginning balances and entered transactions. We want to record our money 
market fund balance as of the end of the last fiscal year.

1 Select the Beginning Balances button.

2 The Select Period window appears.

Period 1 begins 1/1/03. We will enter a balance prior to this period.

3 Scroll down and select From 12/1/02 through 12/31/02, and then click OK. 
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Peachtree Accounting operates on a forced-balance trial balance. The 
trial balance must always balance or equal zero (Ø). This means the sum 
of assets and expenses must equal the sum of liabilities, equity, and 
income.

First we will decrease the balance of the savings account. Then we will 
make up the difference by adding the balance of the new money market 
fund.

4 Select Account 10400-Savings Account, and enter 5500.00 in the Assets, 
Expenses column and press e.

Notice the Trial Balance is now out of balance (instead of 0.00, it displays 
-2000.00).

5 Enter 2ØØØ.ØØ for Account 10500-Money Market Fund and press e.

The Trial Balance is now back in balance (displays 0.00).

6 Select OK to save the adjustment.

The beginning balance is posted to the General Ledger and will display 
properly in our financial statements. You return to the Maintain Chart 
of Accounts window.

Before you leave this
window, the Trial

Balance should
equal zero (in

balance).

If the Trial Balance is
out of balance and

you select OK
(not recommended),
Peachtree will make
the correcting entry

for you.
79



Tutorials
Getting Started Guide3
What If You Are Out of Balance?

Sometimes the trial balance may be out of balance. It’s a good idea to 
investigate this first and make the adjusting entries. However, if the 
reason cannot be determined, Peachtree Accounting will make a 
correcting entry to temporarily put you back into balance. When you 
select OK (with the trial balance out of balance) on the Prior Year 
Adjustments or Beginning Balances window, a message appears warning 
you that an equity account will be created (or updated) to contain the 
difference or out-of-balance amount. You can select Cancel to return to 
the window and make corrections, or OK to accept the correcting entry.

For more information on the chart of accounts and beginning balances, 
refer to the “General Ledger” chapter of the User’s Guide.

Entering Budgets

Let’s enter a new expense account and allocate a budget amount throughout 
the upcoming year.

1 In the Maintain Chart of Accounts window, select the New button.

2 In the Account ID box, type 717ØØ and press e. 

3 In the Description field, type Cellular Phone Expense and press e.

4 Select the Budgets tab.

5 Type 18ØØ.ØØ in any Amount field for Budget This Year. Press e.
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6 Select the Allocate button on the Budget This Year side.

The $1800.00 is distributed over all accounting periods during the year, 
with any odd pennies being distributed to the last accounting period.

7 Select Save, and then select Close to close the window.

Budget information can be viewed in financial statements and certain 
General Ledger reports.

Posting Transactions to the General Ledger

Peachtree Accounting offers two methods for posting transactions.

• Real-Time Posting: Transactions are written to the General Ledger 
as they are entered and saved. If your company uses real-time posting 
you will select the Post button to record a transaction.

• Batch Posting: Transactions are saved in a temporary holding area 
and later posted in a group. You can print registers and check the 
batch of transactions before they are posted to the General Ledger. If 
your company is using batch posting, you will use the Save button to 
record a transaction. Later, you post all the saved transactions at one 
time by selecting System, and then Post from the Tasks menu.

There are several advantages for using either posting method. Refer to the 
“General Ledger” chapter of the User’s Guide to determine which method best 
suits your company’s needs.

You can change posting methods at any time by selecting Company 
Information from the Maintain menu. Our sample company, Bellwether 
Garden Supply, uses the real-time posting method.

The General Ledger and General Journal

The General Ledger contains all journal transactions posted to the chart of 
accounts and keeps track of account balances. Each program area contains 
journals that list the transactions for that specific area. For example, Accounts 
Receivable information (sales orders, sales invoices, and receipts) is recorded 
in the Sales Order Journal, Sales Journal, and Cash Receipts Journal, 
respectively.

If you are operating in an accrual-based company, all journal transactions are 
posted collectively to the General Ledger. If you are operating in a cash-basis 
company, some journals will not be included, such as the Purchase Journal 
and Sales Journal. These purchase and sales transactions are posted to the 
General Ledger in the Cash Disbursements and Cash Receipts Journals, 
respectively.
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The General Journal contains transactions that establish and adjust account 
balances. It is used to transfer funds from one account to another or make 
correcting journal entries. If you make beginning balance entries or prior year 
adjustments in the Maintain Chart of Accounts window, Peachtree 
Accounting generates the entries for you and inserts them into the General 
Journal. Other examples include monthly accruals, asset depreciation, and 
end-of-year adjustments. In the General Journal you distribute the debits and 
the credits. In other journals, Peachtree Accounting automatically distributes 
the entry for you.

General Journal Entry

Our sample company, Bellwether Garden Supply, has two checking accounts. 
One is used for disbursements (accounts payable) and the other is used for 
payroll. Let’s transfer $5000.00 from the Regular Checking account to the 
Payroll Checking account to cover an upcoming payroll run.

1 From the Tasks menu, select General Journal Entry. 
 

2 Press e to accept the displayed date in the Date field.

The cursor moves to the Reference field. You could type anything here to 
identify the journal entry.

3 Type Transfer101 and press e. The cursor moves to the first Account 
No. field.

4 Type the account number for the Regular Checking Account—1Ø2ØØ and 
press e.
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5 Enter the following description: Transfer from Regular Checking to 
Payroll Checking and press e twice to move to the Credit field.

6 We are decreasing this account by $5000.00, so type 5ØØØ.ØØ and press 
e twice.

We could have entered the debit for the payroll account first. However, it 
makes no difference.

Notice that the Totals field in the lower right corner now displays 
5000.00 beneath the Credit column of the table. The Out of Balance field 
totals 5000.00. To complete the entry and remain in balance, this total 
must equal zero (debits equal credits).

Once you pressed e twice, the cursor moved to the Account No. field 
on the second line to begin the new line item entry. Now we are going to 
enter the offsetting debit ($5000.00 to the Payroll Checking Account).

7 Type 1Ø3ØØ and press e. The Payroll Checking Account appears in the 
account description area. 

8 Accept the Transfer from Regular Checking to Payroll Checking 
description by pressing e and move to the Debit field.

9 We are increasing the balance of the account by $5000.00, so type a debit 
amount of 5ØØØ.ØØ and press e twice.

Notice the Totals field now displays 5,000.00 in the Debits column. The 
Out of Balance field now displays Ø. This means the journal entry is in 
balance and can be posted.

10 Select Post to record this journal entry.

11 Press q to close the window.

Accounting Periods

Accounting periods are set up when you create your company during New 
Company Setup. Once you have defined your accounting periods, you cannot 
change the structure of the periods. You can only change the current 
accounting period, moving forwards or backwards within the structure 
already established.

Peachtree Accounting allows up to 26 open periods. This allows you to have 
last year’s history available for editing or adjusting throughout the current 
fiscal year. You can work in the second year without closing the first year.

➤ To view the current accounting period, look at the status bar.
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If you do not see the status bar, turn on the option by selecting View Status 
Bar from the Options menu.

Bellwether Garden Supply is set up with 12 accounting periods per fiscal year. 
The current accounting period is Period 3—3/1/03 to 3/31/03. If the current 
accounting period was February 2004, then the status bar would read Period 
14—2/1/04 to 2/28/04.

The date to the left of the current accounting period is the system date. 
Normally this represents today’s date or the current date of your computer’s 
clock. However, in our sample company, we have set this date to always be 
3/15/03 for tutorial purposes.

Changing Accounting Periods

At the end of each accounting period you should change to the next 
accounting period. Peachtree Accounting does not actually close accounting 
periods. You change accounting periods at will, moving back and forth 
through the fiscal year. When you post a transaction, Peachtree Accounting 
selects the correct period based on the transaction date. 

This brings up an interesting point. You cannot post a new transaction to a 
previous accounting period. This feature ensures that a new entry will not be 
inadvertently posted to a period for which financial statements have been 
reported. However, you can post future transactions while remaining in the 
current accounting period.

For example, the current accounting period in our sample company is Period 
3—3/1/03-3/31/03. You can post new transactions dated 3/2/03 or 5/4/03. 
However, you cannot post a new transaction dated 2/6/03 because it’s in the 
past. The only way you can add this old transaction is to change accounting 
periods back to Period 2—2/1/03-2/29/03—then enter it.

Entering future transactions is a powerful feature and can save you time. This 
is especially true if you are approaching the end of a current accounting 
period and are not quite ready to change. It also allows you to post recurring 
transactions.

Note
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There are a couple of additional rules to consider when changing accounting 
periods.

• All transactions currently entered in the General Ledger must be 
posted before you can change accounting periods. If you are using 
real-time posting, this is already done for you. If you are using batch 
posting, then you must post all journals before moving forward. 
(Our sample company uses real-time posting, so this rule does not 
affect us.)

• If you are using a network, all other Peachtree Accounting users 
must exit the company data before you can change accounting 
periods. Basically this means only one user can be working in the 
company when changing accounting periods.

Let’s pretend it’s the end of the month. We are ready to change accounting 
periods to move ahead.

1 From the Tasks menu, choose System, and then select Change Accounting 
Period.

2 Select Period 4—Apr 1, 2003 to Apr 30, 2003 from the drop-down list, and 
then select OK.

3 Peachtree Accounting asks if you would like to print reports before 
continuing. Select Yes.

Generally it is a good idea to print and file reports before you change 
accounting periods. This maintains an audit trail for your records. You 
can select which reports you want to print. You should also print open 
invoices and checks.

4 To save time and paper, let’s not print any reports at this time. Select 
Cancel. You will return to the Change Accounting Period window.

5 Select Period 4—Apr 1, 2003 to Apr 30, 2003—again from the drop-down 
list, and then select OK.

This drop-down list
box displays the

current accounting
period.

The Current Calendar year 
field refers to the current 
payroll year of the 
company.
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6 Select No when given the option to print reports.

Peachtree Accounting checks for unposted entries and changes your 
accounting period. Notice the status bar now displays the current 
accounting period as Period 4—4/1/03 to 4/30/03. You can begin 
entering transactions for period 4 or later. You cannot enter new 
transactions dated prior to 4/1/03.

For tutorial purposes, let’s change back to period 3 to prepare for the 
next lesson.

7 From the Tasks menu, choose System, and then select Change Accounting 
Period. The Change Accounting Period window appears.

8 Select Period 3—Mar 1,2003 to Mar 31,2003—from the drop-down list 
and then select OK.

When changing to previous periods, Peachtree Accounting does not ask 
if you want to print reports. (This only occurs when you move forward.)

Review of Lesson III

Let’s review some of the things we learned in this lesson.

• You can create your own chart of accounts from scratch. However we 
recommend you use a chart of accounts from one of the sample 
companies as a template—keeping the basic structure, but editing 
and adding individual accounts to suit your needs. 

• You can only enter chart of account beginning balances in the 
current fiscal year if no transactions have been posted to the General 
Ledger. If transactions are posted, you must enter prior-year 
adjustments.

• Peachtree Accounting operates on a forced-balance trial balance. The 
trial balance must always balance or equal zero (Ø.ØØ). This means 
the sum of assets and expenses must equal the sum of liabilities, 
equity, and income. 

• When entering budget amounts for an account, enter the yearly 
total, and then select the Allocate button to have Peachtree 
Accounting subdivide and distribute budget amounts for individual 
accounting periods throughout the year. 

• Peachtree Accounting offers two methods for recording transactions 
to the General Ledger—real-time posting and batch posting. You can 
change posting methods at any time.

• The General Ledger contains all journal transactions posted using 
the chart of accounts and keeps track of account balances.
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• The General Journal contains transactions that establish and adjust 
the chart of account balances. It is also used to transfer funds from 
one account to another or make correcting entries. In the General 
Journal you distribute the debits and the credits. In other journals, 
Peachtree Accounting automatically distributes the entry for you. 
Make sure the Out of Balance amount equals zero (Ø), or you can’t 
post the General Journal entry.

• At the end of each accounting period you should change to the next. 
Peachtree Accounting does not actually close accounting periods. 
You change accounting periods as needed, moving back and forth 
through the fiscal year. 

• You cannot post a new transaction to a previous accounting period. 
However, you can post future transactions while remaining in the 
current accounting period. 

• All transactions currently entered in the General Ledger must be 
posted before you can change accounting periods.

Now that you have been introduced to the General Ledger area of Peachtree 
Accounting, you are ready to proceed to Lesson IV—Accounts Payable. 

If you would like to quit Peachtree Accounting, follow these steps.

Quit Peachtree Accounting

➤ From the File menu, select Exit. 

For a keyboard shortcut, you could select a+4 to exit Peachtree 
Accounting as well.

This closes the current company and exits Peachtree Accounting. 
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Lesson IV—Accounts Payable

In this lesson you will learn about entering vendors and using the accounts 
payable functions of Peachtree Accounting.

You will learn how to:

• Update a vendor record

• Enter a purchase order

• Receive inventory and record the purchase invoice

• Display a journal entry using Accounting Behind the Screens

• Make a payment for the purchase invoice

• Print a disbursement check

• Analyze payments to vendors

• Hide and display G/L accounts in task windows

Estimated Lesson Time: 30 Minutes

Beginning the Lesson

If you are continuing from Lesson III, follow the steps below before 
proceeding with the lesson. 

1 From the Options menu, select Global.

2 In the Hide General Ledger Accounts section of the Accounting tab, select 
Accounts Payable. Make sure the Accounts Receivable and Payroll Entry 
check boxes are clear (not checked).

The rest of the global options are set up properly from the previous lesson, so 
you can now proceed with the lesson.

If you are just starting the lesson, do the following:

1 Start Peachtree Accounting and open up the sample company, Bellwether 
Garden Supply. 

2 If the Action Items window appears, close it for right now. 

3 From the Options menu, select Global. The Maintain Global Options 
window appears.

You need to make sure that the tutorial global options are set up 
properly.

Tu
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Accounts Payable Tasks
4 In the Accounting tab, do the following:

• Select Manual Decimal Entry and enter 2 as the number of decimal 
places.

• In the Hide General Ledger Accounts section, select Accounts 
Payable. Make sure the Accounts Receivable and Payroll Entry check 
boxes are clear (not checked).

• Select the “Warn if inventory item is out of stock” option.

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

5 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could have other global options selected as well. However, the above 
options are the only ones that directly affect this tutorial. 

6 When finished, select OK to close the Maintain Global Options window.

Accounts Payable Tasks

Processing vendor transactions in Peachtree Accounting is, at most, a five-
step process. The number of steps may vary depending on your needs.

You may use all five steps or, in some cases, only one step. For example, if you 
make a cash purchase, you can enter this directly in the Payments window 
(without even creating a vendor).

Tasks Procedure

Maintain Vendors Set up a vendor

Purchase Orders Order items from your vendor

Purchase Invoices Receive inventory or services and/or 
apply purchase order to purchase 
invoice

Payments Apply a disbursement payment against 
the purchase invoice or record a cash 
purchase

Print Checks Print the disbursement check
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Maintain Vendors

First we are going to select the vendor from whom we are going to order items. 
Then we will change one item of information—the discount percentage 
offered for timely payment.

1 From the Maintain menu, select Vendors.

The cursor is in the Vendor ID field. The magnifying glass indicates a 
lookup box, which is a field with a lookup list attached.

2 With the cursor in the Vendor ID field, type a question mark. 

Alternatively, you could select the magnifying glass button to display the 
vendor lookup list.

The vendor we will use for this tutorial is Arbor Wholesale Suppliers.

3 Double-click on ARBOR-01—Arbor Wholesale Suppliers to select it from the 
list.

You could also select ARBOR-01 and press e.
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Maintain Vendors
Entering a Discount

This vendor is offering our company a 5% discount for paying bills within 15 
days of the purchase invoice date. This exceeds our standard vendor terms of 
payment for Bellwether Garden Supply, which is 2% in 10 days. However, we 
have been given this incentive because we are a good customer to them.

1 Select the Purchase Defaults tab.

Notice that most of the information in the window changes, but some 
remains the same—the Vendor ID, Name, and the Inactive check box.

2 Select the Terms arrow button at the bottom of the window. 

An arrow button indicates additional information can be accessed 
related to the subject. 

3 Click the Use Standards Terms check box to clear this option. There should 
be no mark in the box.

When the Use Standard Terms check box is selected, the other term 
options are dimmed. Clearing the check box allows us to make changes 
to this vendor’s terms.

4 Move the cursor to the Discount in # of days field. Type 15 and press e. 
The cursor moves to the Discount % field.

5 Type 5.0 and press e.

6 Select OK to save these entries. Next, select the Save button to update the 
vendor record.

7 Press q to close the Maintain Vendors window.

Clearing the Use
Standard Terms

check box allows
you to enter

unique conditions.
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Entering a Purchase Order 

Purchase orders are used to place an order for items you intend to purchase 
from a vendor. When you post a purchase order, you do not actually update 
accounting information. In an accrual-based company, the accounting 
information is updated only when you receive the items on the purchase 
order through the Purchases/Receive Inventory window.

1 From the Tasks menu, select Purchase Orders.

The cursor is in the Vendor ID field. Do you remember the Vendor ID 
for Arbor Wholesale Suppliers? Don’t worry if you don’t— the program 
does. The Vendor ID field is also a lookup box. 

2 Type A (capital A) and press e.

If you have the Automatic field completion (a Smart Data Entry option) 
set up in Global Options window, the Vendor ID ARBOR-01—Arbor 
Wholesale Suppliers appears. (For more information, refer to Lesson 
II— “Using Smart Data Entry” on page 68.)

If the Smart Data option is turned off, select the magnifying glass icon or 
type ? to access the lookup list for vendors. Select ARBOR-01—Arbor 
Wholesale Suppliers and press e.

The cursor moves to the PO # field. Peachtree Accounting supplies PO 
numbers for purchase orders it prints. You would enter a number here 
only when recording a previously entered purchase order that you don’t 
want to print.
92



Lesson IV—Accounts Payable
Entering a Purchase Order
3 We want to print the PO, so press e to move to the Date field.

Dates

The Date field defaults to the System Date. This date will print on the 
purchase order as the date you want to issue the purchase order. It does not 
represent the purchase invoice date or the date you may have entered the 
purchase order in the computer.

Peachtree Accounting permits flexibility when entering dates. For example, to 
enter January 1, 2003, type 10103 and Peachtree Accounting will format the 
date correctly. You can even enter the day portion of the date and the program 
formats the date based on the current accounting period. For example, if you 
are operating in December 2003, type 4 with the date field selected and press 
e, Peachtree Accounting would format the date as Dec 4, 2003. This can 
save time during data entry.

We’ll pretend it’s March 27, 2003.

4 In the date field type 27 and press e. The cursor moves to the Good 
Thru date field. Accept the 30 day expiration and press e. The cursor 
moves to the Ship To address field.

The shipping information and terms are correct. We are going to skip 
these items.

Entering Transaction Lines

There are two ways to enter transaction lines for purchase orders and invoices:

• By Inventory Item: You can set up inventory items through 
Maintain Inventory Items, making it easy to track items or services 
purchased or sold. Setting up these items also allows Peachtree 
Accounting to complete distribution entries for you, saving you 
time.

• By Account Number: If there is no line item set up for a particular 
item you intend to purchase (or sell), or if you do not intend to use 
the Inventory module, you can type a description and distribute it 
directly to the proper General Ledger account.

We are going to use the first method to purchase some inventory items. 
You might use the second method when purchasing items like office 
supplies or recording a telephone bill.

5 With your mouse, select the Quantity field. 

Our stock levels are low for a couple of items—Cilantro Seeds and Pansy 
Seeds.
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6 In the first line, Type 12 in the Quantity field and press e. The cursor 
moves to the Item field.

7 Select the magnifying glass button to open the lookup list for inventory 
items.

You can set up a list like this for your own products or services in the 
Maintain menu. See “Lesson VII—Inventory” on page 145.

8 As an exercise, select the Sort button from the inventory lookup list. 

Notice this changes the order of the list from being listed by ID to being 
listed by item name. This feature is available for all lookup lists.

9 Double-click SEHB-32120—Cilantro Seeds.

The item description appears in the Description field. Notice that the 
description changes to read, “Catalog #:102030: Cilantro Seeds.” When 
setting up inventory items, you can enter two types of descriptions for 
the same item—one for purchases and one for sales. In this example, we 
need to refer to the vendor’s catalog number when ordering the item. 
However, when we sell the item it is described as “Bell-Gro Basil Cilantro 
Seeds (Long Standing)”.

10 Press e twice to accept the description and unit price and the cursor 
moves to the Amount field.

Peachtree Accounting calculates the quantity multiplied by the unit 
price and enters it in the field.

11 Press e to move to the Job field.

The Job field is also a lookup box. It contains a list of jobs and their 
descriptions. For this part of the tutorial, we are going to skip entering a 
job. To learn more about jobs, refer to “Lesson VIII—Job Costing” on 
page 157.

12 Press e. The cursor moves to a new transaction line.

Next we will order Pansy Seeds.

13 Type 12 and press e. 

14 Find item SEFL-31160 Pansy Seeds (Pastel Mix) from the lookup list and 
press e.

The PO Total at the bottom should now display a total of $12.00.
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Printing Purchase Orders
Saving and Posting

Always save your entries before exiting a task window (in this case the 
Purchase Order window). The Post button is displayed because the sample 
company uses real-time posting. When you select the Post button, Peachtree 
Accounting saves and posts the purchase order. (You could also select the 
Print button here to both print the purchase order and post it to the Purchase 
Order Journal.)

When purchase orders and sales orders are posted, the account information 
is not recorded to the General Ledger—just recorded to the Purchase Order 
Journal or Sales Order Journal, respectively. Once you receive or ship 
inventory, the orders are changed to invoices. When you enter a purchase 
invoice or sales invoice, Peachtree posts the account information to the 
General Ledger (in an accrual-based company).

15 Select the Post button.

16 Select the Close button or press q to close the window.

Printing Purchase Orders

Now let’s print the Arbor Wholesale Suppliers purchase order we just entered.

There are three ways to print purchase orders.

• From the Purchase Orders task window, select the Print button: 
This prints the current purchase order displayed. If the reference 
number field (PO number) is left blank, Peachtree Accounting 
assigns a reference number and prints the form. If the PO number 
field already has a reference number, Peachtree Accounting prints the 
form with the word “Duplicate” on it.

• From the Reports menu, select Accounts Payable. Select a form 
from the Purchase Orders folder, and then click the Print button: 
This prints a batch of open purchase orders (those without PO 
numbers assigned) at one time based on a date you enter.

• From the Navigation Aid, select the Purchases folder, and then the 
Print Purchase Orders icon: This prints a batch of open purchase 
orders (those without PO numbers assigned) at one time.

This basic procedure is the same whether you’re printing a batch of Purchase 
Orders, Quotes, Sales Invoices, or Packing Slips. From the Reports menu, 
select the module (for example, Accounts Receivable). Then double-click the 
form folder, select the form you want to print, and filter the last date for which 
to print the form. All transactions without reference numbers (for example, 
invoice or order numbers assigned) will print.

Note
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1 From the Reports menu, select Accounts Payable.

2 Scroll down the report list and open the Purchase Orders forms folder by 
double-clicking it.

3 Scroll down and single-click the PO Plain form to print a plain paper 
purchase order.

If you purchased preprinted forms, you might select the PO PrePrinted 
form.

4 Select the Print button. The PO Plain filter window appears.

5 For tutorial purposes, assign the first PO number as 8111. In the Last Date 
for which PO will print field, type 3/27/03 and press e.

6 Select OK to accept the filter options.

7 The Print window displays. Confirm the print setup and select OK to print 
purchase orders.

After the purchase order is printed, a message box displays asking if it 
printed properly. In real life, this is a very important question. When you 
answer Yes, Peachtree Accounting updates PO numbers and flags the PO 
as printed, so that it will not print again.

8 Select Yes.

9 Press q to close the Select a Report window.

Purchases/Receive Inventory

In the Purchases/Receive Inventory task, you apply purchase orders to 
purchases or enter direct purchases (invoices you receive from your vendor 
without a PO).

We have just received a shipment from Arbor Wholesale Suppliers for the 
purchase order we previously entered.
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Purchases/Receive Inventory
1 From the Tasks menu, select Purchases/Receive Inventory. 

Notice the similarities with the Purchase Order window. The only major 
difference is the presence of the Apply to Purchase Order tab and Apply 
to Purchases tab. 

• Apply to Purchase Order: When you select a vendor who has open 
purchase orders, this tab appears, allowing you to select which 
purchase order to receive items against.

• Apply to Purchases: If you select a vendor with no open purchase 
orders, this tab appears. You can enter a vendor invoice that did not 
originate on a purchase order. In addition, even if you have selected a 
purchase order and received items against it on the Apply to 
Purchase Order tab, you can also select the Apply to Purchases tab to 
enter purchases not included in any open purchase orders.

2 With the cursor in the Vendor ID field, type ARBOR-01 and press e. 
The cursor moves to the Invoice # field.

Included in the Arbor Wholesale Suppliers shipment is Invoice 15777, 
dated 3/29/03, responding to our Purchase Order # 8111. They shipped 
us 12 packs of Cilantro Seeds and 12 packs of Pansy Seeds.
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3 Type 15777 and press e. In the date field, type 29 and press e. 

The date should format as Mar 29, 2003. The cursor moves to the 
Waiting on Bill from Vendor field. Since our shipment included the 
invoice, we can skip this field.

4 Press e five times. The cursor should now be on the Apply to Purchase 
Order tab.

You should see a drop-down list displaying <No PO Selected>. This 
displays all the current open POs for the particular vendor.

5 Select the down arrow, and then choose 8111 from the drop-down list.

You cannot apply more than one open purchase order to an invoice.

6 Press e twice. The cursor should be on the first transaction line in the 
Received field. We ordered 12 packs of Cilantro Seeds and only received 6. 
The remaining 6 packs have not been received yet.

7 Enter 6 and press e. The cursor moves to the Description field.

8 The description has not changed, so press e to move to the Unit Price 
field.

9 The vendor has reduced the price to $.40 a pack, so enter .40 and press 
e. The Amount field should calculate and display 2.40.

10 Press e to accept the amount. The cursor moves to the Job field.

11 Let’s skip the Job field for now. Press e to move to the second 
transaction line which displays the Pansy Seeds.

12 Enter 12 and press e. 

The unit price did not change and remains $.55. That’s all we need to 
complete this invoice. The invoice total should display as $9.00.
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Purchases/Receive Inventory
Discount Information

We began this lesson by changing the payment terms for Arbor 
Wholesale Suppliers. Let’s check the discount information for the 
purchase invoice we just entered.

13 Select the arrow button to the right of the Terms. This information is just 
below the Ship To address.

The Date Due is the date by which the invoice should be paid. The 
Discount Amount is the invoice total multiplied by the discount 
percentage you entered in the Maintain Vendor record. The discount 
date is the date by which we must pay to receive the purchase discount. 
The Displayed Terms are the percentage of discount, the time in days for 
receiving the discount, and the number of days before the invoice is due. 

14 Select OK to exit this window.

Accounting Behind the Screens

Let’s examine the journal entry that will be made to the Purchases Journal 
before posting it. 

15 Select the Journal button from the toolbar. 

You can edit the
account number

for each line item
you entered. The

other fields cannot
be edited in this

window.
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The Accounting Behind the Screens window displays journal entries that 
will be posted if this transaction is saved; it provides a preview of what 
will happen when the transaction is recorded.

The default account that is selected for each line item is 12000—
Inventory. This default comes from the inventory item list and or default 
information set up in Maintain Inventory Items. The accounts payable 
account also appears. You have the opportunity to change these account 
IDs, if necessary, but usually you would accept the default.

The Accounting Behind the Screens window displays debit and credit 
information for each line item. Since Peachtree is a double-entry 
accounting system, all the accounting distributions are automatically 
done for you, behind the scenes. Whenever you need to see this 
accounting information, select the Journal button.

16 Since we do not need to make any changes, select the OK button to return 
to the Purchases/Receive Inventory window.

Posting Purchase Transactions

Most entries made in the Purchases/Receive Inventory window are debits. 
The offsetting credit is made to the Accounts Payable account (in accrual 
accounting). The credit to Accounts Payable is made to the A/P account that 
appears on this Purchases/Receive Inventory window.

17 Select Post to record the Purchase invoice.

The purchase is recorded and the proper accounts are distributed to the 
General Ledger. Inventory is also updated.

You return to the Purchases/Receive Inventory window.

Note: You cannot print purchase invoices, only purchase orders.

18 Close the Purchases/Receive Inventory window by pressing q.
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Payments
Payments 

Typically, you would enter purchase invoices throughout the month so that 
you would have a record of what you owed. Then, at some later date, you pay 
the invoices. We are going to enter a payment for this purchase invoice.

1 From the Tasks menu, select Payments.

You have the option of writing a disbursement check to a vendor or a 
customer. Usually payments are made to vendors. However, you might 
write a check to a customer when issuing a refund. 

2 Select Vendor ID as the payment type, type ARBOR-01 (the vendor ID for 
Arbor Wholesale Suppliers) in the Vendor ID field, and press e. The 
cursor moves to the Pay to the Order of field.

Notice the Apply to Invoices tab now displays the purchase invoice 
15777 we just entered. Other outstanding invoices for this vendor are 
also listed here.

With the cursor in the Pay to the Order of field, you could change the 
vendor address by selecting the arrow button.

If you wanted to enter a cash purchase (for example, food for an office 
lunch) without creating a vendor ID or purchase invoice, you could skip 
the Vendor ID field and enter the name of the one-time payee in the Pay 
to the Order of field.
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3 Press e to accept the vendor name and address. The cursor moves to 
the Check Number field.

We are leaving the check number blank. When we print the check, 
Peachtree Accounting will then assign the next check number in 
sequence. If you enter a check number, Peachtree Accounting assumes 
you are entering a manual check or a previously-printed check, and will 
print the word “DUPLICATE” on the check if you choose to print it.

4 Press e to leave the Check Number field blank. In the Date field, type 
29 and press e. The date formats to Mar 29, 2003. The cursor moves to 
the Memo field. 

Peachtree Accounting automatically fills this field with the vendor 
account number (set up in the Maintain Vendors window). You could 
enter other information in this field.

5 Press e to accept the Memo field. The cursor moves to the Cash 
Account field. 

The Cash Account field should display Regular Checking. Below is the 
current balance (as of the check date 3/29/03). If question marks display, 
select the Recalculate (Recalc) button to temporarily display the cash 
balance. This displayed balance will not change until you press the 
Recalculate button again.

Peachtree Accounting offers you the option of automatically displaying the 
current Cash Account balance on the Payments, Receipts, and Payroll Entry 
windows. From the Options menu, select Global and turn on the Automatic 
Recalculate cash balance automatically in Receipts and Payments option. 
Each time you enter Receipts, Payments, or Payroll Entry windows and enter 
a transaction, the displayed cash account balance is updated.

At this point, you can select invoices to pay. Optionally, you can make a 
payment against an expense account. When you select the Apply to 
Expenses tab, the outstanding invoices for this vendor will temporarily 
disappear, and the columns in the distribution area will be different 
(similar to the purchase invoice). We are going to apply this 
disbursement against the invoice we just entered.

6 Click the Description column beside invoice 15777. You could enter a brief 
description to appear on the check stub if necessary. For the tutorial, we 
won’t enter a description. So all you have to do now is select the Pay check 
box in the far right column.

Note
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Payments
Notice the amount box on the check form now displays $8.55. This is 
$9.00 minus the 5% discount we established earlier for Arbor Wholesale 
Suppliers. 

The amount box keeps a running total of the vendor invoice(s) you pay. 
You can only adjust the amount it shows indirectly, by entering 
payments in the Amount Paid field. 

In addition to Purchase Invoice 15777, you may see other outstanding 
invoices due for this vendor. You can elect to pay them as well or make a 
partial payment on a single invoice. You may also note that these 
invoices may or may not qualify for purchase discounts based on the 
check date entered.

7 Select the Journal button to display the Accounting Behind the Screens 
window.

The Accounting Behind the Screens window appears. This window 
shows all transaction distributions.

8 Select OK to return to the Payments window.

9 Select the Post button to record and post this payment.

You could also select the Print button here to both print the check and 
post the disbursement. However, we will print the check in the next 
section.

10 Press q to close the Payments window.

Disbursement Transactions

When you post this payment (in an accrual-based company), the Accounts 
Payable account is debited for the full invoice amount, which balances the 
credit when we entered the invoice. The cash account is decreased by the 
amount of the check, and the Discounts Taken account is decreased by any 
discount that might apply. (You establish the account for discounts taken 
from the Maintain menu by selecting Default Information, and then 
Vendors.)
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Printing Checks

You can print a batch of checks, or print checks individually, as you enter 
them (using the Print button on the Payments window). Because Peachtree 
Accounting prints a form for checks, you cannot choose to display the check. 
You can, however, print a check register prior to printing a batch of checks to 
ensure accuracy.

1 From the Reports menu, select Accounts Payable.

2 Scroll down the report list and open the Disbursement Checks forms folder 
by double-clicking it.

3 Scroll down and single-click any of the forms. 

If you purchased preprinted forms, you might select the AP Preprint 1 
Stub form.

4 Select the Print button. The print forms (AP Preprint 1 Stub) window 
appears. 

From here you can filter the checks that print. We’ll set the Filter options 
to print only checks for Arbor Wholesale Suppliers.

The first check number may display 10211 (or possibly a different 
number depending on whether you started this tutorial with a “fresh” 
copy of Bellwether Garden Supply). This is the next check number in 
sequence, tracked and assigned by Peachtree Accounting. Normally, you 
would check your blank preprinted form to verify the next available 
check number and enter it here if it is different. For right now, accept the 
default since we are only printing a practice check on plain paper.

5 The Cash Account displays 10200— Regular Checking. In the Last date for 
which checks will print field, type 3/29/03 and press e.

6 In the Filter Range list, click in the From column, beside Vendor ID.

7 Type ARBOR-01, the code for Arbor Wholesale Suppliers. Press e. In 
the To column type the same code.

Now only outstanding checks for Arbor Wholesale Suppliers dated 
3/29/03 or earlier will print. 

8 Select OK to accept the filter options.
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Printing Checks
9 The Print window appears. Confirm the print setup and select OK to print 
checks.

After the disbursement check is printed, a message box displays asking if 
it printed properly. In real life, this is a very important question. When 
you answer Yes, Peachtree Accounting updates the check number and 
flags the check as printed, so it will not print again.

10 Select Yes.

11 Press q to close the Select a Report window.

Reprinting a Check

After printing checks, they are assigned check numbers. If you wanted to 
reprint a check, it would print with the word “duplicate” on it. However, in 
the instance that you need to reprint an original check, you could follow these 
steps:

1 From the Tasks menu, select Payments.

Peachtree displays the Payments window.

2 Select the Edit button from the toolbar.

The Select Payment window appears.

3 Select the payment we just entered for Arbor Wholesale Suppliers and then 
select OK.

The payment appears.

4 Delete the check number.

5 Select the Print button. 

This will use the next check number in the sequence and print the check. 

If you wanted to enter and print checks for several vendors at one time, you 
can save data entry time by using the Select for Payment option from the 
Tasks menu.Note
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Display the Vendor Ledger

Let’s display this vendor’s ledger to review the journal entries that we just 
made.

1 From the Reports menu, select Accounts Payable.

2 Select Vendor Ledgers, and then select the Screen button.

This vendor uses a type code of SUPPLY. We will use this as a mask, 
limiting the report to only vendors with this type code.

3 Beside the Vendor Type in the Filter list, select Range in the Type column.

4 Type SUPPLY in the From and To columns.

Similar to ID codes, type codes are case sensitive. Be sure to type 
SUPPLY in capital letters.

5 Select OK to display the report.

The Vendor Ledgers report for all SUPPLY type vendors displays.

The accounts payable subsidiary account for Arbor Wholesale Suppliers 
was credited for $9.00 (the amount of their invoice #15777). When we 
posted the payment, the program debited this vendor’s account for our 
check #10211, clearing the transaction to zero.

6 Select the Close button, to close the report window. Press q to close the 
Select a Report window.
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Display or Hide General ledger Accounts
Display or Hide General ledger Accounts

To simplify data entry, you have the option to hide General Ledger accounts 
on various task windows. When the General Ledger accounts fields are not 
visible, it is assumed that the default accounts you have set up will be used 
when recording the transaction. However, you can still change G/L accounts, 
if needed, by selecting the Journal button, which displays the Accounting 
Behind the Screens window.

In this tutorial the Accounts Payable task windows were set up to hide General 
Ledger accounts from view. We will now turn off this global option and 
examine the difference.

1 From the Options menu, select Global.

The Maintain Global Options window appears.

2 In the Hide General Ledger Accounts section, clear the Accounts Payable 
check box. Make sure the Accounts Receivable and Payroll Entry check 
boxes are also clear (not checked).

3 When finished, select OK to close the Maintain Global Options window.

4 From the Tasks menu, select Purchases/Receive Inventory. The Purchases 
Receive Inventory window displays with General Ledger account fields 
visible. 

5 To display the purchase invoice entered previously, select the Edit button. 
Select invoice 15777, and then click OK.

The General Ledger accounts for each line item appear as well as the 
Accounts Payable account field. 
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For the remainder of these tutorials, the Hide General Ledger Accounts 
global option will not be activated so that you are exposed to all the 
Peachtree Accounting window elements.

Review of Lesson IV

Let’s review some of the things we learned in this lesson.

• We covered the basic accounts payable tasks—ordering items using 
purchase orders, printing purchase order forms, receiving inventory 
and applying purchase orders to purchase invoices, applying a 
payment against the purchase invoice, and printing the 
disbursement check.

• We learned how some of the various features of Peachtree 
Accounting work together. The discount information entered in 
Maintain Vendors was automatically included in the new purchase 
invoice entered and was subtracted when entering a timely payment.

• If you want to record an invoice now and pay for it later, use the 
Purchases/Receive Inventory window. If you want to print a purchase 
order, leave the PO # field blank on the Purchase Orders window. If 
it’s a direct cash purchase, enter a payment using the Apply to 
Expenses tab.
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• There are two ways to enter transaction lines in purchases (and 
sales): 

• By Inventory item: With line items set up through Maintain 
Inventory Items, you can keep track of items or services 
purchased or sold. Setting up these items also allows Peachtree 
Accounting to complete distribution entries for you to save you 
time.

• By Account Number: If there is no line item set up for a 
particular item you intend to purchase (or sell), or if you do not 
intend to use the Inventory module, you can type a description 
and distribute it directly to the proper General Ledger account.

• To examine a transaction’s journal entry, select the Journal button on 
the Task window. This action displays the Accounting Behind the 
Screens window where you can change account information and 
examine debit and credit entries corresponding to the transaction.

• In accrual-based companies, a typical invoice credits the accounts 
payable subsidiary account and debits inventory or expenses.

• When printing a check, leave the check number blank to have 
Peachtree Accounting later assign a check number and print the 
check.

• Once you print a batch of checks and answer Yes to the prompt that 
asks you if the checks printed properly, Peachtree updates the check 
numbers and flags the checks as printed. To reprint a check, you 
must complete the following steps:

• From the Payments window, select the Edit button.

• Select the Payment check you want to reprint.

• Delete the check number.

• Select the Print button. This action prints the check using the 
next check number in the sequence.

• You have the option to hide General Ledger Account fields on 
various task windows. Hiding these fields can make data entry easier, 
if desired. When the General Ledger accounts fields are not visible, it 
is assumed that the default accounts you have set up will be used 
when recording the transaction.

Now that you have been introduced to the Accounts Payable module of 
Peachtree Accounting, you are ready to proceed to Lesson V—Accounts 
Receivable. 
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Lesson V—Accounts Receivable

In this lesson you will learn about entering customers and using the accounts 
receivable functions of Peachtree Accounting.

You will learn how to:

• Enter a new customer on-the-fly

• Enter a quote

• Enter a sales order

• Ship inventory and enter the sales invoice

• Record a receipt for the sales invoice

• Analyze collections of payments from customers

Estimated Lesson Time: 30 Minutes

Beginning the Lesson

If you are continuing from Lesson IV, skip this section and proceed with the 
lesson.

If you are just starting the lesson, do the following:

1 Start Peachtree Accounting and open up the sample company, Bellwether 
Garden Supply. 

2 If the Action Items window displays, close it for right now. 

3 From the Options menu, select Global. The Maintain Global Options 
window appears.

You need to make sure that the tutorial global options are set up 
properly.

4 In the Accounting tab, do the following:

• Select Manual Decimal Entry and 2 as the number of decimal places.

• Clear the Hide General Ledger Accounts option for all modules 
(Accounts Receivable, Accounts Payable, and Payroll).

• Select the “Warn if inventory item is out of stock” option.

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

Tu
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5 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could possibly have other global options selected as well. However, 
the above options are the only ones that directly affect this tutorial. 

6 When finished, select OK to close the Maintain Global Options window.

Accounts Receivable Tasks

Processing customer transactions in Peachtree Accounting is, at most, a five-
step process. The number of steps may vary depending on your needs.

You may use all five steps or, in some cases, only one step. For example, if you 
make a cash sale, you can enter this directly in the Receipts window (without 
even creating a customer).

This time we are going to skip the Maintain Customers/Prospects window 
and enter a customer directly from the Quotes window.

Task Procedure

Maintain Customers/Prospects Set up a customer

Quotes Print a proposal for sales of products or 
services

Sales Orders Order items for your customer

Sales/Invoicing Enter an invoice for products or 
services delivered

Receipts Apply a receipt payment against a sales 
invoice or record a cash sale
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Quotes, Sales Orders, and Sales Invoices

Quotes are proposals you give a customer detailing prices and terms for a 
possible sale. This is an optional accounts receivable task. Many times you 
have already established the sale. If so, you can skip this procedure and begin 
entering a sales order or invoice. Quotes can be converted into sales orders or 
invoices to save time.

Sales orders are used when your customer agrees to a sale, but you are not 
prepared to ship or invoice all or part of the order. The service or inventory 
items are ordered for the customer—either packaged by your shipping 
department or issued to your staff to schedule services. Once you issue a sales 
order, prospects are converted to customers. 

After you actually ship items or render services, a sales order can be applied to 
a sales invoice. Once the sales invoice is entered, accounting information is 
entered in the General Ledger (in accrual-based companies). Quotes and sales 
orders are not posted to the General Ledger.

Entering a Quote

In this lesson we will enter a quote for a new prospect.

1 From the Tasks menu, select Quotes/Sales Orders, and then Quotes.

Notice the similarities between the Quotes window and the Purchase 
Orders window. Transaction lines are entered in the middle of the 
window for this quote. The inventory item description displays on the 
lines beneath each transaction line.
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Invoice Modes

Before we begin entering the quote, let’s take a moment to discuss the 
methods you can use to enter sales. There are two types of sales forms 
(Quotes and Sales Invoices) you can use based on the type of data entry 
required.

With the Quotes window displayed, take a minute and observe the field 
layout. Notice the shipping information fields, the Item column, and the 
Template button on the toolbar. You can click the Template button to see 
which invoice format you’re currently set up to use.

For more information about the types of templates available, refer to the 
Basics chapter of your User’s Guide.

2 Click the Template button and choose the Service template from the pull-
down menu. 

The invoice format changes to a Service template. This is identical to the 
Product template except that the fields for Ship Via, Quantity, Item, and 
Unit Price are removed.

Since our sample company uses inventory, we need to use a Product 
template.

3 Select the Template button again, but this time select the Product template 
from the pull-down menu.

Place the cursor in the Customer ID field.

Suppose you get to this point and realize that the prospect whose quote 
you are about to enter hasn’t been entered in Peachtree Accounting. You 
don’t have to exit the window and open the Maintain Customers/
Prospects window. You can enter a new customer on-the-fly.

4 With the cursor in the Customer ID field, press +. The Maintain Customers/
Prospects window displays.
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You could also double-click inside the Customer ID field to display the 
Maintain Customers/Prospects window.

Let’s take a moment to look at the Maintain Customers/Prospects 
window. If you’ve just worked through Lesson IV—Accounts Payable, 
notice the similarities with the Maintain Vendors window. The 
information is subdivided into four tabs—General, Sales Defaults, 
Custom Fields, and History.

Coding Systems 

When labeling ID codes for vendors, customers, inventory items, and so 
on, it is important to use a system that is consistent so that other users in 
your office can step in and easily enter a new record or search for an 
existing record. 

There are several methods you can consider. Our sample company, 
Bellwether Garden Supply, uses the first part of a vendor’s/customer’s 
last name or company name (in all caps) followed by a number. For 
example, Coleman Realty has a customer ID of COLEMAN-01. The 
advantage to this system is the ease of memorizing and using codes 
during data entry. It also takes advantage of Peachtree Accounting’s 
Smart Data Entry option set up in the Maintain Global Options window.

Another example of coding could be a four-character, alphanumeric 
code, with the first letter of the company’s name, followed by a 
sequential three-digit number. Thus Acme Janitorial Supply and Acme 
Andirons would be coded AØØ1 and AØØ2, respectively.

Remember: ID codes are case sensitive. AØØ1 and aØØ1 are not the 
same.

The customer we are going to enter is Armstrong Manor.
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5 With the cursor in the Customer ID field, type ARMSTRONG-01 and press 
e. The cursor moves to the Name field.

6 Type Armstrong Manor and press e.

Since this is a new customer and we are only entering a quote at this 
time, the customer is considered a prospect. Once an actual sale is 
recorded, the prospect can be converted to a real customer. Separating 
customers from prospects makes sorting and filtering reports easier to 
manage. Also, if the prospect ends up never using our services, it can be 
deleted or purged easily. 

7 Select the Prospect check box in the header information section (there 
should be a check mark in the box). 

8 Our principal contact at Armstrong Manor is Rodney Potter. Type the 
name and press e. The cursor moves to the Bill to Address drop-down 
list.

Customers can have several addresses. One is a billing address and the 
others are shipping locations. You can have up to nine different shipping 
addresses.

9 Press e and type the following billing address:

2200 Jimmy Carter Blvd
Building A
Norcross, GA 30092

If the customer has a different shipping address, you could return to the 
Bill to Address drop-down list and select Ship to Address 1. However, we 
are going to use just one address for now. 

10 After entering the address, move your cursor to the Sales Tax field. Select 
the magnifying glass button. The Sales Tax lookup list displays. 

In our sample company we have entered five sales tax codes to use based 
on the location of the customer sale.

The billing and shipping addresses can be assigned separate sales tax 
codes. You can have customer branch offices in several areas, each with 
their own sales tax requirement. To select a tax location, choose the 
billing or shipping address, and then select its respective sales tax code. 

11 Double-click GAGWINN—Gwinnett County Sales Tax for the Bill to Address. 
The cursor moves to the Customer Type field.

In the Customer Type field you could enter a classification for your 
customers. You can set up unique customer types for your own 
company. In our sample company, properties use the LAND customer 
type.
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12 Select the Customer Type field with your mouse pointer. Type LAND and 
press e.

13 Select the Sales Defaults tab. Notice that the heading information—
Customer ID and Name—stays the same.

Customer defaults are set up during New Company Setup, including the 
default G/L Sales account. This default is assigned to all new customers 
unless otherwise specified. The current G/L Sales account 40000 (Sales) 
is the correct income account for this customer. 

14 Select the Save button to add this customer, and then select Close to return 
to the Quotes window.

You just entered a customer record! You can use this procedure to enter 
vendors quickly from the Purchases window, employees quickly from 
the Payroll Entry window, and many other combinations that use an ID 
lookup box.

Exiting from the Maintain Customers window takes us back to the same 
field (Customer ID) where we pressed +. 

Proceed with Entering the Quote

Now we can proceed with entering the quote.

1 In the Customer ID field, type A (the first letter of our new customer code) 
and press e. Our new prospect, Armstrong Manor, is displayed. The 
cursor moves to the Quote # field. 

2 Leave this field blank. When we print this quote, Peachtree Accounting will 
assign the next quote number in sequence.

3 Press e to move to the Date field. Type 20 and press e. The date 
formats to Mar 20, 2003. Accept the Good thru date (a 30-day expiration) 
by pressing e. The Cursor moves to the Ship To arrow button. Skip this 
field for now. 

Armstrong Manor is interested in buying a bird bath. They also want us 
to install the bird bath on their property and do some landscape work.

4 Place your mouse pointer in the Quantity field on the first transaction line. 
Type 1 and press e. The cursor moves to the Item field.
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5 Press ? to open the Item ID list. Scroll down and select AVRY-10150 (Bird 
Bath - Stone Gothic 2pc.). Notice the item list shows that we currently have 
6 of these in stock (as of the quote date). Double-click the item to select it.

6 The sales item description is completed for you. Press e twice. The 
cursor moves to the Unit Price field.

7 The Unit Price field displays a drop-down list of the five established sales 
price levels for this item. Press the W or Z arrow keys to move through the 
list. 

Sales price levels for items are entered in the Maintain Inventory Items 
window. When setting up your customers you can select one of the five 
sales price levels to use as the default price. For our customer, Armstrong 
Manor, we used the default sales price level 1. When invoicing this 
customer, all items default to the level 1 price.

8 Press e to accept the unit price for Sales Price Level 1 ($129.99). The 
cursor moves to the Tax field.

9 Press ? to display the Item Tax type list.

Inventory item tax types are set up in the Maintain Inventory Item 
Defaults window. When you enter your inventory items on the Maintain 
Inventory Items window, you can designate items as taxable or exempt. 
The bird bath uses item tax type 1, which is set up as taxable.

10 Press e once to move to the Amount field.

The Amount should display $129.99. In the bottom right corner, you 
can see the tax amount for the item in the Sales Tax field.

11 Press e to accept the amount and then enter again to skip the Job field. 

Jobs will be covered in more detail in Lesson VIII.

Next, we will enter our Landscaping Design. We estimate this will take 
four hours.

12 In the second transaction line type 4 and press e. Type LA. The item list 
displays LAND-17100 (Landscaping Service - Weekly); however, we need to 
select landscaping design. Press Z three times to select LAND-17400 
(Landscaping Design), and then press e four times. The cursor moves to 
the Tax field. 

13 Since this is a service item it is non-taxable. It has been set up to use Tax 
Type 2 (exempt). Press e to move to the Amount field.

Four hours of Landscaping Design at $49.99/hr equals $199.96.
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14 Press e to accept the amount calculated.

That is all the information we need at the moment to complete the 
quote. In real situations, you may charge freight when shipping items. 
However, our company will hand-deliver the bird bath since we are 
going to install it.

The Quote Total should display $337.75.

Now let’s print the Quote.

15 Select the Print Button. 

The Print Forms: Customer Quotes window appears. 

16 Select Quote Plain Product, and then OK.

A second Print Forms window displays. You could select Practice if you 
need to align your form in the printer or select Form Design to modify 
the form. However, we are printing a plain paper quote so these options 
are not necessary.

17 Select Real. The About to Print Quote window appears. 

18 Accept the Quote number assignment and select OK.

After the quote is printed, you return to the Quotes window.

19 Press q to close the Quote window.

Converting the Quote to a Sales Order

Our customer has agreed to the sale. Instead of re-entering the sales 
information in the Sales Order window, we can save time and convert the 
quote directly to a sales order or sales invoice. We are not prepared at this time 
to complete the service or ship the item, so we will convert the quote to a sales 
order.

1 From the Tasks menu, select Quotes/Sales Orders then Quotes. Peachtree 
displays the Quotes window.

2 Select the Edit button. The Select Quote window displays. To select the 
quote for Armstrong Manor, double-click the quote. The quote appears.

3 Select the Convert button to change this quote to a sales order.
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4 Peachtree displays a warning message telling us the quote is for a prospect. 
Select OK to convert the prospect to a customer. The Convert Quote 
window appears.

There are three options at this point. You can convert the quote to a sales 
invoice to be printed later, convert it to a sales invoice and print it now, 
or convert it to a sales order. In real transactions this varies based on 
your company needs and the current situation. For this tutorial we will 
go the longer route to observe the complete accounts receivable process.

5 Select the convert to Sales Order option. For tutorial purposes, change the 
assigned sales order number to 9ØØ1, and then select OK.

The quote is now converted to sales order # 9001. We will no longer be 
able to view the transaction in the Quotes window.

6 Press q to close the Quotes window.

Editing the Sales Order

Let’s examine the sales order. 

1 From the Tasks menu, select Quotes/Sales Orders, and then Sales Orders.

Notice the similarities between the Sales Orders window and the Quotes 
window.
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2 Select the Edit button. Peachtree displays the Select Sales Order window. 
Double-click sales order 9001, for Armstrong Manor. The sales order 
appears.

All the quote information displays in the sales order. 

One of our sales representatives has convinced the customer to buy eight 
bird house kits to place around the property. This needs to be added to 
the sales order.

3 Select the Add button. A new (third) transaction line displays.

4 Type 8 in the Quantity field and press e. Select AVRY-10100 (Bird House 
Kit) from the Item lookup list and press e until you reach the Unit Price 
field. Accept the unit price of $129.99.

The Amount for the eight bird house kits should display as $1039.92.

The SO Total should now display $1440.06.

We need to give the sales representative credit for the sale. 

5 Place your mouse pointer in the Sales Rep ID box. Press ? and double-click 
the first sales rep, DBECKSTROM-01.

6 Select the Post button to record the sales order, and then press q to close 
the Sales Orders window.

You can also print sales orders. One copy of the sales order can be sent to the 
customer as a packing slip. A second copy of the sales order can be marked up 
by warehouse personnel as verifying what was shipped to the customer and 
what needs to be put on order. The marked-up copy could be given to your 
accounting clerk prior to invoicing the customer for items shipped.
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Entering the Sales Invoice

We are ready to deliver and install the bird bath at Armstrong Manor.

1 From the Tasks menu, select Sales/Invoicing.

The Sales/Invoicing window is similar in many ways to the Purchases 
window. Freight and Sales Tax fields have been added along with the 
presence of the Apply to Sales Order tab and Apply to Sales tab.

• Apply to Sales Order: When you select a customer who has open 
sales orders, the Apply to Sales Order tab displays, allowing you to 
select which order to receive items against.

• Apply to Sales: If you select a customer with no open sales orders, 
this tab displays. You can enter a direct sale that did not originate on 
a sales order or quote. In addition, even if you have selected a sales 
order and shipped items against it on the Apply to Sales Order tab, 
you can also select the Apply to Sales tab to enter additional sales not 
included in a sales order. 

If you followed along in Lesson IV—Accounts Payable, the procedure 
here is very similar.

2 With the cursor in the Customer ID field, type A and press e. The 
customer Armstrong Manor displays.

3 Leave the Invoice # field blank; we want Peachtree Accounting to assign 
the invoice number when we the print invoice. Press e.
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4 With the Date field selected, type 25 and press e. The date formats to 
Mar 25, 2003.

5 In the Apply to Sales Order tab, select 9001 from the drop-down list.

6 We plan to deliver all items ordered. Select the All button from the toolbar.

If you started this tutorial with a clean copy of our sample company, 
Bellwether Garden Supply, you should receive the following warning 
message:

7 Press e to close the warning message. Look at the line items. The only 
items that show no shipment are the Bird House Kits.

8 With the Sales/Invoicing window still open, select Inventory Items from the 
Maintain menu.

9 In the Item ID field type AV and press e. The record for Bird House Kit 
displays.

10 Notice the Quantity on Hand field. This window shows that we currently 
have only three in stock. The Sales Order calls for eight kits. We need to 
order some more from the vendor. For now let’s return to the sales invoice.

11 Press q to return to the Sales/Invoicing window.

12 Knowing that you are low in stock, type 8 in the Shipped column for the 
Bird House Kits, and then press e.

A second warning message displays identifying that we are currently 
attempting to ship/sell the item over the current stock level.
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We just demonstrated two methods of signaling that you are selling 
beyond the current stock level. Both messages are an optional setting in 
the Maintain Global Options window.

• Global Out of Stock Warning Message: This message warns that you 
are selling one or more items that are out of stock when you select 
the All button. The item is not identified. The quantities (for items 
out of stock) in the Shipped column are set back to zero.

• Individual Item Out of Stock Warning Message: This message 
warns that you are selling a particular item and displays the item and 
its current stock level. This is a system-generated message. If you 
proceed, the item will be sold beyond the current stock level.

These two warning messages will not display if you do not have the “Warn if 
inventory item is out of stock” option activated in the Maintain Global 
Options window.

13 Select OK on the item warning message.

Note: Depending on how you want to invoice a customer, you have the option of 
invoicing the customer for all items on order (no matter how many items are 
in stock) or invoicing the customer as the items are shipped.

The quantity shipped still reflects eight bird house kits shipped. You 
should change this to reflect three items because that is what you have on 
hand. You will invoice the customer later for the remaining kits when 
they are in stock.

14 Press s+e to move back to the Shipped field. Type 3 and press 
e.

The Invoice Total should display $751.12.

15 Select the Post button to save the invoice and record account information 
to the General Ledger.

Remember that quotes and sales orders are saved to their respective 
journals and that no account information is recorded to the General 
Ledger. When you post a sales invoice, account information is then 
recorded to the general ledger.

Note
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Sales Transactions

In an accrual-based company, most entries made in the Sales/Invoicing 
window are credits posted to the General Ledger. The offsetting debit is 
made to the Accounts Receivable account displayed on this Sales/
Invoicing window.

There are also other accounts which might be affected including cost of 
goods and inventory.

• Debit: Accounts Receivable, Cost of Goods Sold

• Credit: Income, Sales Tax Payable, and Inventory

Printing Invoices

There are three ways to print invoices.

• From the Task window, select the Print button: This prints the 
current invoice displayed. If the reference number field (Invoice #) is 
left blank, Peachtree Accounting assigns a reference number and 
prints the form. If the invoice number field already has a reference 
number, Peachtree Accounting prints the form displaying the word 
“Duplicate” next to the invoice number.

• From the Select a Report window, select the invoice form: This 
prints a batch of invoices at one time. You have the option of printing 
“printed invoices” (those with reference numbers already assigned) 
and “non-printed invoices” (those which need to be assigned 
reference numbers and then printed).

• From the Sales Navigation Aid, select Print Invoices: This prints a 
batch of invoices at one time. Only “unprinted invoices” (those 
which need to be assigned invoice numbers and printed) will be 
printed using this method.

This basic procedure is the same whether you are printing a batch of 
purchase orders, quotes, or sales invoices. From the Reports menu, select 
the module area, open the form folder, select the form, and enter the last 
date for which to print the form.

Invoices only print when the date of the invoice is less than or equal to the date 
set for the Last date for which invoices will print, on the Filter window.

1 From the Reports menu, select Accounts Receivable.

2 Scroll down the report list and open the Invoices/Credit Memos/Packing 
Slips forms folder by double-clicking it.

Note
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3 Scroll down and single-click on the Invoice Plain w/ Freight w/BO form.

This will print a plain paper invoice that includes freight and backorder 
information.

4 Select the Print button. The Filter tab of the Invoice Plain w/Freight w/BO 
window appears.

5 Make sure the Unprinted Invoices option is selected. For tutorial purposes, 
assign the first invoice number as 9901. In the Last date for which invoices 
will print field, type 3/25/03 and press e.

6 Select OK to accept the filter options.

7 The Print window displays. Confirm the print setup and select OK to print 
sales invoices.

After the invoice is printed, a message box displays asking if it printed 
properly. In real life, this is a very important question. When you answer 
Yes, Peachtree Accounting updates sales invoice numbers and flags the 
sales invoice as printed, so that it will not print again.

8 Select Yes.

Notice that the invoice states we have five bird house kits on backorder. 
This will be explained in a moment.

9  Press q to close the Select a Report window.

Understanding Backorders

Peachtree Accounting uses sales orders and invoices you have entered to 
determine if you have over-sold stock or assembly items. When you enter a 
sales order, all items are placed on order. Once you invoice items that are in 
stock, the remaining items (if any) remain on order. These items are 
considered to be on backorder. Once you purchase and receive these items, 
you can sell them, closing the sales order.

To determine what items are still on order after an invoice is posted, look at 
the Sales Backorder Report or the Sales Order Report.

In our previous example, we entered Sales Order #9001 for eight bird house 
kits when we only had three in stock. Therefore, we should still have five kits 
on backorder. Once we receive these items, we can invoice and ship the 
remaining five bird house kits; Sales Order # 9001 is then closed.
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1 From the Reports menu, select Accounts Receivable.

2 From the Select a Report window, scroll down, single-click the Sales 
Backorder Report, and click the Screen button.

The Sales Backorder Report window displays with the Filter tab selected. 
To make things easy, we will generate a report for only one customer.

3 In the As of Date field, enter or select March 25, 2003.

4 Place your mouse pointer in the From field of the Customer ID filter line. 

5 Select ARMSTRONG-01 and press e.

The Type field changes automatically to Range.

6 In the To field, select ARMSTRONG-01 again.

7 Select OK to display the report.

The Sales Backorder Report displays only the open sales orders as of the date 
specified. Our report displays the five remaining bird house kits on order. 
Once we purchase and receive additional kits from the vendor, we can issue a 
second invoice to our customer for the remaining five items ordered. This will 
close the sales order.

If we had displayed the Sales Backorder Report before posting the sales 
invoice, this report would have displayed eight bird house kits on order with 
three on hand.
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Entering a Cash Receipt

Now we are going to enter a receipt from Armstrong Manor for the amount 
we just invoiced.

1 From the Tasks menu, select Receipts.

Notice the similarities between the Receipts window and the Payments 
window. There are a few differences including the addition of the 
Deposit ticket ID and Payment Method fields. The Check Number field 
in Payments is replaced by a Reference field in Receipts.

2 The cursor is in the Deposit ticket ID field. This field defaults to today’s date 
and is used to combine receipts for fast account reconciliation with bank 
statements. Press e. 

You have the option of entering a receipt from a customer or a vendor. 
Usually receipts come from customers. However, you might receive a 
refund check from a vendor. 

3 Type A and press e. The customer Armstrong Manor displays. The 
cursor moves to the Reference field. 

The Apply to Invoices tab now displays the sales invoice 9901 we just 
entered. If the customer had other invoices due, they would also display 
here.

If you wanted to enter a cash sale (for example, a walk-in sale) without 
creating a customer ID or sales invoice, you could skip the Customer ID 
field and enter the name of the one-time customer in the Name field.
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4 Type 101 in the Reference field for the customer’s check. This is a required 
field. Press e. The cursor moves to the Date Field.

5 In the date field, type 29 and press e. The date formats to 
Mar 29, 2003.

The cursor moves to the Payment Method field. Peachtree Accounting 
allows you to enter up to 10 payment methods. These are set up in the 
Customer Defaults window.

6 Select Check from the Payment Method drop-down list and press e. 
The cursor moves to the Cash Account field. 

7 Select 10200—Regular Checking for the cash account. Press e.

Below the Cash Account field is the current balance (as of the check date 
3/29/03). If question marks display, select the Recalculate (Recalc) 
button to display the current balance. This displayed balance will not 
change until you select the Recalculate button again.

At this point, you can select invoices to pay. Optionally, you can enter a 
receipt against a sales income account. When you select the Apply to 
Sales tab, the outstanding invoices for this customer will temporarily 
disappear, and the columns in the distribution area will be different 
(similar to the sales invoice). We are going to apply this receipt against 
an invoice.

8 On the Apply to Invoices tab, check the Pay box in the far right column 
beside invoice 9901.

Notice that the Receipt Amount box on the check form now displays 
$736.10. This is $751.12 minus a 2% discount extended to Armstrong 
Manor (established in default customer terms). 

The Receipt Amount box shows a running total of the customer 
invoice(s) paid. You can only adjust the amount it shows indirectly by 
entering payments in the Amount Paid field.

9 Select the Post button to record and post this receipt.

You cannot print cash receipts.

10 Press q to close the Receipts window.
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Cash Receipts Transactions

When you post this receipt, the accounts receivable account is credited for the 
full invoice amount. This balances the debit created when we entered the 
invoice. The cash account is debited (increased) by the amount of the check, 
and the sales discounts account is increased by any discount that might apply. 
(You establish the discount for sales by selecting Default Information from 
the Maintain menu, and then Customers.)

Analyzing Customer Payments

Now we are going to look at how well Bellwether Garden Supply manages its 
collections of payments from customers. Obviously, they don’t have a 
problem with the invoice we just entered. They just need to ship Armstrong 
Manor the remaining items (currently on backorder) to close the sales order, 
and then invoice the remaining sale. However, to look at other customers and 
aging amounts, we’ll use the Collection Manager.

Using the Collection Manager

The Collection Manager allows you to analyze, on three different levels, the 
outstanding invoices owed by customers.

The first (Graph) level provides a graphical representation of outstanding 
invoices and the aging brackets the invoices fall into. You can select a bracket 
from this level and drill drown to a detailed view of the amounts in this level.

1 From the Analysis menu, select Collection Manager. The first level of the 
Collection Manager appears.

Notice the four aging brackets, along the horizontal or X axis. The 
vertical or Y axis shows dollar amounts due.
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2 Select the Bracket button.

Here we see the age of the invoice in days, the customer name, the 
invoice number, the document date, (transaction date), the due date, the 
total amount due, and the option to print a collection letter.

3 Move the highlight bar using your arrow keys to an invoice with Ertley 
Bulldog Sports. Select the Source button.

At this level, we see all the outstanding invoices for Ertley Bulldog Sports 
and their respective ages. You can send a collection letter from this 
window by selecting the Letter button from the toolbar.

4 Select Close to exit the Collection Manager and return to the Main Menu.

For more information on the Collection Manager, refer to the “Business 
Analysis” chapter of the User’s Guide.

Review of Lesson V

Let’s review some of the things we learned in this lesson.

• We covered the basic accounts receivable tasks: 

• Entering prospects and customer records

• Preparing proposals using quotes

• Printing quotes

• Ordering items using sales orders

• Shipping items and applying sales orders to sales invoices

• Applying a receipt against the sales invoice

• The number of accounts receivable tasks you’ll use depends on your 
business situation. If you want to bill a customer now and let them 
pay for it later, use the Sales/Invoicing window. If it’s a direct cash 
sale and no invoice is required, enter it in the Receipts window using 
the Apply to Revenue tab.

• Product and Service invoice templates are available from the Quotes 
and Sales/Invoicing windows:

• Product template: This data-entry window displays all available 
data-entry fields and can be used for products or services. If you 
track inventory, you should use this mode.

• Service template: This data-entry window allows you to print an 
invoice for services (only). If you don’t track inventory items, you 
can use this mode for easier data entry.
130



Lesson V—Accounts Receivable
Review of Lesson V
• While in a task window, you can enter a customer (or anything 
contained within a lookup box) on-the-fly by pressing + or double-
clicking the ID look-up field (except jobs).

• Most ID codes in the program can be any combination of letters and 
numbers up to 20 characters long. You should establish a consistent, 
logical coding system, so others in your company will know how to 
code a new vendor/customer, or how to find a previously entered 
one.

• Quotes are proposals you want to give a customer that outline a 
possible sale.

• Sales orders are used when your customer agrees to the sale but you 
are not ready to ship or sell the entire order. Quotes can be converted 
to sales orders to avoid additional data entry. The service or 
inventory items are ordered for the customer—either packaged by 
your shipping department or issued to your staff to schedule 
services. You can print sales orders and include them as packing slips 
when shipping items to your customer. Warehouse personnel can 
also mark up a printed sales order to determine what was shipped 
and what needs to be put on order.

• Sales invoices are entered once you actually ship items or render 
services. A sales invoice can apply only to one sales order at a time. 
Once the sales invoice is posted, the accounting information is 
entered into the General Ledger (in accrual-based companies).

• If you attempt to sell an item beyond the current stock level, you may 
receive up to two warning messages. Both messages are an optional 
setting in the Maintain Global Options window.

• Global Out of Stock Warning Message: This message warns that 
you are selling one or more items that are out of stock when you 
select the All button. The item is not identified. The quantities 
(for items out of stock) in the Shipped column are set back to 
zero.

• Individual Item Out of Stock Warning Message: This message 
warns that you are selling a particular item and displays the 
current stock level. This is a system-generated message. If you 
proceed, the item will be sold beyond the current stock level.

• If you want Peachtree Accounting to print a sales invoice, leave the 
Invoice # blank.

• Peachtree Accounting uses sales orders and invoices you have 
entered to determine if you have over-sold stock or assembly items. 
To determine if you still have items remaining on order after you 
have posted a sales invoice, look at the Sales Order or Sales Backorder 
report.
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• In accrual-based companies, entering typical invoices debits the 
accounts receivable subsidiary, and distributes the offsetting credit to 
the applicable income and sales tax payable accounts. If inventory 
items are used, inventory accounts are credited and cost of goods 
sold accounts debited.

• If you want to look at a graphical overview of all outstanding 
invoices from customers, use the Collection Manager’s Graph level. 
To zoom in on all outstanding invoices by aging bracket, use the 
Collection Manager Bracket level. If you want to view all outstanding 
invoices for just one customer for an aging bracket, use the 
Collection Manager Detail level.

Now that you have been introduced to the Accounts Receivable module of 
Peachtree Accounting, you are ready to proceed to Lesson VI—Payroll. 
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Lesson VI—Payroll
In this lesson, you’ll learn about processing payroll with Peachtree 
Accounting.

You will learn how to:

• Store constant information about standard payroll fields and 
payment methods in Default Information and in the Maintain 
Employee file 

• Enter paychecks

• Run a Payroll Register report to verify payroll entries

• Print payroll checks

• Analyze employee earnings

In this lesson, we’re also going to see how Default Information fits into the 
flow of tasks in Peachtree Accounting.

Estimated Lesson Time: 30 Minutes

Beginning the Lesson

If you are continuing from Lesson V, skip this section and proceed with the 
lesson.

If you are just starting the lesson, do the following:

1 Start Peachtree Accounting and open up the sample company, Bellwether 
Garden Supply. 

2 If the Action Items window appears, close it for right now. 

3 From the Options menu, select Global. Peachtree displays the Maintain 
Global Options window.

You need to make sure that the tutorial global options are set up 
properly.

4 In the Accounting tab, do the following:

• Select Manual Decimal Entry and 2 as the number of decimal places.

• Clear the Hide General Ledger Accounts option for all modules 
(Accounts Receivable, Accounts Payable, and Payroll).

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

Tu
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5 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could possibly have other global options selected as well. However, 
the above options are the only ones that directly affect this tutorial. 

6 When finished, select OK to close the Maintain Global Options window.

Payroll Tasks

Processing payroll in Peachtree Accounting is, at most, a five-step process. 
The number of steps may vary depending on your needs.

You may use all five steps, or, in some cases, only a couple, depending on how 
much payroll information you intend to track and/or use.

Task Procedure

Employee Defaults Set up company standard payroll 
information and define payroll fields 

Maintain Employees/Sales Reps Set up individual employees, pay rates, 
and special deductions 

Payroll Entry (or Select for Payroll 
Entry)

Enter paycheck information for a 
specific pay period

Print Payroll Checks Print employee paychecks

Reports Print Earnings reports, 941 forms, and 
W-2 forms
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Default Information

Default information is an important part of running your business efficiently 
with Peachtree Accounting. Setting up default information allows you to 
enter data easily while also being consistent.

1 From the Maintain menu, select Default Information, and then Employees.

The Employee Defaults window displays four folders. Each area allows 
you to set up standard information that will make your payroll 
processing as automatic as possible. We’ll look at some of this 
information.

2 Select the EmployEE Fields tab.
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Payroll Fields

Using payroll fields, you can track 401(k) contributions, tips, employee 
taxes, and employer taxes. You can even set up non-dollar amounts, like 
vacation hours, to be updated each pay period.

Payroll fields are holding places for any amount that must be updated by 
payroll processing.

Our sample company deducts Social Security, federal income tax, 
Medicare, and state income taxes, all of which are calculated by 
Peachtree Accounting based upon the appropriate tax table. The General 
Ledger accounts affected by payroll checks are generally liability 
accounts set up specifically to handle these kinds of deductions. You can 
set up allowances, such as a gas allowance, that is manually entered for 
an employee paycheck when applicable. Entering these kinds of 
allowances here saves time and ensures that the proper account is 
updated, no matter who in your office processes payroll.

If your payroll requires setting up additional payroll fields (for example, 
401(k), vacation, employee tips, commission, and so on), refer to the 
“Payroll” chapter of the User’s Guide. There are several examples you can 
follow to set up payroll fields.

Peachtree Accounting comes with tax tables for all 50 states. You tell the 
program the deductions and allowances you want it to calculate, and 
which table(s) you use for these calculations. 

The Memo check box is for payroll field amounts that are not posted to 
your company’s books, but to the employee records (for example, meal 
allowance and employee tips in the restaurant business).

Selecting the Run check box indicates that the amount in this field 
should be carried forward to the next year (for example, vacation or sick 
time).

3 Select the EmployER Fields tab.

These fields represent the employer portion of payroll entry including 
Social Security, Medicare, federal employment, and state 
unemployment.

If applicable, the company paid portion of State Disability (SDI) and 
401(k) matching contributions can also be set up here.

We’re going to see how the information in the payroll fields is used, 
together with the information stored in the employee file, when entering 
and posting a paycheck.

4 Press Cancel to close the window.
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Maintain Employees

In Default Information, you indicate the general guidelines for processing 
payroll for the whole company. In Maintain Employees, you give specific 
guidelines for individual employees. 

1 From the Maintain menu, select Employees/Sales Reps.

We’re going to look at two employees—one hourly and one salaried—
and then enter paychecks for each.

2 Select the lookup button beside the Employee ID field.

3 From the list, double-click MWANG-01—Michelle Wang.

4 Select the Pay Info tab.

 Notice the following things about Michelle:

• She is an hourly employee.

• She is paid every two weeks (bi-weekly) at 80 hours per pay period.

• She is being paid $9.00 an hour (regular rate).

5 Select the EmployEE Fields tab.

Notice the similarities between this window and the Default 
Information EmployEE Fields tab. The only difference is the presence of 
the Std column (short for Standard). If Std check box is selected, the 
employee is using the default setup for this payroll found in the 
Employee Defaults window. If the Std check box is clear, then the 
employee is an exception to the defaults.
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6 Move the cursor back to the Employee ID lookup list, if it’s not already 
there.

7 Select employee DGROHS-01—Derrick Grohs. Select the Pay Info tab again.

Compare this employee to Michelle Wang. Derrick Grohs is a salaried 
employee paid $1346.15 every two weeks.

8 Press q to close the window.

Payroll Entry

As we proceed to enter paychecks for these two employees, remember the 
kind of information stored in Default Information, and in the Maintain 
Employees file. We’ll see how important this preliminary information is, and 
how simple payroll processing is once you’ve set everything up properly.

1 From the Tasks menu, select Payroll Entry. 

2 In the Employee ID field, type MWANG-01 and press e.

3 To have the program print a check, leave the Check Number field blank by 
pressing e. 
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4 Accept the check Date displayed (3/15/03) by pressing e. 

The Hours Worked, from the Maintain Employees window, are listed in 
the bottom left of the window. The hours can be adjusted for this 
paycheck, if necessary.

Notice that all the Employee/Employer Fields entered in the Default 
Information display in the bottom right of the window. All of the fields 
we asked the program to calculate for us—Federal Income, Social 
Security, Medicare, and State Income—have been calculated, and display 
as negative amounts (because they decrease the check amount). 

Accrued Vacation (entered as a memo field) displays as a positive 
amount but is present for record purposes. It does not affect the balance 
of the paycheck. The EmployER field also displays (as a positive 
number) to record employer taxes. This field also does not affect the net 
amount of the check.

5 Save and post this paycheck, by selecting the Post button. 

A Salaried Employee

6 In the Employee text box, type DGROHS-01 and press e.

Notice that Derrick has the same payment and deduction categories as 
Michelle Wang. The only difference is he has a single Salary field where 
Michelle’s record had three types of hourly rates.

Once everything is set up properly, payroll takes very little effort. Just 
check the Check Date field and leave the Check Number blank to have 
the program print a check. If no special adjustments need to be made, 
save the record.

7 Save and post this paycheck, by selecting the Post button.

8 Press q to close the window.

Instead of entering one paycheck at a time, you could alternately enter a batch 
of paychecks and print them at the same time by using the Select for Payroll 
Entry option from the Tasks menu.Note
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Using the Payroll Register

After you have entered paychecks in payroll entry, look at the postings for 
accuracy before you print the checks. The Payroll Register is an excellent 
report to use before you print checks.

1 From the Reports menu, select Payroll. Peachtree displays the Select a 
Report window.

2 Select Payroll Register, and then select the Screen button.

3 In the Filter tab, select the Date drop-down list.

4 You have a variety of choices on how you print this report. Select Today 
from the drop-down list. The dates now display the range 3/15/03 to 
3/15/03. Using this filter, we will view paychecks entered today only.

Today’s date represents the system date (computer date). Our sample 
company system date is always set at 3/15/03 for tutorial purposes.

5 Select OK. The Payroll Register appears.

The two checks we just entered display, outlining each payroll field and 
the amounts deducted. These appear accurate. However, let’s examine 
one of the payroll entries in more detail. 

6 Place your cursor on the transaction line that represents Michelle Wang’s 
paycheck. A blue box outlines the report line, and the cursor changes to a 
magnifying glass.

This indicates you can examine the transaction in more detail.

7 Double-click the area outlined in blue. The Payroll Entry window displays 
the original transaction we just entered.

Double-clicking transaction lines in reports displays the window where 
the transaction was originally entered. This is known as the drill-down 
feature. You can drill down on most transactions displayed in reports. 
One advantage of using the Payroll Register is that we can actually edit 
the transaction at this point.

8 Give Michelle four hours of overtime by typing 4 in the Overtime Hours text 
box and pressing e. Notice how the amounts are automatically 
adjusted.
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9 Select Post to save the change.

10 Select Close to close the Payroll Entry window. You return to the Payroll 
Register report window.

Notice the report reflects your change. We have just demonstrated that 
you have the ability to edit transactions from reports and have the 
reports update for you at the same time.

Not all reports have the drill-down feature. The majority of task-related 
reports and ledgers contain the drill-down feature; maintenance list reports 
do not. The best way to determine this is by observing the cursor shape when 
placed on the report window in the detail area.

Everything appears ready for you to print your checks.

11 Press q twice to close the report windows.

Print Paychecks

Just as in vendor disbursements, you can print a batch of checks or print from 
the Payroll Entry window.

For this tutorial, you can use plain paper for printing checks. Or, if you like, 
you can test the alignment of forms. (If you are using a dot matrix printer, you 
can align the print head with the perforation of the paper forms.) 

1 From the Reports menu, select Payroll. Peachtree displays the Select a 
Report window.

2 Scroll down the Report List and open the Payroll Checks form folder by 
double-clicking it.

3 Double-click any of the displayed paycheck forms, such as PR Preprint 1 
Stub.

The Filter tab of the PR Preprint 1 Stub window appears.

4 Type 9999 for the first check number and press e.

5 Change the G/L Cash Account to 10300—Payroll Checking Account, if it is 
not already selected, and press e.

6 Press e to accept the displayed last check date for which checks will 
print.

Note
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7 Select OK to print the checks.

8 The Print window appears. Select OK if the printer settings look correct.

A window appears, asking if the checks printed properly and if it’s okay 
to update the journal. In real life, always look carefully at the checks 
before you answer Yes because Peachtree Accounting updates check 
numbers and flags these checks as printed.

9 Select Yes.

Take a moment to look at the two checks you just printed. The employee 
statement information is printed first, then the actual check. 

What Happens During Payroll Posting

In the simplest, most-common case, the cash account that you entered in the 
Employee Defaults window is automatically credited for the net paycheck 
amount when you post payroll checks. The employee salary expense is debited 
for the gross amount of the check, and any deductions you use are credited, 
to make up the balance of the gross.

DEFAULT INFORMATION

DEDUCTIONS

SIT

MAINTAIN

        PAYROLL

RATE OF PAY        FREQUENCY

$20 / HR WEEKLY

PAYCHECK NET

$500.00

SALARIES  750.00
FICA                               95.00
FIT                                125.00
SIT                                  30.00
CASH

DEBIT    CREDIT

500.00

FICA

FIT
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Analyzing Employee Earnings

At the end of a period, quarter, or year, typically you need to examine the 
accrued employee earnings. You may need to track certain payroll fields for 
one reason or another. These reports also detail what is printed on your 941 
forms as well as W-2s.

1 From the Reports menu, select Payroll.

2 Scroll down and double-click the Quarterly Earnings report. Peachtree 
displays the Quarterly Earnings report.

Scroll down and notice that every payroll transaction is included for 
each employee for the quarter and broken down by each payroll field. 
There are subtotals for the quarter as well as year-to-date totals. If you 
scroll to the very bottom, there are company totals for each payroll field.

Also, this report has the drill-down feature, shown by the blue outline 
that appears when you click a transaction.

We want to see the employee totals in a summary format, rather than 
listing every transaction.

3 Select the Options button. The Filter window appears.

4 Select the Show Totals Only check box, and then select OK. The report 
reformats and shows a summarized version of the Quarterly Earnings 
report.

When any report is displayed onscreen, you can select the Options 
button to modify the filter or layout.

5 Select q twice to close the report windows.

Review of Lesson VI

Let’s review some of the things we learned in this lesson:

• Payroll fields are holding areas within each employee record for any 
accumulating amount, dollars or otherwise, that should be updated 
by payroll processing.

• Once you establish Default Information and employee pay records, 
regular paychecks calculate automatically based upon frequency, rate 
of pay, valid deductions, and their corresponding tax tables.

• Adjusted gross is the gross pay plus any amounts you must add for 
tax purposes (such as restaurant tips), minus any amounts you must 
deduct for tax purposes (such as 401(k) contributions).
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• Double-clicking transaction lines in reports displays the Task 
window where the transaction was originally entered. This is referred 
to as the drill-down feature. One advantage is you can edit the 
transaction, save/post it and return to the report. The report 
automatically updates. The majority of task-related reports and 
ledgers contain the drill-down feature; maintenance list reports do 
not. The best way to determine this is by observing the pointer shape 
in the report window detail area. If the pointer is the shape of a 
magnifying glass, you can drill-down on the transaction.

• When any report is displayed onscreen, you can select the Options 
button to modify the filter or layout. 

Now that you have been introduced to the payroll module of Peachtree 
Accounting, you are ready to proceed to Lesson VII—Inventory.
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Lesson VII—Inventory
This lesson shows you how to implement and use Peachtree Accounting’s 
inventory system.

You will learn how to:

• Set up an inventory item

• Use inventory with purchases

• Use inventory with sales

• Use inventory reports

• Make adjustments to inventory levels

• Maintain item prices

Estimated Lesson Time: 20 Minutes

Beginning the Lesson

If you are continuing from Lesson VI, skip this section and proceed with the 
lesson.

If you are just starting the lesson, do the following:

1 Start Peachtree Accounting and open up the sample company, Bellwether 
Garden Supply. 

2 If the Action Items window appears, close it for right now. 

3 From the Options menu, select Global. Peachtree displays the Maintain 
Global Options window.

You need to make sure that the tutorial global options are set up 
properly.

4 In the Accounting tab, do the following:

• Select Manual Decimal Entry and 2 as the number of decimal places.

• Clear the Hide General Ledger Accounts option for all modules 
(Accounts Receivable, Accounts Payable, and Payroll).

• Select the “Warn if inventory item is out of stock” option.

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

Tu
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5 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could possibly have other global options selected as well. However, 
the above options are the only ones that directly affect this tutorial. 

6 When finished, select OK to close the Maintain Global Options window.

Tracking Inventory Items

Peachtree Accounting lets you track inventory items both in purchasing and 
sales (for stock items only). When you set up an inventory item, you can 
establish the general ledger accounts to update with purchases and sales. If 
you choose, Peachtree Accounting tracks the cost of goods sold, stock levels, 
sales prices, and vendors for your items.

Types of Inventory Items

There are several types of items you can use in Peachtree Accounting. These 
are called item classes. For a detailed explanation of the following item types, 
refer to the Inventory chapter of the User’s Guide.

• Non-stock item

• Stock item

• Description only

• Assembly

• Service

• Labor

• Activity item

• Charge item

Setting Up an Inventory Item

Our sample company, Bellwether Garden Supply, sells and installs garden 
supplies and tracks them as stock inventory items. It also offers various 
landscaping services and bills clients for items used. First, let’s enter a new 
garden supply product to be stocked as an inventory item.
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1 From the Maintain menu, select Inventory Items. 
T

Our new product is Violet Seeds.

2 Enter SEFL-31180 in the Item ID field and press e. The cursor moves to 
the Description field.

3 Type Violet Seeds and press e. The cursor moves to the Item Class 
drop-down list. Stock item is the default type.

4 Make this a stock type item by pressing e. The cursor moves to the 
Description field.

You can have two different detailed descriptions for inventory items—
one for sales, which appears on sales quotes, orders and invoices, and the 
other for purchases, which prints on purchase orders and invoices. You 
can use up to 160 alphanumeric characters for each description.

5 Select “for Sales” and type the following description: Bell-Gro Violet 
Seeds.

6 Select “for Purchases” and type the following description: Catalog #: 
101037: Violet Seeds.

This description refers to the Vendor’s identification of the product.

7 Move to the Sales Price # field and press the arrow button beside this field. 

You can set up five different sales prices per item. For this item, we’ll 
only set up one price.
147



Tutorials
Getting Started Guide3
8 Type 1.39 in the Sales Price #1 box, and then select OK to set the sales price 
per ring to $1.39.

9 In the Unit/Measure field type Packet and press e. The cursor moves to 
the Item Type field. 

The Item Type is a way of classifying similar inventory items for sorting 
and printing in reports.

All type fields are case sensitive. The program reads Supply, SUPPLY, and 
supply as being different types.

10 Type SUPPLY to classify the violet seeds as a supply item.

Inventory Default Accounts

When you purchase inventory stock-type items, you credit accounts payable 
and debit the inventory account. When you sell inventory stock-type items, 
two sets of disbursements take place:

• Debit accounts receivable, credit revenue

• Debit cost of goods sold, credit inventory

You must tell Peachtree Accounting which revenue account and cost of 
goods sold account to update for sales and which inventory account to 
update for both purchases and sales.

11 Being a retail and service company, Bellwether Garden Supply defaults the 
following accounts for stock items:

• G/L Sales Account: 40000 Sales 

• G/L Inventory Account: 12000 Inventory

• G/L Cost of Sales Account: 50000 Product Cost 

These accounts are set up in Inventory Item Defaults window. (From the 
Maintain menu, select Default Information then Inventory Items to 
display the Inventory Item Defaults window.) Each time you enter an 
item these accounts are already established for you. If an item is an 
exception, you can change the account information for this item on the 
Maintain Inventory Items window.

In our sample company we created some accounts specifically for seeds. 
Use the lookup list in the G/L Sales Acct field to enter account number 
40000-SE (Sales - Seeds). Keep the default account (12000) in the G/L 
Inventory Acct field. In the G/L Sales Acct field, enter 50000-SE (Product 
Cost - Seeds). 

Note
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12 Move to the Cost Method field.

Peachtree Accounting offers three costing methods to track your stock 
and assembly items in inventory: 

• Average Cost

• Last In First Out (LIFO)

• First In First Out (FIFO).

Always select the same method for each item in your inventory. Check 
with your accountant about the implications of changing this method. It 
should only be changed at the beginning of the fiscal year. For more 
information about costing methods, refer to the “Inventory” chapter of 
the User’s Guide.

Our sample company uses the FIFO cost method for all its stock and 
assembly items.

13 Move to the Last Unit Cost field. Type .55 and press e. The cursor 
moves to the Item Tax Type field.

The Last Unit Cost field is used for entering the cost of new inventory 
items in case you sell an item before there is a purchase, payment, or 
adjustment to base the real cost on. Once you enter a purchase, payment, 
or beginning balance, the item cost is calculated by Peachtree 
Accounting’s costing system (depending on your costing method).

In the Item Tax Type lookup box, you specify whether or not the item is 
subject to sales tax. You might also set up specific taxes for items that 
have special exemptions. An explanation of these exemptions is required 
by some states.

14 Type 1 (the code for a Regular taxable item) and press e twice, skipping 
the Subject to Commission field. The cursor moves to the Minimum Stock 
level field.

This records the minimum quantity on hand of the stock item you can 
reach before you need to reorder the item. Also, you can set your global 
options and action item alerts to warn if you fall below the minimum 
stock level. If you include a minimum stock level, you can effectively use 
the Inventory Reorder Worksheet in reports when you are ready to make 
inventory purchases.

15 Type 6 and press e to move to the Reorder Quantity field.

This records the minimum number of items you can reorder at one time 
(for example, the number of items in a case).
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16 Type 12 and press e to move the cursor to the Preferred Vendor ID field.

You can specify a primary vendor for a stock item. This is only used to 
track your recommended or usual vendor. You can still purchase items 
from other vendors.

17 Type ARBOR-01 for the vendor and press e.

18 Press 5 to save this inventory item, and press q to close the window.

Inventory and Purchases

Now let’s purchase the item from our vendor.

1 From the Tasks menu, select Purchases/Receive Inventory. The Purchases/
Receive Inventory window appears.

2 Type ARBOR-01 in the Vendor ID field and press e.

We received purchase invoice # 104 for 12 packets of violet seeds.

3 Type 1Ø4 for the vendor’s invoice number. 

This is generally a required field. However, you can select Waiting on Bill 
from Vendor if this is not known yet.

4 Select the Apply to Purchases tab. Move to the Quantity field.

5 Type 12 and press e. The cursor moves to the Item field.

6 Type the code we just created—SEFL-31180—and press e.

The purchase description and G/L Account default to the information 
we entered in the Maintain Inventory Items window.

7 Move the cursor to the Unit Price text box.

8 Enter .55 as the Unit Price and press e.

6.60 appears in the Amount field.

9 Post this purchase.

10 Press q to close the window.

When you post, Peachtree Accounting credits accounts payable and 
debits inventory (in an accrual-based company). The cost is updated 
each time you make a purchase, and is used to calculate cost of goods 
sold when an item is sold.
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Inventory and Sales

When you sell a stock-type item, Peachtree Accounting updates accounts 
receivable and computes the cost of goods sold, using the selected costing 
method. In the General Ledger report, entries are made which update 
accounts receivable, revenues, inventory, and cost of goods sold accounts. 
Peachtree Accounting also displays the inventory and cost of goods sold 
distributions in a separate Cost of Goods Sold Journal for tracking purposes. 
The entry is dated the day of the sales transaction.

Now that we have the item in stock, let’s enter a sale using our inventory item. 

1 From the Tasks menu, select Sales/Invoicing. Peachtree displays the Sales/
Invoicing window.

2 Click the lookup button in the Customer ID field and select HENSLEY-01 
(Hensley Park Apartments). 

3 Select the Apply to Sales tab if it is not already selected. Move to the 
Quantity column in the first transaction line.

4 Type 2 and press e The cursor moves to the Item column.

5 Click the lookup button to display the Item lookup list.

6 Single-click item SEFL-31180 (Violet Seeds). Notice the quantity on hand 
registers as 12.0000. Before you select OK, take a moment and select the 
Edit button at the bottom of the window.

The Maintain Inventory Items window appears, showing the SEFL-31180 
record. You could conceivably edit this record, save it, and then return to 
the Sales/Invoicing window. You can use this feature for all lookup lists. 
Notice that the Quantity on Hand displays 12.0000 as well.

7 Press q to return to the Sales/Invoicing window.

8 Type SEFL-31180 and press e. The account defaults to the information 
we entered when setting up the inventory item.

9 The program computes the amount, based on the quantity times the unit 
price. We’re ready to save and post this invoice.

The Invoice Total should display $2.97 (after adding sales tax).

10 Post this invoice.

11 Click the Close button to complete the task.
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Cost of Goods Sold

When you post a sale, Peachtree Accounting records the cost of goods sold 
and posts the normal sales distribution (in an accrual-based company). The 
program tracks the cost of all stock-type inventory items purchased, based on 
the costing method you chose for the item. Now, at the time of sale, the 
product cost times the quantity sold is credited to the inventory account and 
debited to the cost of goods sold account. (The program uses the accounts you 
specified when setting up the inventory item, through the Maintain menu.)

Inventory Adjustments

Sometimes it is necessary to adjust the amount of inventory items. This might 
be due to faulty records, pilferage, spoilage, or inventory change. Use the 
Inventory Adjustments Journal to make such entries.

In this example, we did a monthly inventory count at the warehouse. It 
appears that one of our gardening handbooks is missing. We need to reduce 
our inventory to adjust for this loss.

1 From the Tasks menu, select Inventory Adjustments. 

2 Enter or select BOOK-11010 in the Item ID field and press e. The cursor 
moves to the Reference field.

3 Press e to skip the Reference field (you could put anything here—the 
employee code for the person responsible, the date of a physical inventory, 
and so on.).

4 Press e to accept the displayed date. 

5 Move to the Adjust Quantity By field. 

The Quantity On-Hand field displays 2.00.
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6 Type -1 in the Adjust Quantity By field to decrease the current inventory 
level by one, and press e. The New Quantity field shows that you now 
have 1 book. 

7 Type Item missing as the Reason to Adjust.

8 Post this adjustment, and then close the window.

When you make an adjustment, the G/L Cost of Goods Sold account, G/L 
Inventory account, total inventory value, and quantity on hand are all 
updated. For more information on types of adjustments and how they affect 
your item cost refer to the “Inventory” chapter of the User’s Guide.

Maintaining Item Prices

Next we’re going to change the prices of some inventory items. One way to 
change prices is through the Maintain Inventory Items window. Follow the 
steps below to change the price of Violet Seeds from $1.39 per packet to $1.49 
per packet.

1 From the Maintain menu, select Inventory Items.

2 Type SEFL-31180 in the Item ID field, and press e.

Peachtree displays the inventory information for Violet Seeds.

3 Select the Sales Price arrow button. 

4 Enter 1.49 in the Sales Price #1 field, and then select OK.

5 Select the Save button to record the change, and then click the Close 
button to close the window.

You can also change prices from the Maintain Item Prices window. This 
method is more convenient if you are changing prices on a range of inventory 
items, or all inventory items. We’re going to mark up all of our seeds by 10%, 
so the following method will be faster.
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1 From the Maintain menu, select Item Prices. The Maintain Item Prices - Filter 
Selection window appears.

To mark up the seeds by 10%, we are going to filter by item ID. Notice 
the Item ID category in the Filter column.

2 Click your mouse pointer in the Type column next to Item ID. Select Range 
from the drop-down list.

3 Press e to move to the next column, and then type SE.

The item IDs for seeds all begin with the letters SE. Since the Item ID 
lookup list is currently arranged in alphabetical order, it will be easy for 
us to set a range for the seeds.

4 Press e to accept the first item ID for seeds, SEFL-31100 (Carnation 
Seeds Mix).
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5 Click the lookup button in the To column. Scroll down the list and double-
click SEVG-33270 (Watermelon Seeds), and then select OK.

6 In the “Mark up or down selected items by” field, select Percent. 

7 Press e to move to the next field where you can enter the percent by 
which you want to mark up the items. Type 10 and press e again.

Since we want to mark up all price levels of all seeds based on the current 
price, we can keep the default settings. For more information about the 
options on this window, refer to the Inventory chapter of the User’s 
Guide.

8 Click the Recalculate (Recalc) button to calculate the new item prices.

Scroll through the list to see that the prices for all seeds have been 
marked up 10%.

9 Click the Save button to adjust the item prices.
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Review of Lesson VII

Let’s review some of the things we learned in this lesson:

• For Stock Type inventory items, Peachtree Accounting tracks costs, 
quantities, descriptions, sales prices, minimum levels and reorder 
quantity. For non-stock, labor items and service items, the program 
tracks descriptions and sales prices. For description-only items, the 
program only tracks the description.

• When you purchase inventory stock-type items, you credit accounts 
payable and debit the inventory account. 

• When you sell inventory stock-type items, two sets of disbursements 
take place:

• Debit accounts receivable, credit revenue

• Debit cost of goods sold, credit inventory

• When you access a lookup list field, you can display detailed 
information or even edit the record by selecting the Edit button.

• Adjustments are used to correct levels of stock inventory. When you 
make an adjustment, the cost of goods sold G/L account, inventory 
G/L account, total inventory value, and quantity on hand are all 
updated.

• There are two ways to change the prices of inventory items. You can 
change prices on an individual level through the Maintain Inventory 
Items window. To change prices for a range of inventory items, or all 
inventory items, it is faster to use the Maintain Item Prices window.

Now that you have been introduced to the Inventory module of Peachtree 
Accounting, you are ready to proceed to Lesson VIII—Job Costing.
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Lesson VIII—Job Costing
This lesson teaches you how to implement and use Peachtree Accounting’s 
job costing system.

You will learn how to:

• Set up a job

• Use phases and cost codes

• Use job costing with purchases

• Use job costing with payroll

• Use job costing with sales

• Use job costing reports

Estimated Lesson Time: 30 Minutes

Beginning the Lesson

If you are continuing from Lesson VII, skip this section and proceed with the 
lesson.

If you are just starting the lesson, do the following:

1 Start Peachtree Accounting and open up the sample company, Bellwether 
Garden Supply. 

2 If the Action Items window appears, close it for right now. 

3 From the Options menu, select Global. Peachtree displays the Maintain 
Global Options window.

You need to make sure that the tutorial global options are set up 
properly.

4 In the Accounting tab, do the following:

• Select Manual Decimal Entry and 2 as the number of decimal places.

• Clear the Hide General Ledger Accounts option for all modules 
(Accounts Receivable, Accounts Payable, and Payroll).

• Select the “Warn if inventory item is out of stock” option.

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

Tu
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5 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could possibly have other global options selected as well. However, 
the above options are the only ones that directly affect this tutorial. 

6 When finished, select OK to close the Maintain Global Options window.

Job Costs

Job costs are any costs associated with the completion of a job or project. 
These may include costs associated with purchasing materials, or paying for 
labor, equipment, or subcontractors. Peachtree Accounting lets you assign 
job ID codes to identify jobs which can be applied to purchasing, payroll, and 
sales transactions. This way, you can track how the expenses and revenues 
impact costs for a specific job and analyze job profitability.

Peachtree Accounting helps you track job costing with easy options that can 
be used at a simple or detailed level. Before setting up a job, you have to 
determine how you want to use job costing.

Peachtree Accounting offers the following options to track job costing:

• Jobs only: If you want to track simple jobs where you don’t intend to 
use stages or specific kinds of costs.

• Jobs with Phases: If you want to divide jobs into separate stages.

• Jobs with Phases, Cost Types, and Cost Codes: If you want to assess 
cost of each item, its type/group, and its time of usage in each stage 
of the project.

Purchases

Sales
Labor
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Each job you set up in Peachtree Accounting can have up to three elements: 
phases, cost codes, and cost types. For more information on these elements, 
refer to the “Job Costing” chapter of the User’s Guide.

For this tutorial, we are going to set up a job which uses phases and cost codes. 
Then we will enter a purchase and assign the transaction to a particular phase. 
Next, we will enter a payroll transaction and assign labor and a cost code to a 
second phase. Finally, we will invoice the customer for reimbursable expenses 
and analyze job profitability.

Setting Up a Job

One of our sample company’s customers, Torrance Country Club, needs to 
have some landscaping work done. We need to set up a job ID so that we can 
track supplies and employee labor charged throughout the landscaping 
project.

1 From the Maintain menu, select Job Costs, and then Jobs. 

The Maintain Jobs window stores general information about the job and 
custom field information you want to track. It also allows you to enter 
estimated revenues and expenses in order to analyze job profitability.

We need to create a job for Torrance Country Club’s landscaping work. 
Most of the job information entered on this window is standard for all 
jobs, except for the job name and customer ID. Our sample company 
already has a similar landscaping job. We can copy the information from 
it to our new job to save data entry time.
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2 In the Job ID field, type ? and select HENSLEY-01 (Hensley Park 
Landscape).

This is a job still in progress. Notice the percentage of completion is 
currently set at 40%. It is also set up to use phases, which will be 
explained in a moment.

3 Select the Estimated Exp./Rev. tab.

The estimated expense and revenue is currently established for this job. 
It is broken down by phase ID and cost code ID for phases that use cost 
codes. Phase IDs and cost code IDs are set up in the Maintain Phases and 
Maintain Cost Codes windows. Your jobs can use any or all of the phase 
and cost codes currently set up for your company.

Let’s take a look at the phase codes currently set up for Bellwether 
Garden Supply.

4 Click your mouse pointer in the first Phase ID field (01-Design) and select 
the lookup button.

The lookup list displays all of the phases set up in the Maintain Phases 
window. Our sample company uses phases to break down all possible 
stages of landscaping.
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5 Select the Edit button from the Phase ID lookup list.

This Design phase does not use a cost code, so a cost type is established 
for the phase itself.

6 If you want to examine the current cost types, select the Cost Type drop-
down list.

7 Click the lookup button in the Phase ID field again, but this time select 03-
Nursery from the list. 

Notice that this phase uses cost codes. The cost type is set up with the 
cost code itself in the Maintain Costs window.

8 Select the Close button to return to the Estimated Expense and Revenue 
tab.

Because the first two phases (01-Design and 02-Permits) do not use cost 
codes, the Cost Code ID fields are disabled. However, our third phase, 
03-Nursery, is set up to use cost codes.

9 Move to the Cost Code ID field for phase 03-Nursery (currently displaying 
010-Labor). Click the lookup button to display the cost code lookup list.

Notice the cost code descriptions. These are set up in the Maintain Cost 
Codes window and break down the areas of job cost for our sample 
company.
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10 With 010 Labor selected, select Edit from the lookup list to examine this 
cost code.

The Maintain Cost Codes window appears. Notice this cost code uses 
the cost type of Labor.

11 Press q to return to the Estimated Exp./Rev. tab.

Job Estimates

You can create estimates for revenue and expenses of a job. These can be 
broken down into phases and cost codes. These items help you calculate 
the job’s profitability. Since these are just estimates, they are not 
recorded to the General Ledger. You can optionally print the estimate 
using the job reports.

Copying a Job ID

To save time we are going to copy this job information to our new job, 
and then enter estimated revenue and expenses.

12 Double-click the Job ID field to highlight the text.

13 Type TORRANCE-01 and press e.

You may get a message indicating you have modified the current record 
and asking if you want to save it. (This is an option you can activate in 
Global Options.) Select No for right now and continue entering the new 
job ID code.

Typing over the existing ID and pressing e automatically copies the 
job information to the new ID, including cost codes and phase codes. It 
does not copy beginning balances.

You can copy any ID in the Maintain windows using this method.

14 In the Description field, type Torrance Landscape and press e.

The current estimated expenses and revenues apply to this job. Select the 
General tab.

15 In the For Customer field, enter TORRANCE-01 to change the customer to 
Torrance Country Club.

16 In the Start Date, enter 3/15/03.

17 Change the % Complete value to zero (Ø).

Note
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18 Select the Custom Fields tab.

These field labels are established in the Job Defaults window. (From the 
Maintain menu, select Default Information, and then Jobs.) You could 
enter unique information that applies to this job. For tutorial purposes, 
we will not change these fields.

19 Select the Estimated Exp./Rev. tab. Enter the estimates similar to the 
following:

20 Select Save to establish the new job, and then close the Maintain Jobs 
window.

Job Beginning Balances

If you are setting up your company, you may have jobs already in progress. 
When you start to use Peachtree Accounting, you will need to enter beginning 
balances for those jobs. You can break down revenue and expenses by phase 
code and cost code. All of this information is valuable in establishing accurate 
up-to-date balances in the job ledger. None of the information entered in the 
Job Beginning Balances window is recorded to the General Ledger.

Since this is a new job, we can skip this. For more information on job 
beginning balances, refer to the “Job Costing” chapter in the User’s Guide.

Now we’re ready to apply some transactions to this job.
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Job Costing and Purchasing

Before we can begin work on Torrance Country Club, we will purchase a 
building permit from the county licensing board.

Purchasing Inventory Items for Jobs

An important point here is that you cannot purchase stock items or 
assemblies and apply them against a job. You can, however, apply non-stock, 
labor, or service items to a job. You can also record the purchase without 
using inventory; you would just include a description of the item.

If you need to apply a purchased stock item to a job, you can include it in the 
service you provide through Sales/Invoicing. Another way is to use the 
Inventory Adjustments window to decrease your inventory, and apply the 
adjustment to the job.

The cost of the permit can be charged to the job in one of three ways:

• Record the purchase directly as a job expense using inventory. You 
can assign a non-stock or a description-only inventory item to a job 
when you purchase it, but not a stock or assembly item.

• Record the purchase directly as a job expense without using 
inventory. You just record the expense by skipping the Item ID field 
and including a description of the expense. This method is best when 
recording time and expense transactions that you purchase on behalf 
of customer jobs.

• Record the purchase into Inventory, without entering a Job. When 
you bill the customer, enter the item and the job. Peachtree 
Accounting posts the price as job revenue and the Cost of Goods 
Sold as job expense.

1 From the Tasks menu, select Purchases/Receive Inventory. Peachtree displays 
the Purchases/Receive Inventory window.

2 Type GWINLICENSE-01 for the Vendor and press e.

3 Type 888 for the Invoice #. 

4 Select the Apply to Purchases tab, if it is not already selected, and move to 
the first transaction line. 

5 Skip the Quantity and Item ID fields to move to the Description field. Type 
License for Torrance Landscape. Then, press e. 

6 Accept account number 69ØØØ for the Licenses Expense G/L account and 
move to the Amount field.
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7 The total purchase cost of the permit is $75.00. Type 75.00 and press e 
to move to the Job field.

8 Type ? to display the Job lookup list.

Jobs with a folder indicate that phase codes and or cost codes are used. 
Jobs with just a “J” do not use phases or cost codes.

9 Double-click the TORRANCE-01 job folder to open it up and display the list 
of phases that you can apply to the job.

Phases with folders indicate that the job phase contains cost codes. 
Phases with just a “P” do not use cost codes.

10 Double-click Phase 02-Permits to select it.

The invoice total should display $75.00.

11 Post this purchase.

12 Press q to close the window.

Job Cost and Payroll

To simplify this example, we’ll assume that one employee performed the 
landscaping work. He spent 20 hours on the project.

1 From the Tasks menu, select Payroll Entry. The Payroll Entry window appears 
with the cursor in the Employee ID field. 

2 Click the Employee ID lookup button and select AKORNYLAK-01 (Alex 
Kornylak).

3 In the date field, type 22 to change the date of the check to March 22, 
2003 and press e.
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4 Select the Jobs button. 

5 Select the Add button to add a distribution line. 

6 Click your mouse pointer in the Job field of the line that was just added, 
and then click the lookup button.

The Job ID lookup list appears.

7 Double-click the TORRANCE-01 job folder. 

We will use another phase to record the labor of the landscaping project. 

8 Scroll down and double-click the 03-Nursery phase folder, and then double-
click 010-Labor. You return to the Labor Distribution to Jobs window.
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9 Type 20.00 regular hours worked on this job and press e.

You could select the Add button again to add another distribution line if, 
for instance, the employee worked on another job during this payroll 
period.

10 Select OK to return to the Payroll Entry window.

11 Post the paycheck. 

12 Press q to close the window.

Job Costing and Sales

We’re going to invoice Torrance Country Club for the landscape work so far. 

1 From the Tasks menu, select Sales/Invoicing.

The Sales/Invoicing window appears.

2 In the Customer ID field, use the lookup button to select TORRANCE-01 
(Torrance Country Club) as the customer.

3 In the date field, type 25 and press e to display Mar 25, 2003.

There are two methods for entering sales transactions and applying 
them to jobs. You can enter each transaction line individually and select 
the job ID, phase, or cost code that applies to the item. This is similar to 
the method we used in Purchases.

Peachtree Accounting offers another method which is faster and more 
efficient—Reimbursable Expenses.
167



Tutorials
Getting Started Guide3
4 Select the Apply Tickets/Reimbursable Expenses button, and then select the 
Reimbursable Expenses tab.

Reimbursable Expenses display for this customer, Torrance Country 
Club.

All purchase and payroll transactions that have been applied to the 
selected customer’s job display in this window. All transactions for other 
jobs using this customer will also display.

You must select a customer ID in the Sales/Invoicing window before you can 
select the Apply Tickets/Reimbursable Expenses button.

Notice that the expenses for the permit and the nursery labor display.Note
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5 Select the Use button to display the Select Reimbursables to Use window.

You could select a series of reimbursable transactions by job, item, or 
date range to apply to this invoice. For our example we will select All.

6 Accept the All option in the Select Reimbursables to Use window by 
selecting OK.

You could change the invoice amount of each transaction to apply your 
own markup. However, there is an easier way to accomplish this.

7 Select the Write Up button.

You have several options for writing up/down items—you filter which 
items should be written up, you can write up/down by a fixed amount, 
or you can write up/down by a fixed percentage.

We do not want to write up all the items, so we will select only items for 
a particular job.

8 Select the Job option. 
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9 Click the lookup button in the Job field.

The Job ID lookup list appears.

10 Double-click the TORRANCE-01 job folder. 

11 Scroll down and double-click the 03-Nursery phase folder, and then double-
click 010-Labor. 

You return to the Select Reimbursables to Write Up/Down window.

12 Select the “Write lines up/down by percent” option.

13 Type 75.0 in the % field for a 75% markup and select OK.

You return to the Reimbursable Expenses window. The $280.00 labor 
item displays the markup amount as $490.00. The total amount to 
invoice displays as $565.00.

14 Select OK to return to the Sales/Invoicing window.

The two transactions are included in the invoice. You could optionally 
type alternate descriptions for the items that will print on the invoice.

15 In the transaction line for the labor expense, enter the description Labor 
for landscape work and press e three times. The cursor moves to the 
Tax field. 

16 Type 2 for sales tax exemption and press e.

In some states, labor and service items are exempt from sales tax.

The Invoice Total now displays as $569.50.

17 Post the invoice.

18 Press q to close the window.
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Job Cost Reports

Now let’s look at a report that will tell us how we’re doing with our job. Note 
that the job is still incomplete.

1 From the Reports menu, select Jobs. Peachtree displays the Select a Report 
window. 

2 Single-click the Job Profitability Report, and then select the Screen button.

The Job Profitability Report window appears with the filter tab selected.

3 To set a range so that only information about this particular job will appear, 
click your mouse in the From field of the Job ID line. Then select 
TORRANCE-01 from the lookup list. 

4 Select TORRANCE-01 again from the lookup list in the To field, and then 
click OK. 

The report breaks down each job according to what was spent or earned 
for each affected general ledger account. Finally, it shows the profit or 
loss for each job.

5 Notice the profit margin for our new job, TORRANCE-01.

6 Press q two times to close both report windows.
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Review of Lesson VIII

Let’s review some of the things we learned in this lesson:

• Peachtree Accounting helps you track job costing with easy options 
that can be used at a simple or detailed level. Before setting up a job, 
you have to determine how you want to use your job costing process. 
Peachtree Accounting offers the following options to track in job 
costing:

• Jobs only: You require simple jobs in which you intend not to 
track stages or specific kinds of cost.

• Jobs with Phases: You want to divide your job into stages of 
completion.

• Jobs with Phases and Costs Codes: You want to assess cost of 
each item, its type/group, its time of usage in each stage of your 
project.

• Typing over the existing ID record and pressing e automatically 
copies the record information to the new ID including all fields. All 
you have to do at this point is change the description and other 
information that uniquely applies to the new record. You can use this 
method to copy any ID in the Maintain windows.

• To track job cost, enter a different line on each purchase or invoice 
for each job-related item or service.

• There are several ways to enter purchases as costs to a job: 

• through the Purchases/Receive Inventory or Payments windows 

• through Sales/Invoicing as a cost of goods sold entry from 
inventory

• through inventory adjustments.

• Employee hours can be charged to jobs through the Payroll Entry 
window, using the Jobs button.

• Peachtree Accounting tracks income and expense per job, for each 
applicable Income Statement account, per transaction line item.

Now that you have been introduced to the job costing module of Peachtree 
Accounting, you are ready to proceed to Lesson IX—Company 
Administration.
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Lesson IX—Company Administration
This lesson shows you how to implement various administrative functions in 
Peachtree Accounting.

You will learn how to:

• Enter and use memorized transactions

• Set up user IDs and passwords

• Assign limited access to certain program areas

• Activate and use Peachtree Accounting’s audit trail log

• Remove user/password data security

Estimated Lesson Time: 20 Minutes

Beginning the Lesson

If you are continuing from Lesson VIII, skip this section and proceed with 
the lesson.

If you are just starting the lesson, do the following:

1 Start Peachtree Accounting and open up the sample company, Bellwether 
Garden Supply. 

2 If the Action Items window appears, close it for right now. 

3 From the Options menu, select Global. Peachtree displays the Maintain 
Global Options window.

You need to make sure that the tutorial global options are set up 
properly.

4 In the Accounting tab, do the following:

• Select Manual Decimal Entry and 2 as the number of decimal places.

• Clear the Hide General Ledger Accounts option for all modules 
(Accounts Receivable, Accounts Payable, and Payroll).

• Select the “Warn if inventory item is out of stock” option.

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

Tu
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5 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could possibly have other global options selected as well. However, 
the above options are the only ones that directly affect this tutorial. 

6 When finished, select OK to close the Maintain Global Options window.

Memorized Transactions

You can enter and save common transactions for later use. For example, you 
may want to repeat a transaction previously used for a customer several times. 
Using memorized transactions can save time in repetitive data entry tasks.

You can set up and use memorized transactions for the following:

• quotes

• sales invoices

• purchase orders

• payments

• General Journal entries

You can do the following with memorized transactions:

• enter a new memorized transaction from scratch

• save an existing task transaction as a memorized transaction for later 
use

• select an existing memorized transaction and apply it to a new task 
transaction
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Displaying a Memorized Quote

1 From the Maintain menu, select Memorized Transactions, and then select 
Quotes. Peachtree displays the Maintain Memorized Quotes window.

The Maintain Memorized Quotes window looks similar to the Quotes 
window selected from the Tasks menu. However, two new components 
display that are used to identify the memorized transactions:

• Transaction ID: This is a code used to identify the memorized 
transaction for later use. Enter up to 20 alphanumeric characters for 
a new memorized transaction ID. It’s important to use consistent 
and logical coding. You might want to code your most popular items 
so that they will display first.

• Description: This is text used to describe the transaction that 
appears in the Memorized Transaction lookup list. 

Rather than enter a new memorized quote, let’s display an existing 
memorized quote included in the sample data. 

2 Type ? or click the magnifying glass to display the lookup list. Double-click 
LAWN001 (Lawn Care Service - Fert/Seed). The memorized quote appears.

Since this quote can be used in multiple sales situations, the Customer 
ID, Quantity, and Amount fields are blank. These fields will be entered 
later when the actual quote is recorded.
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Using a Displayed Memorized Transaction

3 With the Lawn Care Service memorized quote displayed, select the Use 
button.

The Quotes window appears and the memorized transaction 
information is applied. You can now enter a customer ID, quote number, 
date, and other unique information.

4 Press q twice to close both the Quotes window and the Maintain 
Memorized Quotes window. When asked if you want to save the 
information, click No.

Selecting a Memorized Transaction for Use in a Task Window

You can also select and use memorized transactions from the task window 
itself.

1 From the Tasks menu, select Sales/Invoicing. The Sales/Invoicing window 
appears.

Rather than enter a new invoice we can select an existing memorized 
invoice.

2 From the Edit menu, choose the Select Memorized Transaction option. 

3 Select Invoice LAND001—Monthly Landscaping Service and click OK.

The Sales/Invoicing window appears with memorized transaction 
information included. Now all you need to do is to select a customer ID 
and print the invoice.

As you can see, memorized transactions can be used to enter common 
transactions. This provides a more efficient way to enter repetitive data, 
which makes data entry faster.

4 Use the lookup button in the Customer ID field to select HOLT-01 (Holt 
Properties, Inc.).

5 Select Post to record the new transaction.

6 Press q to close the Sales/Invoicing window.
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Saving a Transaction as a Memorized Transaction

You can also save a displayed transaction as a memorized transaction.

1 From the Tasks menu, select Payments. The Payments window appears.

2 Enter or select SAFESTATE-01 (Safe State Insurance Company) as the 
Vendor ID.

3 With the Apply to Expenses tab selected, type Truck Insurance Premium 
in the first Description field and press e. Type 540.00 in the Amount 
field and press e.

Rather than save the payment, we will memorize this payment for later 
use.

4 From the Edit menu, select Save As Memorized Transaction. Peachtree 
displays the Maintain Memorized Payments window with the payment 
information.

5 Enter Payment 003 as the Transaction ID.

6 Enter Truck Insurance Premium as the description.

7 Select SAFESTATE-01 as the Vendor ID. 
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8 When finished, select Save to record the memorized transaction.

You can now use this memorized payment any time you want to pay the 
insurance company. You can even change the amount if it goes up or 
down.

9 Press q twice to close the Maintain Memorized Payments and Payments 
windows. Select No when asked if you want to save the payment in the 
Payments window.

User IDs and Passwords

Peachtree Accounting allows custom access for different users. You can set up 
user profiles (records) for each person who will be using Peachtree 
Accounting. Each user record is set up with a user ID and password that will 
be required before opening and working with company data. Setting up users 
also enhances security and personal accountability when the Use Audit Trail 
option is activated. (This will be explained in a moment.)

You can set up user rights (control levels) to various program areas of 
Peachtree Accounting. You can choose to allow users access to a complete 
program module (for example, all Sales areas) or limit access to a particular 
window (for example, Sales/Invoicing). 

The next part of the lesson will demonstrate how to implement user IDs and 
passwords in our sample company, Bellwether Garden Supply. 

Set Up an Administrative User

1 In Bellwether Garden Supply, select Users from the Maintain menu.

2 A message appears indicating that you are about to set up users and 
passwords for the first time. Select OK to continue. 
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3 Type admin as the user ID and press e. 

4 Type peach as the password and press e.

Notice that the “Access to Maintain Users” check box is disabled (gray 
and unavailable). The first user you set up in Peachtree Accounting 
must have the “Access to Maintain Users” option selected. Typically, the 
first user would be an administrative user who needs access to all areas 
included the Maintain Users window. This ensures that at least one user 
can manage user records and passwords. You can have more than one 
user with this option. However, for security reasons it is best to have 
only one administrative user.

5 Select Save to establish the user record.

6 A message appears telling you that you have set up user/password security 
in this company. Select OK to continue.

7 We have the option of setting up additional users and choosing rights 
(control levels) to various program areas of Peachtree Accounting.

For simplicity, we will limit access to program areas for our own 
administrative user record. 

8 With the admin user record still displayed, select the Summary tab (if it is 
not already displayed).

9 Select the Payroll program area, click the Control field, and choose No 
Access from the Control drop-down list.

This option will prevent a user from accessing payroll areas in Peachtree 
Accounting. You can also select control access to individual areas (for 
example, specific windows) of Peachtree Accounting.
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10 Select the Inventory tab.

Three primary program areas display: Maintenance, Tasks, and Reports.

11 Double-click the triangle to the left of Maintenance. The Program Area list 
expands.

Three secondary program areas appear: Inventory Items, Inventory 
Item/Beginning Balances, and Multiple Item Prices.

12 Select Read from the Control drop-down list for the Inventory Items 
program area.

This control level will allow users to open the Maintain Inventory Items 
window and display records. However, they cannot add, edit, or delete 
inventory items.

13 Select No Access for the Inventory Item/Beginning Balances program 
area.

The user will not be able to display or maintain inventory item 
beginning balances.

14 Select No Access for the Multiple Item Prices program area.

The user will not be able to change or recalculate sales prices for a group 
of inventory items. 

15 Select Save to record the access rights.

16 Press q to close the Maintain Users window.

A message notifies you that any changes you made, including changes to 
your personal user record, will take effect the next time you open the 
company. 
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Logging on to a Peachtree Accounting Company

1 From the File menu, select Open Company. Select OK to close the current 
company. The Open Company window appears.

2 Select Bellwether Garden Supply, and then select OK. A Security Check 
window appears.

3 Enter admin as the User ID and peach as the Password. Click OK to verify 
your access information and open the company.

User IDs and passwords are case sensitive. If you have trouble logging 
on, check your Caps Lock key.

Demonstrating Limited User Access

Previously we set up no access to payroll areas of Peachtree Accounting and 
limited access to inventory.

1 From the Maintain menu, select Employees/Sales Reps. 

Notice that the menu option is not available. The same would hold true 
for Payroll Entry and other payroll tasks and reports.

2 From the Maintain menu, select Inventory Items. Peachtree displays the 
Maintain Inventory Items window.

3 Enter or select any existing item record to display its information.

4 Select the Save button . 

A warning message indicates that you do not have rights to edit records 
in this area. Also, notice that you do not have access to the Beginning 
Balances button.

5 Select OK on the warning message. Then, press q to close the window.

Audit Trail

There are several methods in Peachtree Accounting that you can use to track 
information. For example, a combination of the General Ledger, journals, 
reports, and financial statements can be used to trace transactions and 
balances for audit purposes. However, if you want to track when an action is 
performed in your company data, you can activate Peachtree Accounting’s 
audit trail. This is a security option that logs when a person enters data, 
maintains (edits) existing data, and removes data. Audit trail provides 
accountability of users, deters users from fraudulent activity or mistakes, and 
tracks transaction history. The Audit Trail report can trace fraudulent activity 
and other accounting adjustments that might otherwise have been missed.
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Activating Audit Trail

Before Peachtree can log data activity, you must select the Use Audit Trail 
option in the Maintain Company Information window. 

1 From the Maintain menu, select Company Information. The Maintain 
Company Information window appears.

2 Select the Use Audit Trail check box and click OK.

After you select this option, Peachtree will begin logging data activity for 
the current company. 

Demonstrating Audit Trail Activity

To observe audit trail activity, follow the steps below:

1 From the Maintain menu, select Customers/Prospects. Enter or select any 
existing customer record. Change the customer’s phone number. Then 
select Save and close the window.

2 From the Tasks menu, select Payments. Enter or select any vendor and make 
a payment. Then select Post and close the window.

If you selected a vendor with an outstanding purchase, select the Pay 
check box. 

Displaying the Audit Trail Report

The Audit Trail report can list important information about each activity 
performed while operating in the Peachtree Accounting company. The Audit 
Trail report can trace fraudulent activity and other accounting adjustments. 

1 From the Reports menu, select Company. The Select a Report window 
appears.

2 With Audit Trail Report highlighted, click the Screen button. 

The Audit Trail Report window appears with the Filter tab selected.
182



Lesson IX—Company Administration
Audit Trail
3 In the Date field (right above the Filter Range), click the drop-down list and 
select Range. In the From field, enter today’s date (the actual date you’re 
doing this lesson). In the To field enter March 15, 2003. Then select OK to 
display the report onscreen.

Audit trail activity is recorded based on your computer’s system clock. 
Therefore, all the activity we just completed will be stamped with today’s 
date and time even though Peachtree’s system date for our sample 
company is March 15, 2003.

Three items display in the report:

• The action of activating audit trail in the Maintain Company 
Information window

• The action of changing a customer’s record

• The action of adding a payment

Notice that the user ID “admin” is associated with each audit trail 
activity. If you intend to activate Peachtree's audit trail log, it is highly 
recommended that you set up user records in the Maintain Users 
window. Peachtree can associate the user currently logged into the 
company with the data that is being entered or maintained, thus 
providing a more complete audit trail. For example, USER1 adds a 
customer record. USER2 then logs on and modifies the customer record. 
The Audit Trail report will show that USER2 was the last person who 
maintained the customer record, and it will display what was changed. 
This establishes user accountability.

4 Press q twice to close the Audit Trail Report window and the Select a 
Report window.
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Removing User/Password Protection

For tutorial purposes, we need to remove user/password security from the 
sample company so that anyone can easily open the sample data. To avoid 
entering a user ID and password when opening the sample data (or any 
company that has security set up), you must delete all user records. 

Only individuals who have access to the Maintain Users window can delete 
user records and disable data security. If you followed along in this lesson, you 
are currently logged in our sample company as “admin,” with access to the 
Maintain Users window.

1 From the Maintain menu, select Users. The Maintain Users window 
appears.

2 Enter or select the “admin” user ID.

3 Select the Delete button to remove the user record. Select Yes to confirm 
deletion.

A warning message appears notifying you that security has been 
removed from this company and will take effect after closing the 
company. 

4 Select OK to the warning message to continue.

5 Close the Maintain Users window. 

You will receive another warning message. Select OK to continue.

6 Close the company or exit Peachtree Accounting.

7 The next time you open the sample company, Bellwether Garden Supply, 
you will not be prompted to enter a user ID and password.

Note
184



Lesson IX—Company Administration
Review of Lesson IX
Review of Lesson IX

Let’s review some of the things we learned in this lesson:

• Memorized transactions can save time in repetitive data entry tasks. 
You can set up and use memorized transactions for quotes, sales 
invoices, purchase orders, payments, and General Journal entries.

• You can do the following with memorized transactions:

• enter a new memorized transaction from scratch

• save an existing task transaction as a memorized transaction

• select an existing memorized transaction and apply it to a new 
task transaction

• You can set up data security by allowing individual access to your 
company data. You can set up user profiles (records) for each person 
who will be using Peachtree Accounting. Each user record is set up 
with a user ID and password that will be required before opening 
and working with company data. You can set up user rights (control 
levels) to various program areas of Peachtree Accounting.

• If you want to track when an action is performed in your company 
data, you can activate Peachtree Accounting’s audit trail. This is a 
security option that logs when a person enters data, maintains (edits) 
existing data, and removes data. Audit trail provides accountability 
of users, deters users from fraudulent activity or mistakes, and tracks 
transaction history. The Audit Trail report can trace fraudulent 
activity and other accounting adjustments you may not know were 
completed.

• If you intend to activate Peachtree’s audit trail log, it is highly 
recommended that you set up user records in the Maintain Users 
window. Peachtree can associate the user currently logged in with the 
data that is being entered or maintained, thus providing a more 
complete audit trail. 

• If you delete all user records, the Security Check (log in) window will 
no longer display when you open the company. It will also remove 
user accountability if the Use Audit Trail option is selected in 
Maintain Company Information.

You can now proceed to Lesson X—Time & Billing.
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Lesson X—Time & Billing

This lesson shows you how to implement and use Peachtree Accounting’s 
Time & Billing system.

You will learn how to:

• Enter a daily time ticket

• Use a weekly time sheet

• Enter billable and non-billable expense tickets

• Enter a reimbursable expense for a job

• Apply time tickets to an employee’s paycheck

• Apply time and expense tickets to a customer’s invoice

Estimated Lesson Time: 35 Minutes

Beginning the Lesson

This lesson uses a separate sample company, Pavilion Design Group. This is a 
graphics service company designed to demonstrate Peachtree Accounting’s 
Time & Billing features.

The Time & Billing sample data can be installed using the Peachtree 
Accounting compact disc. If you chose the Standard or Upgrade installation 
option, the sample company data is installed and you are ready to begin. 

If you do not have sample company data installed, reinstall Peachtree 
Accounting (the compact disc version), select the Custom installation option, 
and choose to load sample company data only. For more information, see 
“Introducing and Installing Peachtree Accounting” on page 1.

1 From the File menu, select Open Company. Peachtree displays the Open 
Company window.

2 Select Pavilion Design Group, and then click OK.

The sample company opens and all menus are available. The company is 
set up in Period 1 (January 2000). 

There is approximately two weeks worth of data entered for you, which 
you are welcome to explore. Unlike Bellwether Garden Supply, (a 
company that sells inventory), Pavilion Design Group is a service 
company. It has worked on various graphics projects including clothing 
catalogs, company logos, software graphics, restaurant menus, and so 
on. Each of these projects uses various elements of job costing and time/
expense.

Tu
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Backing up the Sample Company Data

If you are the first person in your company to work with this tutorial, then you 
have the honor of backing up the sample company data. This step is 
important because we are going to be entering information and posting 
transactions. Others in your office will need a clean copy of the sample data 
so they can enter the same information and encounter the same conditions. 

If you are not the first person to run through this tutorial, you can read this 
section to understand the procedure, then proceed to the next section, 
“Restoring the Sample Company Data.”

1 From the File menu, select Back Up. The Back Up Company window 
appears.

2 Click the Back Up Now button.

3 In the Save Backup window, specify the path and file name for your backup 
copy. For example, SAMPLE.ptb.

4 Click the Save button. Peachtree displays the estimated size of your backup.

5 Click OK. The system displays the progress of the backup until it is 
complete.

Note: For more information on backing up data, refer to the “Company 
Administration” chapter of the User’s Guide.

Restoring the Sample Company Data

If you are not the first person to use this tutorial, you must restore the sample 
company data to its original state. Open the company you want to restore.

1 From the File menu, select Restore.

2 Select the backup of the sample company data. (SAMPLE.ptb.)

3 Click the Open button to begin the restore process. The system displays the 
progress of the restore procedure.

You will first receive a warning message that you are about to overwrite 
existing data. Select OK to continue.

Note
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Setting Up Tutorial Global Options

You need to make sure that the tutorial global options are set up properly.

1 From the Options menu, select Global. Peachtree displays the Maintain 
Global Options window.

2 In the Accounting tab, do the following:

• Select Manual Decimal Entry and 2 as the number of decimal places.

• Clear the Hide General Ledger Accounts option for all modules 
(Accounts Receivable, Accounts Payable, and Payroll).

• Select the “Warn if inventory item is out of stock” option.

• Select the “Recalculate cash balance automatically in Receipts and 
Payments” option.

3 In the General tab, do the following:

• Make sure the Line Item Entry Display option is set to two lines.

• Select both Smart Data Entry options by putting check marks in the 
“Automatic field completion” and “Drop-down list displays 
automatically” check boxes.

You could possibly have other global options selected as well. However, 
the above options are the only ones that directly affect this tutorial. 

4 When finished, select OK to close the Maintain Global Options window.

Changing the System Date

Since most of the sample data is in Pavilion Design Group is dated during the 
first two weeks of January, 2000, we need to change the Peachtree system date.

1 From the Options menu, select Change System Date.

2 Enter or select January 14, 2000 as the Peachtree System Date. Then, 
select OK.

This is a temporary setting that matches your computer settings with those of 
the tutorial lesson. Once you complete the lesson, you will be instructed to 
reset the system date to today’s date. 

If you decide to take a break from this lesson, close the sample data company, 
or exit Peachtree Accounting, you must reset the system date each time you 
open Pavilion Design Group company data.

Note
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The Time & Billing Process

Time & Billing can track time spent on various activities and record internal 
use of company resources on behalf of customers or jobs. If you choose, 
recorded time and expenses can later be billed to customers on sales invoices. 
If you use payroll, timed activities can be applied to an employee’s paycheck. 
Time & Billing can also be used to effectively manage administrative activities 
and overhead expenses for your business.

This lesson demonstrates a typical Time & Billing process. It summarizes all 
the procedures and areas of Time & Billing used in Peachtree Accounting. 

• Recording daily time tickets

• Using a weekly time sheet

• Recording billable and non-billable expense tickets

• Entering reimbursable expenses for a job

• Paying employees based on time-ticket hours (payroll)

• Reimbursing employees for out-of-pocket expenses

• Billing customers for the work completed (time spent, expenses 
incurred, and charges that need to be recovered).

Understanding the Scenario

Cherokee Community Theater, a customer of ours, has asked us to design and 
print an upcoming membership campaign packet to be mailed to potential 
subscribers. The membership packet includes the following:

• a color brochure describing upcoming performances

• a cover letter from the theater president

• a new subscription form
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Recording Time Tickets

Peachtree Accounting uses the concept of tickets to track time and expenses. 
There are two types of tickets—time tickets and expense tickets. The difference 
between time and expense tickets is the type of service or item that the ticket 
references.

Time Tickets

Time tickets record an activity that has a timed duration associated with it. 
Employees or vendors can record time spent performing activities like the 
following:

• talking on the phone or meeting with a client

• researching information for a project

• designing and writing proposals

• developing or completing tasks for a project

Peachtree Accounting allows you to manually enter timed durations or 
actively start and stop a timer running while performing the activity. When 
using the timer, Peachtree calculates the duration for you. You can even 
account for breaks in the activity that should not be included in the duration 
such as lunches, telephone calls, or other interruptions.

You can use two methods to enter time tickets. You can enter single daily time 
tickets in the Time Tickets window using the Daily tab, or you can enter 
several time tickets at once using a weekly time sheet. This is done in the 
Weekly tab of the Time Tickets window.

Entering a Time Ticket 

Our customer provided us with the text and artwork to go in the brochure. 
Judy, one of our employees, spent 4.5 hours designing and typesetting the 
brochure. For this type of project, graphic design is billable by the hour. 
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1 From the Tasks menu, select Time/Expense, and then Time Tickets. 

You can record time and expense tickets for employees or vendors in 
Peachtree Accounting. 

2 Select Employee as the type for this ticket and press e.

3 Enter or select JW01 (Judy White) from the employee ID lookup list.

In this example, we will enter a single daily time ticket.

4 Select the Daily tab (if it is not already selected).

A ticket number is automatically assigned by Peachtree.

5 Judy is recording the ticket today, January 14, 2000. The ticket date already 
states this for us. (If it does not, enter the date accordingly.) Then, press 
e to move to the Activity Item field.

Activity items are used to explain what is being recorded on time tickets; 
these items indicate how time is spent when performing services for a 
customer, for a job, or for internal administrative work. Activity items 
are initially set up in the Maintain Inventory Items window.
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6 Select the ART02 (Artwork - Layout and Design) activity item from the 
lookup list.

If you want to examine how the activity item was set up, select the Edit 
button (at the bottom of the lookup list). The Maintain Inventory Items 
window displays with the ART02 activity item selected. For more 
information on setting up inventory items, refer to the “Inventory” 
chapter of the User’s Guide.

Tickets can be recorded for customers, for jobs, or for administrative 
purposes. You would select Administrative if this ticket was recorded for 
company use, such as bookkeeping time, vacation time, and so on. Our 
example demonstrates a billable time ticket for a job.

7 Select Job, and then press e.

8 Type a ? in the Job field. The job ID lookup list appears.

9 Double-click the CHER01-1 (CCT New Season Brochure) job folder. 

10 Double-click the 02-Design phase folder, and then double-click on 011-
Design Labor cost code. You return to the Time Tickets window.

11 Select Regular in the Pay Level field.

The pay level selected here represents the pay level that will be used when 
this ticket is applied during payroll entry. In this case the time-ticket 
hours recorded here will display in the Regular hourly pay level field on 
the Payroll Entry window.

Recording Durations

You can enter time-ticket durations manually or have Peachtree use a 
timer to actively clock the duration.

12 Select the Timed Duration option. Then select the Start icon.

The Duration field displays the clocked time in second intervals. You 
could minimize the Time Tickets window and begin performing the task 
the activity describes. When the activity is completed or you need to take 
a break, maximize the Time Tickets window and select the Stop icon.
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You can only have one time-ticket timer running on a computer or 
workstation at a time.

To save time, we will record the time manually.

13 Select the Stop Timer icon. Then select the Manual Time Entry option. Press 
e to move to the Start Time field.

14 Enter or select 9:00 AM as the start time and press e to move to the 
End Time field.

15 Enter or select 2:30PM as the end time and press e to move to the 
Break field.

16 Break is an optional field that can be used if there is time that should not be 
included in the duration. Judy took an hour for lunch. 

17 Enter 1:00 and press e to move to the Billing Type field.

Notice that the duration calculated 4 hours and 30 minutes (5:30 less the 
one-hour break). If you wanted to manually change the duration, you 
could select the Timed Duration option, and enter a time directly in the 
Duration field. For now, we will keep our manually timed entries. 

Switching from Manual Time Entry to Time Duration automatically resets 
the Start and Stop time values to 12:00 AM and Break to 0:00. However, your 
Duration value does not change.

Next, we need to include the billing information for this time ticket. 
There are four types of billing rates available in tickets.

• Employee rate: The billing rate set up in Maintain Employees/Sales 
Reps for this employee will be used for this time ticket.

• Activity rate: One of five billing rates set up in Maintain Inventory 
Items for this activity item will be used for this time ticket.

• Override rate: This allows you to enter a desired billing rate.

• Flat fee: This allows you to ignore the duration of the time ticket and 
charge a single fee for the activity performed.

18 Select the Activity rate billing type and press e to move to the Billing 
Rate field.

The billing rate selected is $65.00. Select the down arrow and you will 
notice three billing rate levels. Cherokee Community Theater is set up in 
Maintain Customers to use the first sales price level.

Note

Note
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19 Press e to accept the $65.00 billing rate and move to the Billing Status 
field.

There are four types of billing status.

• Billable: This ticket can be included on customer invoices.

• Non-Billable: This ticket will not be applied to customer invoices. 
This status is automatically applied if this is an administrative ticket.

• No Charge: This ticket will be forced to a zero billing amount. This 
ticket can be applied to customer invoices.

• Hold: This ticket will not be applied to customer invoices until the 
ticket’s status is changed to billable. 

20 Select Billable as the billing status.

 The billing amount is calculated for us at $292.50.

21 Press e to move to the Ticket Description field.

There are two description fields:

Ticket Description for Invoicing: This is a short description primarily 
used for describing the ticket’s activity for billing purposes. This 
description can later be applied to a customer invoice.

Internal Memo: This is a note about the ticket intended for company use 
only. Ticket memos can provide detail regarding the activity recorded.

22 Type the following ticket description: Graphic Design and Layout: 2000 
Season Brochure.

23 Type the following internal memo: Completed initial layout and design 
based on accepted concepts. Ready for proofing.
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Our time ticket is complete.

24 Select Save to record the ticket.

This ticket does not create a General Ledger entry. It is used solely to 
track time recorded by the employee. It can later be applied to the 
customer’s sales invoice.

Using a Weekly Time Sheet 

Judy, our employee, is paid by our company based on time-ticket hours she 
records. She needs to enter time tickets this week so that she will be paid 
properly during payroll entry. Rather than enter time tickets one at a time, she 
can use the weekly time sheet in the Time Tickets window to enter all the 
tickets at once.
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1 With the Time Tickets window still open and Judy White’s employee ID still 
displayed, select the Weekly tab.

All of Judy’s previous time tickets entered for the week display including 
the time ticket she just entered for the graphic design work. So far, her 
time tickets total 20 hours.

Displaying Time Ticket Detail in the Weekly Time Sheet

The weekly time sheet is used to display time tickets for a selected 
employee or vendor for the week chosen. You can enter or maintain a 
number of tickets all at one time within this window. However, you 
should notice that not all the ticket information appears in the weekly 
time sheet. You can display the time ticket detail, if needed, by selecting 
the Daily tab.

2 Select the 4.5 hour graphic design duration under the Friday (1/14) column.

This should be the fourth row from the top.

3 With the 4.5 hour duration selected, Click the Daily tab once again. The 
time ticket detail we just entered appears.

You can use this method to enter memos, run a timer to clock activities 
rather than manually entering a duration, or delete the ticket (if the 
ticket is not used).

The time ticket we
just entered appears

in Judy’s weekly
time sheet.
196



Lesson X—Time & Billing
Recording Time Tickets
4 Select the Weekly tab to return to the time sheet.

For this example, we will say that Judy also helped out with bookkeeping 
and administrative duties in our company’s front office. This 
administrative time needs to be recorded for the week.

Entering Administrative Time Tickets for the Week

5 Make sure the Week Including date displays January 14, 2000 (today for 
our sample company).

6 Select the Add button to add a new row to the weekly time sheet.

7 In the Activity Item field of the new row, enter or select BOOK1 
(Bookkeeping/Administrative) and press e to move to the Customer/
Job/Administrative column.

8 Select Administrative since the bookkeeping activity is performed for our 
company itself. Press e to move to the Pay Level column.

Since this activity is not for a customer or job, the Customer ID/Job ID 
column is skipped.

9 Select the Regular pay level and press e to move to the Billing Status 
column.

The Billing Type and Rate columns are not used on administrative 
tickets.

10 Press e to accept the Non-Billable billing status. 

Peachtree automatically assigns all administrative tickets the non-
billable billing status.

You can enter the week’s worth of administrative bookkeeping tickets for 
our employee. Durations are entered on the weekly time sheet in 
decimal format. For example, 4.5 represents 4 hours and 30 minutes.

11 Enter the following durations:

M
1/10

T
1/11

W
1/12

Th
1/13

F
1/14

5.50 2.5 4.5 4.0 2.0
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The weekly time sheet should look similar to the following:

12 Select Save to record the durations.

Each of the daily durations we just entered are saved as individual time 
tickets. The weekly time sheet totals indicate that Judy now has 38.50 
hours recorded for the week. 

13 Press q to close the Time Tickets window.

Recording Expense Tickets

Expense tickets track the use of company resources on behalf of a customer or 
job. Expense tickets can also be recorded internally for administrative 
purposes. Billable expense tickets for a customer or job can later be applied to 
customer invoices. Examples of items that can be recorded on expense tickets 
include:

• expenses of copying, printing, or faxing documents

• travel and meal expenses

• expert advice

• court fees

Entering Billable Expense Tickets

Continuing with our example, the theater wants us to design a cover letter and 
a subscription form. They want 1000 copies of the letter and 1500 copies of 
the subscription form printed. Judy needs to enter billable expense tickets to 
record this service.

First, Judy makes 1000 copies of the cover letter. 
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1 From the Tasks menu, select Time/Expense, and then Expense Tickets.

The Expense Tickets window is similar to the Time Tickets window 
except that it uses charge items rather than activity items. 

2 Select Employee as the type for this expense ticket and press e.

3 Enter or select JW01 (Judy White) from the employee ID lookup list.

A ticket number is automatically assigned by Peachtree. 

4 Judy is recording the ticket today, January 14, 2000. The ticket date already 
states this for us. (If not, enter the date accordingly.) Press e to move to 
the Charge Item field.

Charge items are set up in Maintain Inventory Items. These items are 
recorded by an employee or vendor when company resources are used 
for a customer or job. Charge items are also used to record 
administrative expenses within the company and even employee out-of-
pocket expenses. Billable charge items can later be written up and 
applied to customer invoices.

5 Enter or select COPY01 (Copies - 1:1 Standard) from the Charge Item 
lookup list and press e.

She is making single-sided copies of the cover letter.

Tickets can be recorded for customers, for jobs, or for administrative 
purposes. You would select Administrative if this ticket was recorded for 
internal use by your company, (for example, meals or parking expenses). 
Our example demonstrates a billable expense ticket for a job.
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6 Select Job, and then press e.

7 Click the lookup button in the Job field. The Job ID lookup list appears.

8 Double-click the CHER01-1 (CCT New Season Brochure) job folder. 

9 Double-click the 04-Printing phase folder, and then double-click 010- Labor 
cost code. You return to the Expense Tickets window.

10 Since this expense is company-paid rather than employee-paid, do not 
select the Reimbursable to Employee check box. Press e to move to the 
Ticket Description for Invoicing field.

11 In the Ticket Description for Invoicing field, type: Copies: Cover Letter.

12 In the Internal Memo field, type: Printed 1000 standard single-sided 
copies of cover letter. Instructed to keep master document on file 
for future printings.

Like time tickets, expense ticket internal memos are for internal use only 
and can help provide detail regarding the item recorded. Memos can 
display in reports, but will not display or print on the customer’s sales 
invoice.

Next, we need to enter billing information for the expense ticket.

13 Type 1000 in the Quantity field and press e to move to the Unit Price 
field.

14 Accept 0.12 as the unit price and press e to move to the Billing Status 
field.

15 Select Billable as the billing status and press e.

The Billing Amount is calculated for us and displays $120.00.

16 Select Save to record the expense ticket.

Entering a Second Billable Expense Ticket

Next, Judy makes 1500 color copies of a subscription form. She needs to enter 
a second billable expense ticket.

1 With the Expense Tickets window still open and Judy White’s employee ID 
displayed, make sure the ticket date is January 14, 2000.

A ticket number is automatically assigned by Peachtree. 

2 Enter or select COPY04 (Copies - 1:2 Color) from the Charge Item lookup 
list and press e.

She is making double-sided color copies of the subscription form.
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3 Select Job, and then press e.

4 Click the lookup button in the Job field. The Job ID lookup list appears.

5 Double-click the CHER01-1 (CCT New Season Brochure) job folder. 

6 Double-click the 04-Printing phase folder, and then double-click 010- Labor 
cost code. You return to the Expense Tickets window.

7 Type the following ticket description: Copies: Subscription Form.

8 Type the following internal memo: Printed 1500 color double-sided 
copies of subscription form. Instructed to keep master document on 
file for future printings.

9 Type 1500 in the Quantity field and press e to move to the Unit Price 
field.

10 Accept 0.90 as the unit price and press e to move to the Billing Status 
field.

11 Select Billable as the billing status and press e.

The Billing Amount is calculated for us and displays $1350.00.

12 Select Save to record the expense ticket.

Neither of the expense tickets create General Ledger entries. They are solely 
used to track expense items that the customer should be billed for at a later 
time. 

Entering a Non-Billable Expense Ticket

Because Cherokee Community Theater is a long-time customer, Judy takes 
the theater president out to lunch. She pays for the cost of the lunch out-of-
pocket.

1 With the Expense Tickets window open and Judy White’s employee ID 
displayed, make sure the date is January 14, 2000.

2 Enter or select MEAL01 (Meals) from the Charge Item lookup list.

3 Select Customer, and then enter or select CHER01 (Cherokee Community 
Theater) from the customer ID lookup list. 
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4 Select the Reimbursable to Employee check box.

This is an out-of-pocket expense for our employee. The company should 
reimburse her for the cost of the meal.

Skip the Ticket Description for Invoicing field since this is a non-billable 
expense.

5 Select the Internal Memo field and type the following: Lunch at the Red 
Tomato Cafe with CCT Theater President.

6 Select Non-Billable as the billing status and press e.

7 Enter the cost of the meal as 52.95 in the Billing Amount field.

8 Select Save to record the expense ticket.

This non-billable expense ticket does not create a General Ledger entry. 
However, it can be used for report purposes. When we pay the employee 
back, the expense will be posted to the General Ledger.

Entering a Reimbursable Expense

Judy arranges for an outside printer to print 1500 color copies of the brochure 
for our customer (a job that we cannot do internally). She pays the printer 
with a company check for $1875.00 (1500 brochures at $1.25 each).

The best business practice here would be to record this as a reimbursable 
expense recorded on a disbursement check in accounts payable (rather than 
as an expense ticket item for the customer). We’ll get to this shortly.

Time and expense tickets are records that never impact the General Ledger. 
Reimbursable expenses are accounts payable, payroll, and General Journal 
transactions associated with jobs, which could affect inventory cost of sales.

Using Time and Expense Tickets

So far, no accounting (General Ledger) entries have been entered in Peachtree 
Accounting as a result of entering time and expense ticket records. The 
accounting tasks before us are:

• Pay our employee (payroll).

• Reimburse our employee for out-of-pocket expenses.

• Record the company check issued to the outside printer.

• Bill our customer for the work completed (time spent, expenses 
incurred, and charges we want to recover).

Let’s walk through these tasks in order.
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Pay Our Employee 

1 From the Tasks menu, select Payroll Entry. The Payroll Entry window 
appears.

2 Enter or select JW01 (Judy White) from the lookup list in the Employee ID 
field.

3 Make sure both the paycheck date and Pay Period End date are both 
January 14, 2000.

Judy’s payroll information appears for the current pay period.

The flag “Uses Time Ticket Hours” appears next to Judy’s employee ID. 
This phrase indicates that Judy is set up in Maintain Employees to be 
paid based on time-ticket hours. For more information on setting up 
employees and their payment methods, refer to the “Payroll” chapter of 
the User’s Guide.

The Regular pay level displays a total of 38.50 hours worked for the pay 
period. This is all the hours she recorded on time tickets during the 
payroll period.

Judy, a weekly
employee, has

recorded 38.50
hours for this pay

period.

This message
indicates that the

employee is set up
to be paid based on

recorded time-
ticket hours.
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You could change the total hours worked, if necessary. For example, if 
your employee inadvertently recorded 44 Regular time-ticket hours, you 
might change the pay levels to display 40 hours Regular and 4 hours 
Overtime. 

Note: If you change the hours worked for time-ticket employees, your Time/
Expense reports will not accurately reflect what was paid to your employee.

4 Select Post to record the paycheck and close the window.

For more information on entering paychecks, refer to the “Payroll” 
chapter of the User’s Guide.

Reimburse Our Employee for Out-of-Pocket Expenses

To assist Judy in preparing the official company-mandated expense report, 
she can print Peachtree’s Employee Reimbursable Expense report, which 
includes her tickets that have been marked to be reimbursed for the period in 
question. This report shows ticket dates, charge items, descriptions, and 
associations to customers or jobs. Our employee submits this report for 
approval and requests a payment for these out-of-pocket expenses. We can 
pay the employee either through payroll entry using a non-taxed payroll field 
or through accounts payable using an expense check.

Entering an Expense Check

In this example, we will create an expense check in the Payments window.

1 From the Tasks menu, select Payments. Peachtree displays the Payments 
window.

2 The cursor is located in the vendor ID field. Our employees are not set up as 
vendors, so we will enter Judy’s name directly in the Pay to the Order of 
field.

3 Select the Pay to the Order of button. The Pay To Address window appears.
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4 Type Judy White in the Name field. 

If this expense check was going to be mailed, you could enter her address 
here.

5 Select OK to return to the Payments window. 

6 Leave the check number blank.

7 Accept the date of January 14, 2000.

8 Skip to the first line item and enter or select MEAL01 (Meals) from the Item 
ID lookup list.

9 Remove the sample description displayed and type Client Lunch. Then, 
press e to move to the G/L Account field.

10 Enter or select account 71500 (Meals Expense).

11 Skip to the Amount field and enter 52.95 as the amount of the expense.

12 Select Post to record the check.

Normally you would print the check. For purposes of this tutorial, we 
will skip that process. 

For more information on entering payments in the Payments window, 
see “Payments” on page 101 or the “Accounts Payable” chapter in the 
User’s Guide.

Record the Company Check Issued to the Outside Printer

An outside printer needs to be paid for printing the color brochure for our 
customer. They sent us a bill for $1875.00. This expense is better handled 
through Peachtree Accounting’s reimbursable expense system (as discussed 
earlier), but requires that there is a job set up for the customer. 

1 With the Payments window still open and the check date set as January 14, 
2000, enter or select MATH01 (Mathers Printing) from the vendor ID 
lookup list.

2 Skip to the Description field of the first line item on the Apply to Expenses 
tab. Type Print #1500 CCT Season Brochure as the description and press 
e.

3 Enter or select 73000 (Outside Services Expense) as the G/L account, and 
then press e until you reach the Amount field. 

4 Enter the amount as 1875.00 and press e to move to the Job field.

5 Click the lookup button in the Job ID field. The Job lookup list appears.
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6 Double-click the CHER01-1 (CCT New Season Brochure) job folder. 

7 Double-click the 04-Printing phase folder, and then double-click 080-
Outside Print cost code. You return to the Payments window.

8 Select Post to record the payment, and then close the window.

This payment will be available as a reimbursable expense when creating 
a sales invoice for this customer.

Bill Our Customer for the Work Completed

Now that the work is completed and deliverable, we need to invoice Cherokee 
Community Theater. 

1 From the Tasks menu, select Sales/Invoicing. Peachtree displays the Sales/
Invoicing window.

2 Enter or select CHER01 (Cherokee Community Theater) from the Customer 
ID lookup list.

3 The date should display as January 14, 2000.

4 Select the Apply Tickets/Reimbursable Expenses button.

The Apply Time Tickets/Reimbursable Expenses window appears. All of 
the time and expense tickets entered earlier for this customer, as well as 
the reimbursable expense for the outside printing job, are listed here.

You can now choose which of the tickets or expenses to bill to the 
customer, whether to write the ticket amounts up or down, and how to 
consolidate these tickets and expenses to create a sales invoice line item. 
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5 Select the Time Tickets tab (if it is not already selected).

6 Make sure the “Use Ticket Description for Invoicing” check box is selected.

This option will insert the ticket description we entered earlier as the 
invoice line item description.

7 Select the Use check box for the graphic design ticket.

Since the billing rate was already set up and recorded, we will accept the 
invoice amount displayed ($292.50).
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8 Select the Expense Tickets tab.

Notice that our non-billable expense ticket for the employee out-of-
pocket lunch does not display.

In this window, you could select a series of tickets based on job, item, or 
date range. This can speed up data entry, if several tickets display for this 
customer.

9 Make sure the “Use Ticket Description for Invoicing” check box is selected.

10 Select the Use check box for both expense tickets.
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11 Select the Reimbursable Expenses tab.

Peachtree displays the $1875.00 payment transaction to Mathers 
Printers. It appears here because we associated the CHER01-1 job to our 
customer, Cherokee Community Theater.

12 Select the Use check box to apply the printing expense.

In order to record a profit from this item, we can write up the expense.

13 Select the Write Up button to display the Select Reimbursables to Write Up/
Down window.

In this window, you could select a series of reimbursable expenses based 
on job, item, or date range. In this case, we only have one item, so the All 
option should remain selected.
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14 Select the “Write lines up/down by percent” option. Next, enter a 
percentage of 20.0 and select OK.

You return to the Reimbursable Expenses tab. The reimbursable 
expense’s invoice amount has been written up from $1875.00 to 
$2250.00.

15 Select OK to return to the Sales/Invoicing window.

Four line items have been added to the invoice.

• graphic design hours

• copies expense for the letters and forms

• printer cost for the brochures

The invoice now looks similar to the following:

16 Select Post to record the customer invoice.

When the sales invoice is posted, a General Ledger entry is created 
debiting the appropriate accounts receivable account and crediting the 
appropriate revenue accounts. 
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What Happens Next?

Once the tickets or reimbursable expenses are applied to a sales invoice, 
they will no longer be available for creating a new sales invoice. If the 
customer ever calls to question an invoiced amount, the ticket and the 
reimbursable expense items used display as line items in the sales 
invoice. You can refer to reports for detailed information on all the 
tickets that have been applied to this particular invoice.

That’s it. Now you should have a basic understanding of how Peachtree 
uses Time & Billing to manage time and expenses, whether for a 
customer, for a job, or for administrative purposes.

Review of Lesson IX

Let’s review some of the things we learned in this lesson:

• Time & Billing is a process which uses time and expense tickets to 
track time spent on various activities and record the use of company 
resources on behalf of a customer or job. If you choose, recorded 
time tickets and expense tickets can later be billed to customers on 
sales invoices. If you use payroll, time tickets can be applied to an 
employee’s paycheck. Time & Billing can also be used to effectively 
manage administrative activities and overhead expenses for your 
business.

• Either employees or vendors (contract labor) can record time tickets 
and expense tickets.

• Time & Billing uses two special item classes in inventory: activity 
items (used in time tickets) and charge items (used in expense 
tickets).

• Activity items are used to explain what is being recorded on 
employee or vendor time tickets. These items indicate how time is 
spent when performing services for a customer, for a job, or for 
internal administrative work. Billable activity items can later be 
applied to customer invoices and even written up to record a profit.

• Charge items are expense items that are recorded by an employee or 
vendor when various services are performed for a customer or job. 
Charge items are also used to record administrative use of materials 
or resources within the company and even employee out-of-pocket 
expenses. Billable charge items can later be written up and applied to 
customer invoices.

• You can enter time-ticket durations manually or have Peachtree use a 
timer to actively clock the duration. You can only have one timer 
running on a computer or network workstation at one time.
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• There are two methods to entering and maintaining time tickets. You 
can enter individual time tickets using the Daily tab of the Time 
Tickets window. Or, you can enter or display a group of employee or 
vendor time tickets using the weekly time sheet (the Weekly tab of 
the Time Tickets window).

• You can apply recorded time tickets in payroll entry provided the 
hourly employee is set up to be paid based on time-ticket hours in 
Maintain Employees. The employee will be paid based on time 
tickets that were recorded during the selected payroll period.

• You can record employee out-of-pocket expenses by selecting the 
Reimbursable to Employee check box in the Expense Tickets 
window. This is recorded for report purposes only and is displayed in 
the Reimbursable Employee Expense report. If you want to pay the 
employee for the out-of-pocket expense, you can include the expense 
in a paycheck or print an accounts payable disbursement check.

• When you record time and expense tickets, no General Ledger 
transactions are created. However, transactions are posted in Payroll 
after applying time tickets to paychecks. Transactions are also posted 
to the Sales Journal when applying time and expense tickets to Sales/
Invoicing.

• You can only apply billable time or expense tickets one time in Sales/
Invoicing. You can select which tickets to use based on job, item, or 
date range. You can write up tickets and reimbursable expenses to 
record a profit. You can also consolidate tickets and reimbursable 
expenses so that they will display as single line items on the 
customer’s invoice. 

This concludes the written tutorials for Peachtree Accounting. If you need 
more assistance refer to the chapters throughout this manual or Peachtree 
Accounting’s online Help.
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• Converting Quicken Data to
   Peachtree Accounting •

You can import existing Quicken data into a new Peachtree Accounting 
company. The steps to convert data vary depending on whether you are using 
the DOS or Windows version of Quicken. Follow the instructions that are 
appropriate for the version of Quicken that you are using.

Understanding the Conversion Process

Converting from Quicken to Peachtree Accounting is a three-step process. 

1 Export all Quicken accounts into a separate directory.

2 Create a new company in Peachtree Accounting.

3 Import the Quicken exported files into the new Peachtree Accounting 
company.

During the conversion process, the information you have exported from 
Quicken is imported into Peachtree Accounting. Due to basic differences 
between the two programs, some of the Quicken data cannot be imported 
into Peachtree Accounting as it is. Rather, you must redefine how you want 
the data to be handled as part of the import program.

Differences between Quicken and Peachtree Accounting 

Understanding the basic program differences can help you decide how you 
want to redefine Quicken data. 

Peachtree Accounting is a full accounting program. It uses a chart of 
accounts to track transaction amounts. It requires that every transaction have 
an equal, balancing transaction. Peachtree Accounting automates this for you 
behind the scenes.

Quicken is a cash management program. It does not require that every 
transaction have an equal balancing transaction. It does not have a traditional 
chart of accounts. Rather, it considers most asset and liability accounts to be 
separate accounts while expense and income accounts are categories. You set 
up transactions for payees and track transaction amounts by classes as well as 
categories.

Overvie
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Converting from Quicken 99

You can import Quicken 99 and Quicken 99 Home & Business Edition data 
into a new Peachtree Accounting company. Both these new Quicken products 
use unique account types and data that may or may not convert properly. 
Peachtree Accounting only supports some of these new account types and 
data lists.

Peachtree Accounting can convert the following Quicken 99 accounts and 
data lists:

• bank accounts

• credit card accounts

• asset accounts

• liabilities (loans)

• income categories

• expense categories

• payees and classes

• 401(k) accounts

• investment and money market accounts 

• sales tax accounts

• invoicing/receivables accounts and invoice transactions

Quicken Peachtree Accounting

Accounts
Categories
Subcategories

General Ledger
Chart of Accounts

Payees
Classes

Vendors
Customers
Jobs
Employees
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Exporting Quicken Data

This section describes the process of exporting your Quicken data to a file 
format that can later be imported in Peachtree Accounting.

Preparing for the Quicken Export

Before you begin exporting Quicken data, complete these tasks to ensure that 
your Quicken information will convert to Peachtree Accounting as accurately 
as possible.

• remove duplicate payee and class names

• make sure the opening balance transaction is the first transaction in 
each account

• print Quicken checks

• print Quicken reports for comparison after conversion

Reviewing Payee and Class Names

Quicken allows you to have more than one name for the same payee or class. 
For example, in Quicken you may refer to the same payee as John Brown, 
John R. Brown, and J. R. Brown. 

Peachtree does not recognize multiple names for the same vendor, customer, 
job, or employee. So if you import Quicken data that has the same payee 
referred to by multiple names, Peachtree Accounting views each name as a 
separate entity. In this case, you have these choices:

• select only one during the import process and lose the history for the 
other two

• select all three during the import process, making two inactive so 
that they can be purged later

A better approach might be to review your payees and classes before you 
export and make the entries consistent.

Reviewing Accounts and Categories

You need to check every account to ensure that the opening balance 
transaction is the first transaction in the account. If the opening balance 
transaction is not the first transaction, the account name for the transferred 
account in Peachtree Accounting will not match Quicken’s account. 
216



Exporting Quicken Data
Creating a Directory for the Exported Files
You may also want to change your current Quicken account and category 
naming scheme to a traditional account number scheme. This way, you will 
be able to incorporate the Quicken accounts into one of the Peachtree 
Accounting sample charts of accounts. 

Use this procedure to display a sample list of various charts of accounts.

1 From the Peachtree Accounting Help menu, select Contents and Index.

2 In the Peachtree Accounting Help Topics window, select the Contents tab.

3 Click the Help for Your Business book and choose Sample Charts of 
Accounts. Then select a sample industry that closely matches your business 
type.

Printing Quicken Checks and Reports

If you have any unprinted checks, you should print them before exporting 
account data. Also, print a copy of the Quicken reports that you typically use 
to track your financial activity. You can use the reports to check the accuracy 
of your data after the conversion is complete.

Creating a Directory for the Exported Files

To export data from Quicken, you are going to create a separate directory, 
then export a separate file for each account into the directory you create. Plan 
to export every account that has at least one transaction, even if it’s an 
opening balance. If you don’t export every account, you will lose some 
accuracy in the Peachtree file when you import.

The steps you use to export data vary depending on whether you are using the 
MS-DOS or Windows version of Quicken. Follow the instructions that are 
appropriate for the version of Quicken you are using.

Before you export Quicken data, you must create a separate directory to hold 
only the exported Quicken files. If you are planning to export several accounts 
with many transactions, it is best to send the exported files to a directory on 
your hard disk because you might run out of space if you send the data to a 
floppy diskette. 

To create a directory from DOS

1 From the DOS prompt, type CD\ to reach the root drive, C:.

2 From the root drive prompt, type MD EXPORT.
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To create a directory from Windows 

1 Open Windows Explorer. Select Drive C. Then, from the File menu, select 
New Folder. 

2 Enter a directory name (for example, EXPORT), using up to eight 
characters. 

Exporting Data from the Windows Version of Quicken

You are going to export data one account at a time until you have exported all 
the accounts. Follow these instructions if you are exporting data from the 
Windows version of Quicken. See “Exporting Data from the MS-DOS version 
of Quicken” on page 219 for instructions on how to export from Quicken for 
DOS.

Many versions of Quicken exist. These guidelines for exporting are general. 
Depending on your version, the steps you need may vary.

1 Do one of the following:

• If converting from Quicken 99, from the File menu, select 
Export.

• If converting from another version of Quicken, open the account 
you want to export data from. Then, from the File menu, select 
Export.

2 In the QIF File to Export to field, enter the name of the directory you created 
earlier since Quicken defaults to its own directory, \QUICKENW. For 
example, if you created a directory called EXPORT, the directory should be 
C:\EXPORT.

3 In the same field, do one of the following:

• If converting from Quicken 99, enter the name of the export file.

• If converting from another version of Quicken, enter a name for 
one of the account files you intend to export.

The name can be any combination of up to eight characters. Quicken 
appends the file with a QIF extension (for example, CHECKING.QIF).
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4 In the “Quicken Account to Export from” field, do one of the following:

• If converting from Quicken 99, select All Accounts.

• If converting from another version of Quicken, select the account 
you want to export now.

You will not see income and expense accounts in this list because 
Quicken exports this data automatically as categories when it exports 
transaction data for each account.

5  Enter a date range for the transactions to be included in the exported data.

Normally you would accept the default date range to export all data for 
the account.

6 Check all the export items you want to include.

A typical selection is transactions, accounts list, and category list.

 If you choose to export only transactions for all accounts, the resulting QIF 
file will always contain the Quicken account list.

7 Select OK to export the account data to a text file.

8 If converting from a version of Quicken other than Quicken 99, repeat 
these steps for each account until you have exported all the accounts.

Exporting Data from the MS-DOS version of Quicken

You are going to export data one account at a time. Follow these instructions 
if you are exporting data from Quicken for DOS. 

1 Open the account you want to export data from.

2 Open the register or Write Checks window for the account you select.

3 From the Print/Acct menu, select Export. 

4 Select a separate DOS File name for each exported account file.

The name can be any combination of up to eight characters. Because you 
will be importing the file into Peachtree Accounting, you must append 
the file with a QIF extension.

For example, to create an export file called CHECKING in the directory 
you created earlier, type C:\EXPORT\CHECKING.QIF.

Note
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5 Enter a range of dates in Export Transactions from...to... for the 
transactions you want to export from the account.

If you want to ensure that you include all possible transactions, leave the 
default for the from date and set the future date (the to date) a year or so 
after today’s date.

6 Enter a Y in Export Transactions for each account.

7 Enter Y in Export Categories and Classes for the first account, N for 
subsequent accounts since you use the same categories and classes for all 
your accounts.

8 Enter Y in Export Accounts for each account because you must export the 
account list for every account.

9 Select N in Export Memorized Transactions for each account because this 
data is not converted.

10 Press e to begin exporting the account data.

11 Repeat these steps for each account until you have exported every account. 

Checking What You’ve Exported

Even though you have exported data from each account in a separate file, you 
are going to import data for all exported accounts at once. Do not begin the 
import process until you have all account data in a single, otherwise-empty 
directory, as all files in that directory are read during the import process. You 
also might want to make a list of each exported file, and the account it 
represents.
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Create a New Company in Peachtree Accounting

Before you can import Quicken data, you must set up a new company in 
Peachtree Accounting. This section only describes those areas of setting up a 
company that are unique to converting from Quicken. Refer to Chapter 1, 
“Creating a Company” of the User’s Guide for more detail.

1 If you haven’t already installed Peachtree Accounting, please do so now.

For more information, see “Installing Peachtree Accounting” on page 5.

2 Start Peachtree Accounting.

3 If Peachtree Accounting displays the Startup screen, select “Set up a new 
company.” If you already have a company open, select New Company from 
the File menu.

Setting Up a New Company

The New Company Setup wizard walks you through setting up a new 
company.

1 On the New Company Setup - Introduction window, click the Next button.

2 On the New Company Setup - Company Information window, enter the 
company information and click the Next button.

3 On the New Company Setup - Chart of Accounts window, choose the 
Convert a company from another accounting program option and 
click the Next button.

This supplies you with a blank chart of accounts, because your Quicken 
categories and subcategories are going to be imported as accounts.

4 On the New Company Setup - Accounting Method window, select the 
accounting method and select Next.

Quicken uses the accrual method for credit card accounts and the cash 
method for all other types of accounts. Be sure that you choose the 
correct accounting method as it cannot be changed once you create the 
company.

5 On the New Company Setup - Posting Method window, select the Batch 
posting method and select Next.

Since you can change your company’s posting method at any time 
without affecting your records, select Batch posting until the import 
process is done, then change it to Real-Time posting, if you like. This 
will make the import process go more quickly.
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6 On the New Company Setup - Accounting Periods window, select one of 
the following and select Next.

• 12 monthly accounting periods

• Accounting periods that do not match calendar months.

In Quicken, you don’t close a period or fiscal year, so you have access to 
all the transactions you have ever entered. In Peachtree Accounting, you 
can have up to two fiscal years open, which means you can access only 
transactions in these open periods. When you enter the first accounting 
period, the program recalculates the remaining periods. The accounting 
period you set up needs to correspond with the time period of your 
Quicken data so you can access the data when you start Peachtree 
Accounting. Make sure your accounting periods are correct because you 
cannot change them after you leave this window.

7 Do one of the following:

• If you selected 12 monthly accounting periods, complete the 
monthly accounting periods information and click the Next 
button.

• If you selected Accounting periods that do not match calendar 
months, complete the custom accounting periods information 
and select Next.

In this step, among other things, you specify the first month or period in 
which you will be entering data. This is usually the period that 
corresponds to the current month. However, since you are importing 
Quicken data, the first period in which you enter data is 1, to correspond 
to the beginning of the first accounting year. So you can return to 
previous periods, if necessary, to clean up your data after you import.

You also specify the first year in which you will be entering data. This is 
usually the current fiscal year. However, since you are importing, you 
might want to enter the previous fiscal year so you can have access to 
previous transactions.

8 On the New Company Setup - Finish window click the Finish button. 

Peachtree will set up your company based on the options you just chose.
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Completing Setup

Deleting Default Information

There can be no Default Link Accounts, or accounts in your chart of accounts, 
when importing Quicken information. Make sure that between creating your 
company and importing the Quicken data, no accounts are entered. If you 
just set up a new company using the New Company Setup wizard as described 
in the previous section, this is already done for you.

➤ To check for Default Link Accounts, select Default Information from the 
Maintain menu. Then check Customers, Vendors, Employees, Inventory 
Items, and General Ledger. (The Link Accounts are on the first folder tab.) 
There should be no default accounts defined.

➤ To check for General Ledger accounts, select Chart of Accounts from the 
Maintain menu. Click the lookup button; the list should be empty.

Make a Backup

Before you begin importing, we strongly suggest that you make a backup of 
the company you have just created. This way, you will not have to start from 
scratch if the Quicken information does not import properly.

➤ To back up your company data, select Back Up from the Peachtree 
Accounting File menu. For detailed instructions, refer to the “Company 
Administration” chapter of the User’s Guide.
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Importing Quicken Data

If you have exported your Quicken data and set up a new company in 
Peachtree Accounting, you are ready to import Quicken data. If not, please 
complete these steps before you continue.

Before the Quicken data is actually imported, you must define how you would 
like the Quicken data to be interpreted by Peachtree Accounting. The 
Peachtree Accounting import program allows you to

• set up a chart of accounts that corresponds to Quicken accounts and 
categories

• set up IDs for vendors, customers, jobs, and employees that 
correspond to Quicken payee and class names

Initially, the import program makes assumptions about how you want the 
Quicken data to be imported into Peachtree Accounting and assigns defaults 
based on these assumptions. The windows that appear during the import 
process give you an opportunity to identify and verify the data before the 
Quicken transactions are actually imported in case the defaults aren’t correct. 

Stepping Through the Quicken Import Process

Follow these steps to begin importing Quicken data into Peachtree 
Accounting.

1 Start Peachtree Accounting. 

2 Open the company you created in second section of this appendix. 

3 From the File menu, choose Select Import/Export.

Quicken Account Peachtree Account
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4 Select the All Files import type and choose Quicken.

5 Select the Import button.

Peachtree displays the Import a File window.

6 Enter the path name (directory) where the exported Quicken file(s) are 
located.

This is the directory name, not each file name; for example, C:\EXPORT. 
All files in the directory with a *.QIF extension will be imported.

7 Select OK to begin the import process.

Converting Quicken Accounts and Categories

The first two windows that display after you begin the import process allow 
you to define the chart of accounts in Peachtree Accounting for the Quicken 
accounts, categories, and subcategories. In the first window, you are verifying 
that the import program shows the correct account data for each exported 
Quicken file. In the second window, you are creating accounts for Quicken 
accounts, categories, and subcategories.

Quicken Account Peachtree Account
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Selecting Quicken Accounts to Convert (Part 1 of 6)

1 Begin the Quicken import process (as described in the previous section) 
until Peachtree displays the Quicken Import - Part 1 of 6 window.

You use this window to tell Peachtree where to direct your Quicken 
accounts. There are three columns: File Name, Quicken Account, and 
Peachtree Account.

• File Name: Identifies the name of the Quicken export (QIF) file that 
contains the Quicken account information.

• Quicken Account: Identifies the name of the Quicken account listed 
in the export file.

• Peachtree Account: Specifies the suggested Peachtree Accounting 
name of the Quicken account. The Peachtree Accounting account 
name defaults to the Quicken account name (up to the first 10 
characters). This is where you enter the account ID (account 
number) of the corresponding account in Peachtree Accounting. It is 
strongly recommended that you use numeric account IDs. (For 
example, enter 10200 for your regular checking account. Later you 
can add a description for the account.)

At this point you should already have your chart of accounts for 
Peachtree Accounting planned. For more information about account 
IDs, read the next section. If you are not ready to continue, select the 
Cancel button and see “Preparing for the Quicken Export” on page 216.

2 Make sure that each account is represented accurately. If a Peachtree 
account ID is not correct, you must change it here before you continue. To 
change a Peachtree account name, select the suggested Peachtree account 
name text and type over it. 

3 When you have finished entering Peachtree account IDs for each Quicken 
account, select the Continue button to move to the next step in the 
Quicken import process.

Quicken Account Peachtree Account
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Understanding Peachtree Account IDs

The import program attempts to use the original Quicken account name as 
the account ID in Peachtree Accounting, if it can. Since Quicken allows more 
characters for account IDs than Peachtree, some of your account IDs will be 
shortened.

The import program initially assigns an ID to each account using these 
naming conventions.

Check the Peachtree account ID carefully. If you want to merge accounts, 
duplicate them manually. For example, if you want to merge Carpet Cleaning 
and Food Groceries into one account called Home Expense, change each of 
these account IDs to Home Expense. Of course, you will only merge accounts 
of the same type.

Advantages of Using a Numeric Account Number

If you haven’t already converted the Quicken accounts and categories to a 
numeric naming convention, you might want to consider doing so now. 
Although Peachtree Accounting allows 15 alphanumeric characters for 
account numbers, it also adheres to the accounting standard of a numeric 
chart of accounts in its sample data.

For more information on how to set up your chart of accounts in Peachtree 
Accounting, refer to Chapter 1, “Creating a Company” in the User’s Guide for 
conventions in naming accounts and for information about masking.

# # # # # # # # # #

# # # # # # : # # # #

For Quicken accounts and categories without 
subcategories, the first ten characters of the 
account become the Peachtree account IDs.

For Quicken categories and subcategories 
with subcategories, the accounts are derived 
from:

The first four characters of the subcategory

The first six characters of the category
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Selecting Quicken Categories to Convert (Part 2 of 6)

1 Select the Continue button until Peachtree displays the Quicken Import - 
Part 2 of 6 window.

Peachtree displays a list of Quicken accounts and categories, the default 
Peachtree account IDs, and their default account types.

2 Select the account you want to change by clicking it in the list box.

3 To change the Peachtree account ID, select (highlight) the existing text in 
the New Account ID field and type over it.

You can modify the Peachtree account ID, but you cannot add or delete 
it. It’s important to make your changes now as account IDs cannot be 
modified after they are imported into Peachtree Accounting. 

4 To change the Peachtree account type, select an account type from the 
drop-down list.

Quicken Category New Acct ID Peachtree Acct Type
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The import program assigns these default account types when 
converting Quicken accounts and categories to Peachtree Accounting 
accounts.

You can modify the default account type, but you cannot add or delete 
accounts. It’s important that you make your changes before you 
continue. You want your account types to be set up properly before you 
begin processing.

Refer to the “General Ledger” chapter in the User’s Guide for a list and 
descriptions of the Peachtree account types.

5 Select Save to record your changes for the account.

6 After changing the accounts as appropriate, select the Continue button to 
move to the next step in the Quicken import process.

Quicken Peachtree Accounting

Bank and Money Market Accounts Cash

Credit Card Accounts Accounts Payable

Other Assets Fixed Assets

Other Liabilities Long Term Liabilities

401(k) and Investments Other Assets

Customer Invoice Accounts Accounts Receivable

Sales Tax Accounts Other Current Liabilities

Income Categories Income if Quicken for DOS
Expense if Quicken for Windows

Expense Categories Expense

Unassigned amounts Equity - Retained Earnings
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Converting Quicken Payee and Class Names

Quicken has two types of data remaining that you must identify in Peachtree 
Accounting before beginning to import Quicken transactions. They are:

• Payee names

• Class names

In Quicken, payees can be anybody you write a check to or receive a deposit 
from, including vendors, customers, and employees. The next part of the 
import process asks you to define which of the Quicken payees are to become 
vendors, which are to become customers, and which are to become employees 
in Peachtree Accounting.

Classes are attached to transactions in Quicken like jobs in Peachtree 
Accounting. You can track income and expenses by the job, project, 
customer, region, location, or any grouping you choose. For this reason, you 
may want to define classes as vendors, customers, or jobs when you import.

How Payee and Class Names are Converted

The import program displays the payee and class names so that you can 
identify which ones are vendors, customers, jobs, or employees. 

The import program also assigns an eight-character code to each payee and 
class using this naming convention:

You cannot change the code that Peachtree assigns. If you don’t assign a payee 
or class, the transaction will still be imported into Peachtree and tracked—it 
just won’t be categorized as belonging to a vendor, customer, job, or 
employee.

The windows you see during the import process depend on your Quicken 
data and how you identify it in Peachtree. You may not see every window as 
the import program continues. For example, if you don’t have classes in 
Quicken, the window where you identify jobs won’t be displayed.

X X X   X   # # # # The default Peachtree eight-character ID for 
Quicken payees and classes is derived from:

A four digit sequential number

The first character of the second name

The first three characters of the first name
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Converting Quicken Payees to Peachtree Vendors (Part 3 of 6)

1 Select the Continue button until Peachtree displays the Quicken Import - 
Part 3 of 6 window.

Peachtree lists all the Quicken payees who were associated with checking 
transactions with negative amounts. Initially, all the payees in the list are 
selected as vendors (an X appears next to their name) and all classes are 
not selected.

2 Review the vendor list. 

If you have entered a payee’s name differently in Quicken, each unique 
variation will become a Peachtree vendor.

3 Double-click to remove the X from those entries that are not vendors. 

Make sure that payees who represent these types of accounts are not 
selected (there should not be an X next to them):

• Withdrawal

• Opening balance

• Service charge

• Balance adjustment

• Credit card

4 When you have verified each vendor, select the Continue button to move 
to the next step in the Quicken import process.
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Converting Quicken Payees to Peachtree Customers (Part 4 of 6)

1 Select the Continue button until Peachtree displays the Quicken Import - 
Part 4 of 6 window.

Peachtree lists all the Quicken payees who were associated with checking 
transactions with positive amounts and all classes that were not selected 
previously. Initially, all the payees in the list are not selected as 
customers.

2 Review the customer list.

If you have entered a payee’s name differently in Quicken, each unique 
variation will become a Peachtree customer.

3 Double-click each payee or class that you want to become a customer. If 
you change your mind, double-click again to remove the X. 

4 When you have verified every customer, select the Continue button to 
move to the next step in the Quicken import process.
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Converting Quicken Classes to Peachtree Jobs (Part 5 of 6)

In Peachtree Accounting you can track jobs including reimbursable expenses 
and revenue. Jobs can be company- or customer-related projects. Many of 
Quicken’s classes could be converted to Peachtree Accounting jobs.

1 Select the Continue button until Peachtree displays the Quicken Import - 
Part 5 of 6 window.

Peachtree lists all the remaining classes that have not been chosen as 
either vendors or customers. Initially, all the classes in the list are not 
selected as jobs.

2 Review the job list.

3 Double-click each class that you want to become a job. If you change your 
mind, double-click again to remove the X.

4 When you have verified every valid job, select the Continue button to move 
to the next step in the Quicken import process.
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Converting Quicken Payees to Peachtree Employees (Part 6 of 6)

1 Select the Continue button until Peachtree displays the Quicken Import - 
Part 6 of 6 window.

Peachtree lists all the remaining payees who were not chosen as vendors 
and were associated with negative checking transactions. Initially, all the 
payees in the list are not selected as employees.

2 Review the employee list.

3 Double-click each remaining payee that you want to become an employee. 
If you change your mind, double-click again to remove the X. 

4 When you have verified every employee, select the Continue button to 
move to the next step in the Quicken import process.

Once you have identified all the payees and classes that are to become 
vendors, customers, jobs, or employees, the import program begins 
importing the Quicken transactions. The length of time required to 
complete the import process depends on the quantity of transactions 
you are importing. 
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Balancing Transactions

In Peachtree Accounting, transactions must be balanced with debits and 
credits. This is not required in Quicken. Because of this difference, it may be 
necessary for the import program to create balancing transactions (debits 
equal credits) from sometimes one-sided Quicken transactions.

For example, in Quicken it is possible to write a check without assigning a 
category. In Quicken for Windows, the transaction is unassigned everywhere 
except on the Balance Sheet where it is assigned to a category called Equity. In 
Peachtree Accounting, this transaction is considered unbalanced. For this 
transaction, the import program will import the check, which becomes a 
credit to the bank account. It will also create a balancing debit transaction in 
the equity/retained earnings account, thus balancing the transaction. 

What to Do After Importing

When the import process is complete, you still have some setup work to do. 
Specifically, you must:

• Set up the necessary accounts in your chart of accounts

• Set up sales tax information

• Identify unnumbered payment transactions

• Post transactions

• Check the results

• Optionally, change to real-time posting

• Get to know Peachtree Accounting
235



Converting Quicken Data to Peachtree Accounting
Getting Started GuideA
Setting Up Necessary Accounts

Because Peachtree Accounting uses a full chart of accounts, there are some 
accounts you must set up that you may not have set up in Quicken. The 
accounts required to use each of these features in Peachtree Accounting are 
shown in the following table:

All of these accounts must be set up in your chart of accounts (COA). 
Additionally, some of the accounts must be set up as defaults (DEF). Refer to 
the list to see which accounts must be set up as defaults. Follow these steps to 
set up the necessary accounts.

Feature Account Description COA DEF

Customers Accounts Receivable (accrual method)
Cash Received
Discounts Allowed
Sales Tax Payable
Interest Income from finance charges

✓
✓
✓
✓
✓

✓

✓

Vendors Accounts Payable (accrual method)
Cash Disbursed
Discounts Taken

✓
✓
✓ ✓

Employees Cash Account
Gross Pay Account
Tax Liability Account
Tax Expense Account

✓
✓
✓
✓

✓
✓
✓

General Ledger Retained Earnings 
Rounding (if desired)

✓
✓ ✓

Inventory Inventory Sales Revenue
Inventory
Cost of Sales

✓
✓
✓
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Set Up Accounts in Your Chart of Accounts

1 From the Maintain menu, select Chart of Accounts.

Peachtree displays the Maintain Chart of Accounts window.

2 Enter any accounts from the list that are not in your chart of accounts and 
select Save.

Peachtree requires that you include one account with the “Equity-
Retained Earnings” account type in your chart of accounts before 
posting any transactions. If this type of account was not imported, you 
must set one up now. The retained earnings account also used when 
balancing financial statements, such as the Balance Sheet. If you do not 
have a retained earnings account, you will receive various errors and be 
out of balance.

Refer to User’s Guide for more information on setting up accounts.

3 When you have finished entering and saving the necessary accounts, close 
the window.

Set Up Default Accounts for Your Customers

1 From the Maintain menu, select Default Information, then Customers.

Peachtree displays the Customer Defaults window.

2 Select the Payment Terms tab and choose the default G/L sales (income) 
and G/L discount (income) accounts.

3 Select the Finance Charges tab and choose the G/L finance charge (income) 
account. 

4 Select OK to save your defaults and close the window.

5 From the Maintain menu, select Customers/Prospects.

Peachtree displays the Maintain Customers/Prospects window.

6 Select the Sales Defaults tab.

7 Enter or select a customer ID and choose a default G/L sales (income) 
account, if it is different from the company default. Then save the 
customer. Repeat this step for each of your customers, if necessary.
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Set Up Default Accounts for Your Vendors

1 From the Maintain menu, select Default Information, then Vendors.

Peachtree displays the Vendor Defaults window.

2 Select the Payment Terms tab and choose the default G/L purchase 
(expense) and G/L discount (expense) accounts.

3 Select OK to save your defaults and close the window.

4 From the Maintain menu, select Vendors.

Peachtree displays the Maintain Vendors window.

5 Select the Purchase Defaults tab.

6 Enter or select a vendor ID and choose a default G/L purchase (expense) 
account, if it is different from the company default. Then save the vendor. 
Repeat this step for each of your vendors, if necessary.

Set Up Payroll Default Accounts

1 From the Maintain menu, select Default Information, then Employees.

Peachtree displays the Payroll Setup wizard.

2 From the Payroll Setup Wizard window, select Next.

3 Complete the initial payroll setup information and select Next.

4 From the lists on the Default Payroll G/L Accounts window, select the Gross 
Pay, Tax Liability, and Tax Expense accounts as appropriate and select Next.

5 Continue working with the Payroll Setup wizard as appropriate.

For more information on using the Payroll Setup wizard and setting up 
payroll and employees, refer to the “Payroll” chapter of the User’s Guide.
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Setting Up Sales Tax Information

You need to set up sales tax information before entering sales transactions to 
your customers. Peachtree Accounting uses sales tax authorities for tracking 
revenue from sales tax. You can associate appropriate sales tax codes that you 
set up (a combination of one or more sales tax authorities) with your 
customers. For more information on setting up sales tax information, refer to 
the “Accounts Receivable” chapter of the User’s Guide.

If you are converting from Quicken Home & Business Edition, the sales tax 
accounts are added to your Peachtree Accounting chart of accounts. 
However, you still must set up Peachtree Accounting sales tax authorities that 
will use your sale tax payable account that was converted from Quicken.

Identify Unnumbered Payment Transactions

If your Quicken data included service charges and balance adjustment 
transactions without reference numbers, you will be prompted to post 
and/or print them as checks when you change to a new accounting period in 
Peachtree Accounting. This is because Peachtree thinks these transactions are 
unprinted checks.

Follow these steps to correct this situation.

1 From the Tasks menu, select Payments.

Peachtree displays the Payments window.

2 From the Payments window, select the Edit button.

3 When the Select Payment window is displayed, select Both from the Status 
drop-down list and All Transactions from the Show drop-down list.

Peachtree displays a list of all your payment transactions. You should 
edit any transactions without reference numbers.

4 Select the first transaction without a reference number from the list.

5 From the Payment window, enter a value such as the check number for the 
transaction and save the payment.

Use a numbering scheme that identifies the transaction such as SC1 for a 
service charge or BA1 for a balance adjustment.

6 Select the Edit button and repeat these steps until all unnumbered payment 
transactions have a reference number.
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Posting Transactions

Since you are using the Batch posting method, you must post the transactions 
manually. Follow these steps:

1 From the Tasks menu, select System, then Post.

Peachtree displays the Post window.

If you chose the Real-Time posting method during New Company 
Setup, this menu option will not be available.

2 Select the All Journals option and click OK.

Changing the Posting Method

Before you actually begin entering new transactions in Peachtree Accounting, 
it is recommended that you change to the Real-Time posting method. Most 
companies use this method because transactions are posted to the General 
Ledger as they are recorded in the program.

Use this procedure to change your posting method, if desired.

1 From the Maintain menu, select Company Information.

Peachtree displays the Maintain Company Information window.

2 Select the lookup button to the right of Posting Method.

3 Select the Real-time posting option and click OK.

All transactions that were not previously posted are posted.

Checking the Results

To ensure that the data from Quicken has been imported accurately into 
Peachtree Accounting, we suggest that you print these reports for comparison 
to the Quicken reports you printed prior to exporting the data.

• Year end G/L Report (shows all activity for all accounts)

• Income Statement (current)

• Balance Sheet (current)

• Chart of Accounts list

Getting Acquainted 

To get acquainted with Peachtree Accounting, you can view the Peachtree 
Accounting tutorial, available from the Help menu. For a more hands-on 
approach, you can work through the written tutorial in this book.
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Troubleshooting the Quicken Conversion

Below are frequently asked questions that may help you resolve errors when 
starting or working with Peachtree Accounting.

Frequently Asked Questions

The following section lists common questions that occur when importing 
Quicken data into Peachtree Accounting.

What is converted from Quicken?

All transactions are converted for the date range you selected. You should 
convert all transactions in Quicken for the most accurate conversion.

Categories and subcategories are converted as individual accounts in 
Peachtree Accounting. If you want to report them as you did in Quicken (roll 
up subcategories into categories), you should refer to the “Creating a 
Company” chapter of the User’s Guide for information about masking.

You will have the opportunity to convert anyone to whom you wrote a check 
into a vendor or employee, and anyone from whom you received money into 
a customer.

How long will conversion take?

The length of the conversion process depends on how many transactions you 
have in Quicken. If there aren’t many (100,000 bytes or less), it will probably 
take 30-45 minutes. But if you have many transactions (indicated by file size), 
it could take several hours.

Where are my categories listed when I do the export from 
Quicken?

Even though Quicken doesn’t show your categories as separate files, they are 
there. Your Quicken categories are included in your accounts.
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When setting up my company in Peachtree, what should my first 
accounting period be?

In Quicken, it is never necessary to “close” a period. In fact, there is no way to 
close, so all the transactions you ever entered into Quicken are accessible. In 
Peachtree, you can have two years or 24 periods open, meaning that you can 
access (display) the transactions in these periods.

Any transaction entered in Quicken prior to the date you enter as your first 
accounting period will not be accessible in Peachtree. Generally, this first date 
should be the beginning of your current fiscal year, for example, January 1, 
2000. But if you want access to previous transactions, it might be the 
beginning of the previous fiscal year.

No Quicken transactions that you made prior to the first Peachtree 
accounting period you enter will be accessible in Peachtree Accounting. For 
example, if you have a service charge in November 1998, but enter your first 
accounting period as January 1, 1999, you can’t edit that service charge 
transaction.

What should be my first accounting period that I want to enter 
data in (Peachtree setup)?

To make it easier to check your Quicken data, this should be the first period 
of your first fiscal year. 

Should I set up Peachtree for Real-time or Batch Posting?

For the conversion process, it is faster if you set up Peachtree in batch. Later, 
after your data is converted and you verify it, you can change to real-time 
posting.

What happens if I don’t select a Quicken payee as a vendor, 
employee, or customer?

The transactions are converted, but the “person” is not added as a vendor, 
employee, or customer.

When I start Peachtree Accounting and attempt to import the 
Quicken data, it says no QIF files found. What’s wrong?

When you exported in Quicken, did you specify the directory in which to put 
the files? Does each exported Quicken file have the QIF extension (for 
example, CHECKING.QIF.)?

In Peachtree Accounting, have you entered the directory correctly? You 
cannot type anything else after the directory name (for example, 
C:\EXPORT).
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I had over two years of data and I can’t get to some of my 
transactions from last year in Peachtree. What’s wrong?

Peachtree Accounting allows you to have access to 24 periods, or basically two 
years of data. If the dates of your Quicken data were before the first 
accounting period you entered during setup, these transactions cannot be 
displayed although the amounts for them are accounted for.

When I attempted to change to another accounting period, 
Peachtree said I had checks to print, but I didn’t write any. What’s 
the problem?

Did you have any balance adjustments or service charges in any Quicken 
accounts (checkbooks)? When you converted these, because they came out of 
your checkbook and they didn’t have any check number on them, Peachtree 
considers that they’re unprinted (therefore unpaid) checks.

To clear this up, select Payments from Peachtree Accounting’s Tasks menu, 
then click the Edit button. If there are any unnumbered “items” in the edit list, 
double-click on them to display them. If you have really made this payment 
(such as a service charge or balance adjustment), enter a special check number 
(such as SC1 or BA1) and post it.

What happened to my subcategories? They don’t roll up into my 
categories any more.

Peachtree Accounting uses a different technique to roll amounts into a main 
account. Read about account numbering and masking to learn more about 
how you can do this. We recommend that you read this before you perform 
the conversion because account numbers in Peachtree cannot be changed.

What are all the entries in this Retained Earnings account?

Quicken transactions that you did not allocate to a category or that have not 
been posted are put into your retained earnings account. One reason a 
transaction has not been posted would be because Peachtree considers it a 
check without a number (such as a service charge or balance adjustment).
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What happened to my invoice transactions I imported from 
Quicken Home & Business Edition?

Quicken Home & Business Edition allows you to invoice payees. These 
transactions are converted as separate General Journal entries and are not part 
of the Peachtree Accounting’s Sales/Invoicing system. To display Quicken 
invoices, you must display the General Journal from Peachtree Accounting’s 
Reports menu or select the Edit button in the General Journal Entry task 
window. To enter a receipt for a converted Quicken invoice, you must enter 
a cash sale in the Receipts window, selecting the accounts receivable account 
in the Apply to Revenues tab. For more information, see “Converting from 
Quicken 99” on page 215.
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• Converting QuickBooks and
   Data to Peachtree Accounting •

Overview
If you created a company using QuickBooks or QuickBooks Pro, you can 
convert your company data to the Peachtree Accounting format. Peachtree 
will convert most QuickBooks lists (such as accounts, customers, vendors, 
employees, items, and jobs) and current balances. 

Peachtree Accounting can only convert company data created in versions 4 or 
5 of both QuickBooks and QuickBooks Pro for Windows. You cannot convert 
company data from an earlier Windows version of QuickBooks or 
QuickBooks for DOS.

When Peachtree converts a QuickBooks company to the Peachtree 
Accounting format, all the QuickBooks data that Peachtree can convert is 
brought over. You cannot select which items to convert and which you do not 
want converted. If you convert data to Peachtree and decide you want to do 
the conversion once again, you must complete the entire conversion over 
again. 
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Preparing for the QuickBooks Conversion
Before converting company data to the Peachtree Accounting format, you 
must verify that your QuickBooks company is set up so that Peachtree can 
properly read your data.

Setting up QuickBooks

1 Start QuickBooks or QuickBooks Pro and open your company.

Verify your company name

First, you need to verify that your company data includes a valid company 
name. 

2 From the QuickBooks File menu, select Company Info. The Company 
Information window displays.

3 Verify that your company name is entered in the Legal Company Name 
field.

In this window, QuickBooks displays both the Company Name and 
Legal Company Name fields. Peachtree will convert what is entered in 
the Legal Company Name field as the name of your new Peachtree 
Accounting company.

If your company’s name is entirely numeric (for example, “90210”), or the 
Legal Company field is blank, Peachtree will assign your company’s name as 
“No Name.” After the conversion is complete, you can change your company 
name in Peachtree Accounting at any time.

4 When finished, select OK.

Verify that your chart of accounts uses account numbers

You must verify that the “Use account numbers” preference is activated in 
QuickBooks and that all accounts in your chart of accounts include account 
numbers. 

5 To verify that your chart of accounts uses account numbers, do one of the 
following:

• In QuickBooks (or QuickBooks Pro) Version 4: From the 
Preferences menu, select Transactions. The Transactions Preferences 
window displays.

• In QuickBooks (or QuickBooks Pro) Version 5: From the File 
menu, select Preferences. The Preferences window displays. Select 
Accounting from the Preference list.

Note
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6 Select the “Use account numbers” check box (if it is not already selected), 
then click OK.

7 From the Lists menu, select Chart of Accounts.

8 Scroll through your list of accounts and verify that each account has an 
account number as well as an account name. Account numbers can be up 
to eight alphanumeric characters in QuickBooks. 

QuickBooks may include “non-posting” accounts (for example, estimates) in 
your chart of accounts. Because these accounts do not impact the General 
Ledger, Peachtree will not convert these account types. Therefore, it is not 
necessary to assign account numbers to these accounts in QuickBooks.

Back up our QuickBooks company data

It is recommended that you back up your QuickBooks company data at this 
time. For information on backing up your data within QuickBooks, refer to 
the program's online Help or printed manuals.

Note
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Converting a QuickBooks Company
When converting a QuickBooks company, Peachtree will prompt you to 
locate your QuickBooks company data file (*.QBW). Peachtree will read 
information from this data file and create a new company in the Peachtree 
Accounting format.

Peachtree Accounting conversion does not change your QuickBooks data file. 
It creates a new set of data files and places them in the Peachtree Accounting 
data path.

Stepping Through the Conversion Process

To convert a QuickBooks company, do the following: 

1 If your QuickBooks company is open, close it or exit the QuickBooks 
application.

2 Start Peachtree Accounting.

3 You can begin the conversion process two ways:

• From the Peachtree Accounting Startup Screen: Select the “Convert 
a Quickbooks company to Peachtree Accounting” option. The Open 
Company window displays. If the Startup Screen does not appear 
when initially starting Peachtree Accounting, select View Startup 
Screen from the Options menu. Then, restart Peachtree Accounting.

 

Note

Select this option to
convert QuickBooks

data to Peachtree
Accounting.
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• From the File menu: Select Open Company. 

4 In the Open Company window, select QuickBooks as the company type (if 
it is not already selected).

5 Locate and select your QuickBooks company data file (for example, 
COMPANY.QBW). Then, select OK.

If you installed QuickBooks using the default settings, the company data 
file is located in the \QBOOKSW directory.

Peachtree will verify that the QuickBooks company selected is a valid 
one. If an error displays indicating that the company is not set up 
properly or Peachtree cannot read information from the company file, 
See “Troubleshooting the Conversion from QuickBooks” on page 280.

The Convert Company window displays general information about the 
conversion process. 

Select QuickBooks
as the company

type.

Select the
QuickBooks file that

represents your
company data.
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6 Select OK to begin the conversion.

7 Select an accounting method that you will be using for this company.

The accounting method determines how Peachtree Accounting handles 
General Ledger, Accounts Receivable, and Accounts Payable 
transactions. Cash and accrual are the two basic accounting methods 
used to run a business. You must select the method your company will 
use.

• Accrual: The accrual method records all entries at the time business 
is transacted, whether or not cash has been transferred. In most 
cases, companies that carry inventory or resell goods must use this 
method of accounting.

• Cash: The cash method recognizes transactions at the point you 
actually exchange cash. While the cash method is more common in 
service industries, some organizations may be restricted from using 
this method by the IRS.

Typically, the accrual method provides more accurate information 
regarding the financial status of your company. The cash method, on the 
other hand, may better serve your overall tax status. Consult your 
accountant about which method is best for you. If you choose the cash-
basis method, Peachtree will not convert your account balances. For 
more information, See “Setting Up a Cash-Basis Company” on 
page 278. 

Important: Once you choose the accounting method, you cannot 
change it for this company.

8 After selecting your new company’s accounting method, click OK. 

A warning message displays giving you one last chance to verify the 
accounting method. 
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9 Select Continue. 

This allows you to set up the number of accounting periods per year and 
to set a start and end date for each accounting period for two years. 
Below are the fields you can enter:

Number of Accounting Periods in the Fiscal Year: You can enter up to 
13 periods. Use 12 if you intend to use months as accounting periods; 
use 13 if you wish to have four weeks in your accounting period.

First Period in Which You Will Be Entering Data: Enter the number of 
the period in which you will begin entering transactions. Note: 
QuickBooks current balances are converted to Peachtree Accounting as 
of the day before the first period you chose to enter data. For more 
information, see “Understanding Balances after Converting from 
QuickBooks” on page 277.

Calendar Year: enter the first calendar year in which you plan to enter 
payroll. Payroll operates on a calendar year, regardless of fiscal year 
setup.

Current Fiscal Year Accounting Periods: place your cursor in the first 
column for the first accounting period, and enter the accounting period 
date in the MM/DD/YY format, and press the TAB key. 

The rest of the accounting period dates for the current fiscal year, as well 
as for the next fiscal year, will change according to the first period 
entered.

10 When you are finished, select OK. A warning message displays giving you 
one last chance to verify the dates. This will be your last and only chance to 
set up the accounting periods’ date and fiscal year structure. 
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11 Select Continue to save your entries and proceed with the conversion.

Peachtree begins the process of reading information from your 
QuickBooks data file and creating a new company in the Peachtree 
Accounting format.

During the conversion you are prompted to select default purchases and 
sales accounts. 

12 Select an account that will be assigned as the default purchase account for 
all vendors converted from QuickBooks. 

Peachtree requires that each vendor have a default purchase account 
(typically an expense or inventory account). This account is used as the 
default when entering purchases. After the conversion is complete, you 
can assign unique defaults for each vendor. You can also change the 
purchase account in invoicing or payments, if necessary.

13 Select an account that will be assigned as the default sales account for all 
customers converted from QuickBooks. 

Peachtree requires each customer to have a default sales account 
(typically an income account). This account automatically displays 
when entering sales. After the conversion is complete, you can assign 
unique defaults for each customer. You can also change the sales account 
in invoicing or receipts, if necessary.

When you are finished selecting the default accounts, select OK to 
continue the conversion process.

14 Choose the inventory costing method Peachtree will use when converting 
all inventory parts from QuickBooks. Choose between FIFO, LIFO, or 
Average Cost.

QuickBooks allows only the Average Cost costing method for inventory. 
When converting to Peachtree Accounting you have the opportunity to 
change this method. However, once a costing method is assigned to a stock 
item in Peachtree Accounting, it cannot be changed.

Check with your accountant if you are unsure as to which costing 
method to use.

Note
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15 When the conversion is complete, a message displays indicating that the 
QuickBooks company data was successfully converted. Select OK to display 
the Setup Checklist.

The Setup Checklist lets you know what you have set up for Peachtree 
Accounting. Each time you enter a function from the setup checklist 
you’ll be asked whether you want to mark the task as complete when you 
exit the task. If you select the Yes button, a check mark is placed next to 
the task. The following options have already been marked for you based 
on your QuickBooks data:

• Chart of Accounts

• Vendor Records

• Customer Records

• Employee Records

• Inventory Items and Assembly Records

• Job Records 

You can still access options that are check-marked; the mark just tracks 
your progress towards completing setup. Even though an item in the 
Setup Checklist is marked for completion, there are probably areas that 
still need to be modified after the conversion.

16 Select OK to close the Setup Checklist window.

To return to the setup checklist, select Setup Checklist from the 
Maintain menu.
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What QuickBooks Data Is Converted
Peachtree Accounting handles most accounting data differently than 
QuickBooks. During the conversion process, data may be reformatted to 
conform to Peachtree Accounting formatting standards. This section of the 
conversion guide explains the differences in data handling and offers 
suggestions to minimize the changes you have to make after the conversion. 
Some suggestions require you to make changes to your QuickBooks’ 
companies prior to the conversion. 

Peachtree will convert most lists in QuickBooks to the Peachtree Accounting 
format. Items that are converted to Peachtree Accounting include:

• company name and information

• chart of accounts and current balances for each account

• vendor records and current open balance

• customer records and current open balance

• customer sales taxes

• payroll setup information

• employee records and current year-to-date earnings 

• inventory items (stock items will also include current quantity on 
hand)

• job records

Peachtree cannot convert individual transactions found in QuickBooks. It 
will only establish the current balance for each record at the time of the 
conversion.

Field Comparison Lists

For detailed information on what and how individual QuickBooks fields are 
converted to Peachtree Accounting, refer to the Peachtree Accounting online 
Help. In the online index, search for “QuickBooks, field comparison lists.”

Converting Address Fields 

Peachtree and QuickBooks handle address fields differently. In QuickBooks 
addresses are entered in four one-line fields. You have the option of entering 
the address in any format you want. However, Peachtree addresses use 
individual fields for each component. Address Fields are used for company 
information, customers, vendors, and employees.
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In QuickBooks

In Peachtree

Because there are many variations to how you can enter addresses in 
QuickBooks, these fields may or may not convert as you would expect. To 
ensure accuracy and consistency, make sure your addresses are entered in 
QuickBooks using the U.S. Postal Service standard:

Address Line 1
Address Line 2 (optional)
City, ST Zip Code (the comma separation is optional)

State Abbreviations

When entering states try to use the standard U.S Postal Service two-character 
abbreviations. If you use something different, these characters may become 
part of the City field in Peachtree.
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Zip Codes

Peachtree can accept Zip codes using the five-digit format (XXXXX) and 
nine-digit format (either (XXXXXXXXX or XXXXX-XXXX). If the Zip code 
is entered on a separate line in QuickBooks it may or may not convert 
correctly to Peachtree. If this happens, you can easily correct the address after 
the conversion.

Employee Addresses

In QuickBooks, the employee’s name is automatically inserted as the first line 
of the employee address field. Peachtree will remove this for you when 
converting your company data. However, if you remove the employee name 
from the first line in QuickBooks and begin the address with the address line 
1, the address will not be converted properly in Peachtree.

Converting Company Information 

When converting QuickBooks company data, the QuickBooks Legal Name is 
used as the name of your Peachtree Accounting company. If the Legal 
Company Name field is blank, Peachtree will use the value in the Company 
Name field. Peachtree will also convert the first company address listed from 
QuickBooks, federal and state IDs, and the form of business. 

After converting the company data, you can change the company name and 
address in Peachtree Accounting at any time. 

➤ To display and modify company name and address information, select 
Company Information from the Maintain menu. The Maintain Company 
Information window displays.

The following company information fields are not available in QuickBooks 
and need to be set up in Peachtree Accounting:

• Company Telephone Number

• Company Fax Number

• State Unemployment ID

For detailed information on what and how QuickBooks company 
information is converted to Peachtree Accounting, refer to the Peachtree 
Accounting online Help. In the online index, search for “QuickBooks, field 
comparison lists.”
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Converting Chart of Accounts 

Before you can convert QuickBooks data, each account listed in the 
QuickBooks chart of accounts must have a unique account number. 
Peachtree uses the numbers as account IDs when selecting accounts from 
lookup lists. You cannot change the account IDs after the conversion is 
complete. If you want to change the ID, you must enter a new account in 
Peachtree Accounting’s and transfer the balance.

After converting the company data, you can examine and update your chart 
of accounts in Peachtree Accounting at any time. 

➤ To display and modify chart of accounts information, select Chart of 
Accounts from the Maintain menu. The Maintain Chart of Accounts 
window displays.

For detailed information on what and how QuickBooks account information 
is converted to Peachtree Accounting, refer to the Peachtree Accounting 
online Help. In the online index, search for “QuickBooks, field comparison 
lists.”

Retained Earnings Account

Peachtree requires that you have a Retained Earnings account. QuickBooks 
creates this account for you when initially setting up your company. During 
the conversion Peachtree will search for this account. If it cannot find one, 
you may have removed the account. 

To correct the error, you must force QuickBooks to create a new “Retained 
Earnings” account.

1 Start QuickBooks and open your company.

2 From the Reports menu, select Balance Sheet, then standard.

Displaying the balance sheet forces QuickBooks to search for a retained 
earnings account. If it cannot locate one, it will create a new one for you.

3 Close the report window, then try the conversion once again. 
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Accounts Payable and Accounts Receivable Accounts

If you set up vendors in QuickBooks, Peachtree will require an accounts 
payable account. If you set up customers in QuickBooks, Peachtree will 
require an accounts receivable account. 

During the conversion, Peachtree will prompt you to select default purchase 
and sales accounts. The purchase account selected (typically an expense 
account) will be assigned as the default for all vendors converted from 
QuickBooks. The sales account selected (typically an income account) will be 
assigned as the default for all customers converted from QuickBooks. After 
the conversion, you can assign unique defaults for each vendor and customer.

Non-Posting Accounts

QuickBooks lists non-posting accounts in its chart of accounts. These 
accounts do not impact the General Ledger and cannot be used in Peachtree 
Accounting. Therefore, they will not be converted.

Sub Accounts

Sub accounts, sub accounts of, descriptions, and bank numbers in 
QuickBooks are not converted to Peachtree. Each account in the Peachtree 
chart of accounts is unique. However, you can set up accounts that use 
department masking. For more information, refer to the “General Ledger” 
chapter of the Peachtree Accounting User’s Guide.

Budget Information

Budget information for each QuickBooks account is not converted to 
Peachtree. However, you can easily set these up in Peachtree after the 
conversion is complete. For more information, refer to the “General Ledger” 
chapter of the Peachtree Accounting User’s Guide. 

Account Balances

The current balance (at the time of the conversion) of each account listed in 
the General Ledger is converted as account beginning balances in Peachtree 
Accounting. Each account beginning balance is entered as of the day before 
the first period you chose to enter data during the conversion process. For 
more information, see “Understanding Balances after Converting from 
QuickBooks” on page 277. 
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Converting Customers 

If you have customers set up in QuickBooks, these records will be converted 
to the Peachtree Accounting format. Each converted customer is assigned a 
customer ID, which is derived from the customer name. You cannot change 
customer IDs after the conversion is complete. If you want to change the ID, 
you must enter a new customer in Peachtree Accounting.

After converting the company data, you can examine and update your 
customer records in Peachtree Accounting at any time. 

➤ To display and modify customer information, select Customers/Prospects 
from the Maintain menu. The Maintain Customers/Prospects window 
displays.

For detailed information on what and how QuickBooks customer 
information is converted to Peachtree Accounting, refer to the Peachtree 
Accounting online Help. In the online index, search for “QuickBooks, field 
comparison lists.”

Billing and Shipping Addresses

QuickBooks allows you one billing address and one shipping address per 
customer. These are converted to Peachtree Accounting format. Peachtree 
Accounting allows you to enter up to nine shipping addresses per customer. 

If your customer address fields were not converted properly, See “Converting 
Address Fields” on page 255.

Default Sales Account

Peachtree requires each customer to have a default sales account (typically an 
income account). During the conversion, you are prompted to select a default 
sales account for all the customers that are to be converted from QuickBooks. 
Each customer converted from QuickBooks is assigned the same sales account 
default. This account is used as the default when recording a sale. After the 
conversion, you may want to assign a unique sales account default for each of 
your customers. You can also change the sales account in invoicing or 
receipts, if necessary. 

The sales account default selected during the conversion process only applies 
to customers converted from QuickBooks. After the conversion is complete, 
you will still have to set up a Peachtree Accounting default sales account in 
Customer Defaults.

Note
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Terms

QuickBooks allows you to set up a list of terms. When setting up customers, 
you can select any one of the terms from the list. Peachtree sets up a single set 
of “standard terms” in Customer Defaults. Then, when setting up a customer, 
you choose whether or not the customer uses standard terms. All QuickBooks 
customers are converted as using non-standard terms, with each set of unique 
terms based on the terms listed in QuickBooks. 

After the conversion is complete, you need to set up standard terms for 
customers in Customer Defaults.

Sales Taxes

Each customer is assigned a default sales tax code. Peachtree will select the 
sales tax code that matches the tax item listed in the QuickBooks customer 
record. For more information on what sales tax information is converted, see 
“Converting Sales Taxes” on page 262.

Customer Jobs

In QuickBooks, jobs are a subset of the customer list. In Peachtree Accounting 
jobs are maintained as a separate list. For more information on jobs, see 
“Converting Jobs” on page 275.

Customer Beginning Balances

Peachtree converts the open balance (the sum of all outstanding invoices) as 
the customer’s beginning balance. This beginning balance is entered as of the 
day before the first period you chose to enter data during the conversion 
process. When you receive payment from a customer, you can enter it against 
the beginning balance total.

If a customer has a job associated with it, then the job’s open balance is 
converted as a separate beginning balance. See also, “Understanding Balances 
after Converting from QuickBooks” on page 277. 

Note: Each customer will have its own beginning balance.

Note
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Converting Sales Taxes 

In Peachtree Accounting sales taxes are set up as sales tax codes. Each sales tax 
code is made up of at least one sale tax authority. QuickBooks uses tax items 
and tax groups.

• Tax items: Each QuickBooks tax item (whether exempt or not) is 
converted to a sales tax authority, a component to Peachtree’s sales 
tax codes. Each tax item is also converted as its own Peachtree 
Accounting sales tax code.

• Tax groups: Each QuickBooks tax group is converted as a Peachtree 
Accounting sales tax code, containing their respective tax item 
components (now Peachtree sales tax authorities). 

After converting the company data, you can examine and update your sales 
taxes in Peachtree Accounting at any time. 

➤ To display and modify sales tax authority information, select Sales Taxes 
from the Maintain menu. Then, select Sales Tax Authorities. The Maintain 
Sales Tax Authorities window displays.

➤ To display and modify sales tax code information, select Sales Taxes from 
the Maintain menu. Then, select Sales Tax Codes. The Maintain Sales Tax 
Codes window displays.

For detailed information on what and how QuickBooks sales tax information 
is converted to Peachtree Accounting, refer to Peachtree Accounting’s online 
Help. In the online index, search for “QuickBooks, field comparison lists.”

For information on setting up sales taxes in Peachtree Accounting, refer to the 
“Accounts Receivable” chapter of the User’s Guide.

Converting Vendors 

If you have vendors set up in QuickBooks, these records will be converted to 
the Peachtree Accounting format. Each converted vendor is assigned a vendor 
ID, which is derived from the vendor name. You cannot change vendor IDs 
after the conversion is complete. If you want to change the ID, you must enter 
a new vendor in Peachtree Accounting.

➤ To display and modify vendor information, select Vendors from the 
Maintain menu. The Maintain Vendors window displays.

For detailed information on what and how QuickBooks vendor information 
is converted to Peachtree Accounting, refer to Peachtree Accounting’s online 
Help. In the online index, search for “QuickBooks, field comparison lists.”

If your vendor address fields were not converted properly, see “Converting 
Address Fields” on page 255.
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Default Purchase Account

Peachtree requires that each vendor have a default purchase account 
(typically an expense or inventory account). During the conversion, you are 
prompted to select a default purchase account for all the vendors that are to 
be converted from QuickBooks. Each vendor converted from QuickBooks is 
assigned the same purchase account default. This account is used as the 
default when recording a purchase. After the conversion, you may want to 
assign a unique purchase account default for each of your vendors. You can 
also change the purchase account in invoicing or payments, if necessary.

The purchase account default selected during the conversion process only 
applies to vendors converted from QuickBooks. After the conversion is 
complete, you will still have to set up a Peachtree Accounting default purchase 
account in Vendor Defaults.

Terms

QuickBooks allows you to set up a list of terms. When setting up vendors, you 
can select any one of the terms from the list. Peachtree sets up a single set of 
standard terms in Vendor Defaults. Then, when setting up a vendor, you 
choose whether or not the vendor uses standard terms. All QuickBooks 
vendors are converted as using non-standard terms, with each set of unique 
terms based on the terms listed in QuickBooks. 

After the conversion is complete, you need to set up standard terms for 
vendors in Vendor Defaults.

Vendor Beginning Balances

Peachtree converts the open balance (the sum of all outstanding invoices) as 
the vendor’s beginning balance. This beginning balance is entered as of the 
day before the first period you chose to enter data during the conversion 
process. When you need to pay a vendor, you can enter it against the 
beginning balance total.

See also,“Understanding Balances after Converting from QuickBooks” on 
page 277. 
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Converting Payroll Setup Information

If you have payroll set up in QuickBooks, Peachtree can convert most of the 
setup information to the Peachtree Accounting format. After the conversion, 
you have to update areas that could not be converted.

After converting the company data, you can examine and update your payroll 
setup in Peachtree Accounting at any time. You cannot rearrange the order 
that payroll fields are listed in Employee Defaults. This would impact balances 
that are converted from QuickBooks.

➤ To display and modify payroll setup, select Default Information from the 
Maintain menu. Then, select Employees. The Employee Defaults window 
displays.

For detailed information on what and how QuickBooks payroll setup 
information is converted to Peachtree Accounting, refer to the Peachtree 
Accounting online Help. In the online index, search for “QuickBooks, field 
comparison lists.”

Assign Payroll Fields for W-2s

Peachtree will convert standard federal and state W-2 information set up in 
QuickBooks. However, after the conversion is complete, you may want to 
make sure non-standard W-2 payroll fields are set up properly in Peachtree 
Accounting. W-2 setup information is used when calculating and printing 
certain payroll reports, 941 forms, W-2 forms, and W-3 forms. For more 
information, see “Assign W-2 Payroll Fields in Peachtree Accounting” on 
page 266.

Assign Payroll Fields for EmployEE- and EmployER-Paid Taxes

Peachtree will convert standard employee- and employer-paid tax 
information set up in QuickBooks. After the conversion is complete, you may 
want to make sure these payroll fields are set up properly in Peachtree 
Accounting. For more information, see “Assign Payroll Fields for EmployEE- 
and EmployER-Paid Taxes” on page 267.
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Deductions and Additions

If you set up miscellaneous deductions and additions In QuickBooks, these 
payroll items are converted to Peachtree Accounting as employee payroll 
fields in Employee Defaults. If you entered a set amount to be added to or 
subtracted from the adjusted gross total, these amounts will also be converted. 

QuickBooks allows you to enter percentage amounts when calculating payroll 
additions and deductions. Peachtree does not directly support percentages for 
deductions or additions. During the conversion percentages for additions and 
deductions are entered as whole numbers. For example, if a payroll item is set 
up to deduct 4%, Peachtree will convert this to a payroll field and enter –4.00 
in the Amount field (meaning it will subtract $4.00 dollars from the adjusted 
gross).

If you want Peachtree to calculate percentages, you must set up a company tax 
table. For more information, refer to the “Payroll” chapter of the Peachtree 
Accounting User’s Guide.

Local Withholding Taxes

If you set up a local tax payroll item in your QuickBooks company, the payroll 
item will be converted to Peachtree as a payroll field. However, after the 
conversion is complete, you must assign the appropriate local withholding tax 
table to the payroll field. This will allow the local payroll field to be properly 
calculated during payroll entry.

Note: If there is a balance for this field, it will be converted to Peachtree Accounting 
as an employee beginning balance.

QuickBooks only provides the following local tax types:

• Indiana Counties

• Michigan Cities

• New York City Resident

• New York City Non-Resident

• Ohio School District

• Yonkers City Resident

• Yonkers Non-Resident

These must be manually set up in Peachtree and assigned their corresponding 
local tax table.
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QuickBooks allows you to set up two localities for each employee. Peachtree 
will only allow one locality per employee.

For more information, see “Set Up Local Taxes after Converting from 
QuickBooks” on page 268.

Set Up 401(k) Contributions

Peachtree cannot convert 401(k) information you have set up in QuickBooks. 
However, the first payroll item that uses the “Deduction” or “Addition” type 
found in QuickBooks with 401(k) selected in the W-2 Tracking list will be 
converted to Peachtree Accounting as an “empty” 401(k) payroll field. You 
can use this field to set up 401(k) information in Peachtree Accounting.

Note: If there is a balance for this field, it will be converted to Peachtree Accounting 
as an employee beginning balance.

To set up 401(k) contributions in Peachtree Accounting, refer to the “Payroll” 
chapter of the Peachtree Accounting User’s Guide. You can skip the section on 
creating a 401(k) payroll field. Set up your payroll tax tables and employee 
information using the 401(k) payroll field converted from QuickBooks.

Assign W-2 Payroll Fields in Peachtree Accounting

1 From the Maintain menu, select Default Information, then Employees. The 
Employee Defaults window displays.

2 In the General tab, select the Assign Payroll fields for W-2s button.

3 Select the appropriate payroll field for each W-2 field. Below are examples 
of where to assign common payroll fields:

Box 2: FIT Withheld: Select your federal withholding payroll field (for 
example, “Federal Wit” or “Fed_Income”). After the converting payroll 
information from QuickBooks, Peachtree will assign this payroll field 
for you.

Box 4: FICA Withheld: Select your employee Social Security payroll 
field (for example, “Social Sec” (the first field listed with this field name) 
or “Soc_Sec”). After the converting payroll information from 
QuickBooks, Peachtree will assign this payroll field for you.

Box 6: Medicare Withheld: Select your employee Medicare payroll field 
(for example, “Medicare Em” or “Medicare”). After the converting 
payroll information from QuickBooks, Peachtree will assign this payroll 
field for you.
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266



What QuickBooks Data Is Converted
Converting Payroll Setup Information
Box 7: FICA Tips: Select your employee “Tips” payroll field if your 
employees record tips and you have set this payroll item up in 
QuickBooks or Peachtree Accounting.

Box 18: State Inc Tax: Select your state withholding payroll field (for 
example “GA With” or “GASIT”). After the converting payroll 
information from QuickBooks, Peachtree will assign this payroll field 
for you.

Box 21: Local Inc Tax: Select your local withholding payroll field, if 
applicable and set up.

QuickBooks permits you to assign multiple payroll items to W-2 boxes. In 
Peachtree Accounting you can assign only one payroll field per W-2 box. 

If you are unsure as to what fields should be assigned to W-2 boxes, consult 
with your accountant. 

4 When finished assigning the W-2 payroll fields, select OK.

Assign Payroll Fields for EmployEE- and EmployER-Paid Taxes

1 From the Maintain menu, select Default Information, then Employees. The 
Employee Defaults window displays.

2 In the General tab, select the “Assign Payroll fields for EmployEE Paid 
Taxes” button.

3 Select the appropriate payroll field for each employee-paid tax. These are 
the tax contributions that some states require as deductions from the 
employee's salary. Check your state's tax laws to be sure.

Disability: Select your state employee disability (SDI) payroll field, if 
required. If this payroll item was set up in QuickBooks, Peachtree will 
assign this payroll field for you.

Unemployment: Select your employee state unemployment payroll 
field, if required. If this payroll item was set up in QuickBooks, Peachtree 
will assign this payroll field for you.

Training Tax: Select your employee state training tax payroll field, if 
required.

4 When finished assigning the employee-paid tax payroll fields, select OK.

5 Select the “Assign Payroll fields for EmployER Paid Taxes” button.
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6 Select the appropriate payroll field for each employer-paid tax. These are 
the tax contributions that are required from the employer. Check your 
state’s tax laws to be sure.

Federal Unemployment (FUTA): Select your employer federal 
unemployment payroll field. This is required of all employers (for 
example, “Federal Une” or “FUTA_ER”). After the converting payroll 
information from QuickBooks, Peachtree will assign this payroll field 
for you.

State Unemployment (SUTA): Select your employer state 
unemployment payroll field. This is required of all employers (for 
example, “GA – Unempl” or “GASUI”). After the converting payroll 
information from QuickBooks, Peachtree will assign this payroll field 
for you.

State Disability Insurance: Select your employer state disability (SDI) 
payroll field (most states require this).

State Training Tax: Select your employer state training tax payroll field 
(some states require this).

State Special A and B: Some states require employers to pay additional, 
special taxes.

7  When finished assigning the employer-paid tax payroll fields, select OK.

8 Select OK in the Employee Defaults window to save your changes.

Set Up Local Taxes after Converting from QuickBooks

If you created a local payroll item in QuickBooks, this payroll field is 
converted to Peachtree Accounting. However, you must assign a local payroll 
tax table to ensure that the local tax is calculated during payroll entry.

QuickBooks allows you to setup two localities for each employee. Peachtree 
will only allow one locality per employee.

1 From the Maintain menu, select Default Information, then Employees. The 
Employee Defaults window displays.

2 Select the EmployEE Fields tab.
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3 Locate the local withholding payroll field that was converted from 
QuickBooks. QuickBooks only provides the following local tax types: 

• Indiana Counties

• Michigan Cities

• New York City Resident

• New York City Non-Resident

• Ohio School District

• Yonkers City Resident

• Yonkers Non-Resident

4 Select the Calculate check box.

5 Enter or select the tax ID that corresponds to your area, if required.

Peachtree names these payroll tax tables as XXLIT where XX represents 
your state’s two-letter abbreviation. Peachtree Accounting only includes 
certain local tax tables: COLIT, DELIT, MOLIT, and NYLIT.

If your local tax table is not present, you must set up the calculation. For 
more information, see Set Up Local Taxes after Converting from 
QuickBooks. 

6 Select the Adjust button to display the Calculated Adjusted Gross window.

7 Select the Gross check box, then select OK.

8 Select OK to save changes and close the Employee Defaults window.

Entering the Local W-2 ID field in Employee Setup

If an employee uses a local payroll item converted from QuickBooks, you 
need to make sure the filing status and W-2 ID information is set up correctly.

1 From the Maintain menu, select Employees/Sales Reps. The Maintain 
Employees/Sales Reps window displays.

2 Enter or select the employee ID that requires local tax.

3 Verify or change the Local Filing Status and Allowances fields. 

4 Enter the local W-2 ID that represents your locality. If your local tax uses one 
of the tax tables provided by Peachtree, enter the appropriate Local W-2 ID 
in the box provided.

If the tax table is provided by Peachtree, enter Local 1 as the Local W-2-ID (if 
it is not already selected). For more information on setting up local taxes, refer 
to the “Payroll” chapter of the Peachtree Accounting User’s Guide.
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Converting Employees 

If you have employees set up in QuickBooks, these records will be converted 
to the Peachtree Accounting format. Each converted employee is assigned an 
employee ID, which consists of the employee’s initials. You cannot change 
employee IDs after the conversion is complete. If you want to change the ID, 
you must enter a new employee in Peachtree Accounting (effectively loosing 
any associated balances).

After converting the company data, you can examine and update your 
employee records in Peachtree Accounting at any time. 

➤ To display and modify employee information, select Employees/Sales Reps 
from the Maintain menu. The Maintain Employee/Sales Reps window 
displays.

For detailed information on what and how QuickBooks employee 
information is converted to Peachtree Accounting, refer to the Peachtree 
Accounting online Help. In the online index, search for “QuickBooks, field 
comparison lists.”

Federal, State, and Local Filing Statuses

After converting your QuickBooks company data, you need to verify that each 
employee tax filing statuses are set up properly.

• Federal Filing Statuses: QuickBooks allows you to select from three 
filing statuses: Single, Married, and Head of HouseHold. Peachtree 
uses Single and Married filing statuses. If an employee converted 
from QuickBooks uses Head of Household federal filing status, 
Peachtree will convert it to Single.

• State Filing Statuses: If a QuickBooks employee uses a state filing 
status not available in Peachtree, then the first valid state filing status 
listed in Peachtree’s global tax tables for the respective state 
withholding tax table is selected. For more information, see Valid 
State Filing Statuses in Employee Setup. Make sure that each 
employee has a valid two-letter state abbreviation listed in the State 
W-2 ID box. This is used to determine the employee’s state 
withholding, if required. If your employee requires additional state 
withholdings, this too must be set up.

• Local Filing Statuses: Peachtree cannot convert local payroll 
information from QuickBooks. This must be manually set up in 
Peachtree Accounting and assigned its corresponding local tax table. 
Note: In QuickBooks you can set up two local tax payroll items for 
each employee. Peachtree only allows one locality.
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Pension and Deferred Check Boxes

Peachtree includes Pension and Deferred check boxes in the General tab of 
the Maintain Employees/Sales Reps window. These are primarily used for W-
2 purposes. Peachtree cannot convert this information from QuickBooks. 
This must be manually set up in Peachtree Accounting.

Select the “Pension” check box if an employee used QuickBooks payroll items 
referencing any of the following W-2 Tracking fields with the Calculate 
Adjusted Gross set so that the item affects the employee's payroll:

• SEC 457 Distribution

• 401(k)

• 403(b)

• 408(k)(6) SEP

• Elective 457(b)

• 501(c)(18)(d)

Select the “Deferred” check box if an employee used QuickBooks payroll 
items referencing any of the following W-2 Tracking fields with the Calculate 
Adjusted Gross set so that the item affects the employee's payroll:

• SEC 457 Distribution

• 401(k)

• 403(b)

• 408(k)(6) SEP

• Elective 457(b)

Hourly and Salary Pay Information

QuickBooks allows you to set up employees that use both hourly and salary 
payroll earnings. Hourly and salary earning field names are set up in 
Employee Defaults. In Peachtree Accounting, employees can only use one pay 
method. During the conversion, if the employee setup includes one or more 
payroll items that uses the “Yearly Salary” payroll type, this employee will be 
set up to use the Salary pay method in Peachtree Accounting. If the employee 
setup only includes payroll items that use the “Hourly Wage” payroll type, the 
employee will be set up to use the Hourly-Hours Per Pay Period pay method.
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Deductions and Additions

If you set up miscellaneous deductions and additions in QuickBooks, these 
payroll items are converted to Peachtree Accounting as employee payroll 
fields in Employee Defaults. If an employee does not use a standard amount 
or calculation for one of these fields, clear the Standard (STD) check box and 
enter the unique data. 

QuickBooks allows you to enter percentage amounts when calculating payroll 
additions and deductions. Peachtree does not directly support percentages for 
deductions or additions. During the conversion percentages for additions and 
deductions are entered as whole numbers. For example, if a payroll item is set 
up to deduct 4%, Peachtree will convert this to a payroll field and enter –4.00 
in the Amount field (meaning it will subtract $4.00 dollars from the adjusted 
gross).

If you want Peachtree to calculate percentages, you must set up a company tax 
table. For more information, refer to the “Payroll” chapter of the Peachtree 
Accounting User’s Guide.

Standard vs. Non-Standard Payroll Fields

All employees converted to Peachtree Accounting will have the STD 
(Standard) check box selected, indicating that they will use the default settings 
for each payroll field. If an employee does not use a standard amount or 
calculation for one of these fields, clear the Standard check box and enter the 
unique data.

Vacation and Sick Payroll Fields

Peachtree cannot convert Vacation and Sick earnings setup information in 
QuickBooks. These items will have to be set up in Peachtree Accounting. For 
more information, refer to the “Payroll” chapter of the Peachtree Accounting 
User’s Guide. 

Employee Beginning Balances

Peachtree converts the total year-to-date earnings for each payroll item 
converted from QuickBooks. These beginning balances are entered as of the 
day before the first period you chose to enter data during the conversion 
process. When you enter payroll transactions, year-to-date totals for each 
payroll field will be updated on each employee paycheck.

Note
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Converting Inventory Items

If you have inventory items set up in QuickBooks, they will be converted to 
the Peachtree Accounting format. You can set up stock, non-stock, assembly, 
labor, service, and description only items in Peachtree Accounting. Each 
inventory item is assigned an item ID, which is derived from the QuickBooks 
item name/number. You cannot change item IDs after the conversion is 
complete. If you want to change the ID, you must enter a new inventory item 
in Peachtree Accounting.

After the conversion is complete, you may want to update inventory item 
information.

➤ To display and modify inventory item information in Peachtree Accounting, 
select Inventory from the Maintain menu. The Maintain Inventory Items 
window displays.

For detailed information on what and how QuickBooks inventory 
information is converted to Peachtree Accounting, refer to the Peachtree 
Accounting online Help. In the online index, search for “QuickBooks, field 
comparison lists.”

The following fields cannot be converted or are not available in QuickBooks 
and can be optionally set up Peachtree Accounting:

• Reorder Quantity

• Unit of Measure

• Cost

• Note

For more information in setting up inventory items, refer to the “Inventory” 
chapter of the Peachtree Accounting User’s Guide.

Service and Labor Items

Peachtree will convert “Service” and “Other Charge” items from QuickBooks 
as “non-stock” inventory items in Peachtree Accounting. Peachtree also 
includes “Service” and “Labor” as inventory item classes. However, these 
Peachtree item classes require a default Salary/Wages expense account, which 
cannot be converted from QuickBooks. After the conversion is complete, you 
can change the item class to either Service or Labor and manually add the 
default Salary/Wages expense account.
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Group Items and Assemblies

Peachtree cannot convert group items: those items that contain a 
combination of other items. In QuickBooks, group items can contain 
inventory and non-inventory item components, which is not possible in 
Peachtree. You can create assemblies in Peachtree, which contain only 
inventory components.

For more information on setting up an assembly item, refer to the 
“Inventory” chapter of the Peachtree Accounting User’s Guide. 

Inventory General Ledger Accounts

Peachtree requires that you set up three default G/L accounts for each 
inventory item. These include a default sales account, inventory account, and 
cost of sales account. QuickBooks allows for subaccounts. If a parent account 
and subaccount are selected (PARENT:SUBACCOUNT) as a QuickBooks 
default, the subaccount is used as Peachtree’s G/L account default.

Costing Methods

Peachtree Accounting has three different types of cost methods for inventory:

• Average Cost 

• LIFO (last in, first out)

• FIFO (first in, first out)

Generally, all inventory items need to use the same costing method. Check 
with your accountant if you are unsure as to which costing method to use.

QuickBooks uses only one costing method-Weighted Average. All 
QuickBooks inventory parts are converted to Peachtree Accounting as stock 
items using the costing method selected during the conversion process. For 
more information about costing methods, refer to the “Inventory” chapter of 
the Peachtree Accounting User’s Guide.

You cannot change a costing method once a stock item is converted and set 
up in Peachtree Accounting. If you want to change costing methods, you must 
set up a new inventory item. Note
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Quantity on Hand Beginning Balances

The current number of an inventory part item on hand in QuickBooks is 
converted to Peachtree Accounting as the stock item’s beginning balance. The 
Peachtree Accounting beginning balance for inventory items includes the 
quantity, unit cost, and total cost of the inventory. You only use this when you 
first enter beginning balances. However, if you enter an incorrect unit cost for 
a beginning balance, this is the only place where you can change it. Do not use 
the Beginning Balances window to make adjustments to inventory for 
spoilage or theft; use the Inventory Adjustments option from the Tasks menu.

➤ To display and modify inventory beginning balances, select Inventory from 
the Maintain menu. The Maintain Inventory Items window displays. On the 
General tab, select Beginning Balances button.

Converting Jobs 

Job Costing allows you to track income and expenses for each project your 
company undertakes. In QuickBooks jobs are a subset of the customer list. In 
Peachtree Accounting jobs are maintained as a separate list. Peachtree allows 
you to enter job estimates and apply reimbursable expenses for jobs to 
customer invoices.

Each customer job is assigned a job ID, which is derived from the QuickBooks 
job name. You cannot change job IDs after the conversion is complete. If you 
want to change the ID, you must enter a new job in Peachtree Accounting.

After the conversion is complete, you can update job information in 
Peachtree Accounting at any time.

➤ To display and modify job information, select Jobs from the Maintain menu. 
The Maintain Jobs window displays.

➤ To display and modify payroll setup, select Default Information from the 
Maintain menu. Then, select Employees. The Employee Defaults window 
displays.

For detailed information on what and how QuickBooks job information is 
converted to Peachtree Accounting, refer to the Peachtree Accounting online 
Help. In the online index, search for “QuickBooks, field comparison lists.”
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The following fields cannot be converted or are not available in QuickBooks 
and can be optionally set up Peachtree Accounting:

• Supervisor

• % Complete

• PO Number

• Estimated Expense

• Estimated Revenue

For more information on setting up jobs, refer to the “Job Costing” chapter 
of the Users Guide.

Job Balances

Peachtree does not convert job balances from QuickBooks. In QuickBooks 
job balances are a reflection of open customer invoices; Peachtree Accounting 
handles job balances quite differently. Jobs are used for tracking projects. 
Transactions associated with jobs are included in vendor, employee, and 
customer balances. Job reports list transaction balances associated with the 
job, allowing you to manage estimated revenue and expenses, job 
profitability, and unbilled expenses.

Job beginning balances are entered in Peachtree to give a “snapshot” of the 
job’s progress at the time you start entering data in Peachtree Accounting. 
Once you start entering transactions in Peachtree Accounting, you can 
associate the job ID with each beginning balance, impacting the total job 
balance. For example, if you recorded $600.00 of job expenses prior to 
converting to Peachtree Accounting, enter this amount as a job beginning 
balance. As you record new transactions in Peachtree Accounting that need to 
be associated with the job, select the job ID in the task window.

Job beginning balances do not impact customer, vendor, or General Ledger 
balances.
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After Converting
After your company data has been imported into Peachtree Accounting, you 
have the final set up work to complete.

Understanding Balances after Converting from QuickBooks

While converting QuickBooks data, Peachtree will assign beginning balances 
to accounts, customers, vendors, employees, and inventory items that are 
converted. These balances represent the current balance in QuickBooks at the 
time of the conversion. For example, if you have $148.00 worth of 
outstanding purchase invoices due to a vendor, Peachtree will convert this 
amount as the vendor’s beginning balance.

QuickBooks current balances are converted to Peachtree Accounting as of 
the day before the first period you chose to enter data. During the 
conversion process you are prompted to set up accounting periods that will 
make up Peachtree's fiscal year. You must also enter the period number in 
which you will be first entering data.

For example, you are converting QuickBooks company data on 12/15/99. 
During the conversion, Peachtree prompts you to set up your accounting 
periods. If period 12 is set up as 12/1/99 to 12/31/99 and is also chosen as the 
first period in which you will be entering data, Peachtree will convert all 
balances as of 11/30/99 (not 12/15/99).

Peachtree will convert the “total” current balance of the record in 
QuickBooks. This means that if you entered transactions in future periods in 
QuickBooks, these amounts will also be included in account and record 
balances.

Peachtree Vendor and Customer Beginning Balances

Peachtree vendor and customer beginning balances are not posted to the 
General Ledger. These balances are assumed to already be present in the chart 
of accounts at the time of the conversion.

When you are ready to make a vendor payment or customer receipt, the 
balance will be available to write the transaction against.

Note
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For example, a vendor has a Peachtree beginning balance of $148.00 (the 
balance of open invoices in QuickBooks). To make a payment against this 
balance, do the following:

1 From the Tasks menu, select Payments. The Payments window displays.

2 Enter or select the vendor ID.

In the Apply to Invoices tab the $148.00 displays with a BEGBAL 
reference. This is a lump sum of all the outstanding invoices due at the 
time of the QuickBooks conversion.

3 Enter an amount to pay the vendor in the Amount Paid field.

4 When finished entering the payment, select the Print button to print a 
check. If you are not prepared to print the check, leave the check number 
field blank. If you manually wrote the check, enter a check number. Then 
select Post or Save to record the transaction.

For more information on entering payments, see Pay Vendors. For more 
information on entering receipts, see Receive a Payment from a 
Customer.

Setting Up a Cash-Basis Company 

Peachtree allows you to operate companies using two accounting methods:

• Accrual: The accrual method records all entries at the time business 
is transacted, whether or not cash has been transferred. In most 
cases, companies that carry inventory or resell goods must use this 
method of accounting.

• Cash: The cash method recognizes transactions at the point you 
actually exchange cash. While the cash method is more common in 
service industries, some organizations may be restricted from using 
this method by the IRS.

QuickBooks sets all its companies up using the accrual accounting method. 
However, QuickBooks allows you to display reports that reflect the cash-basis 
accounting method.

If, when converting your QuickBooks company, you choose to set up your 
new Peachtree Accounting company using the cash-basis accounting method, 
Peachtree will not convert chart of account balances. All other balances will 
be converted. After the conversion is complete, you will have to enter 
beginning balances in Peachtree’s chart of accounts.

For more information on entering account beginning balances, refer to the 
“General Ledger” chapter of the User’s Guide.
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Print the QuickBooks Trail Balance report using the cash-basis method. To 
do this, follow the procedure below:

1 From the QuickBooks Reports menu, select Other Reports, then Trial 
Balance. 

2 When the report displays, select the Customize button and choose Cash as 
the Report Basis. 

3 Select OK to display the report. Then, print the report.

You can then enter beginning balances for your accounts in Peachtree using 
this report as a guide.
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Troubleshooting the Conversion from QuickBooks

Below are key points that may help you resolve errors during the conversion 
process.

Common Errors

“No Name” Displays as Company Name after the Conversion

If your company name displays as “No Name” in Peachtree Accounting, it is 
possible that your company name in QuickBooks contains a value that 
Peachtree cannot read or accept. Peachtree first uses the Company Legal 
Name. If this field is blank, Peachtree will use the Company Name field (both 
fields display in the QuickBooks Company Information window) as the name 
of your company in Peachtree Accounting. If both fields are blank or entirely 
numeric, Peachtree will convert the company as “No Name.” After the 
conversion you can easily change the company name in Peachtree 
Accounting.

Accounts Do Not Have Account Numbers

You must have account numbers established for each account in your 
QuickBooks chart of accounts before beginning the conversion. To add 
account numbers to your QuickBooks chart of accounts, refer to the 
procedure described in. “Preparing for the QuickBooks Conversion” on 
page 247.

Retained Earnings Account Not Found

Peachtree requires that you have a retained earnings account in the chart of 
accounts. If Peachtree cannot locate the account, you will receive an error. 
QuickBooks automatically creates the retained earnings account for you 
when setting up your company. It is possible that you removed this account. 
To correct the error, you must force QuickBooks to create a new “Retained 
Earnings” account.

1 Start QuickBooks and open your company.

2 From the Reports menu, select Balance Sheet, then standard.

Displaying the balance sheet forces QuickBooks to search for a retained 
earnings account. If it cannot locate one, it will create a new one for you.

3 Close the report window, then try the conversion once again. 
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Accounts Payable and Accounts Receivable Accounts Not Found

If you have one or more vendors set up in QuickBooks, you must have an 
accounts payable account listed in your chart of accounts before beginning 
the conversion. If one or more customers, you must have at least one accounts 
receivable account set up in your chart of accounts before beginning the 
conversion.

Company Already Exists and Cannot be Converted

You can only step through the conversion of a QuickBooks company one 
time. If you intend to try the conversion again, you must rename your 
QuickBooks company.

Rename a Company in QuickBooks

1 Start QuickBooks and open your company.

2 From the QuickBooks File menu, select Company Info. The Company 
Information window displays.

3 In the Legal Name field, enter a different company name for your 
QuickBooks company. 

Peachtree Accounting first uses the “Legal Company Name,” then the 
“Company Name” of your QuickBooks company when converting the 
data.

4 When finished, select OK. Close the company and try the conversion once 
again.

After your company is converted to Peachtree Accounting format, you 
can change the company name in Peachtree to anything you choose.

Troubleshooting Error Messages

If you receive an error message during the conversion process, select the Help 
button when the message displays.Peachtree Accounting ‘s online Help 
provides information about the message and possible solutions to correct the 
error.

➤ To display an alphabetical list of error messages, open the Peachtree online 
Help. (From the Help menu select Contents). In the Help Topics window, 
select the Contents tab. Select Reference, then Troubleshooting Error 
Messages.
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Comparing QuickBooks to Peachtree

Obviously, Peachtree manages certain aspects of accounting differently from 
that of QuickBooks. This section outlines major differences in the tasks and 
features of each accounting package to assist you in becoming more familiar 
with Peachtree and to make the transition less difficult.

Accounting Methods

The accounting method determines how Peachtree Accounting handles 
General Ledger, Accounts Receivable, and Accounts Payable 
transactions. Typically, the accrual method provides more accurate 
information regarding the financial status of your company. The cash 
method, on the other hand, may better serve your overall tax status. 
Consult your accountant about which method is best for you. 

Peachtree allows you to operate companies using two accounting 
methods:

• Accrual: The accrual method records all entries at the time business 
is transacted, whether or not cash has been transferred. In most 
cases, companies that carry inventory or resell goods must use this 
method of accounting.

• Cash: The cash method recognizes transactions at the point you 
actually exchange cash. While the cash method is more common in 
service industries, some organizations may be restricted from using 
this method by the IRS.

QuickBooks sets all its companies up using the accrual accounting method.

The type of accounting method this company uses is located on the Maintain 
Company Information window.

Once you set up the accounting method for this company, you cannot change 
it. If you want to change the accounting method, you must delete the 
company and re-enter it. Refer to step 7 on page 251 to find out what method 
you selected during the conversion process.

Note
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Inventory
Inventory

Inventory Costing Method

QuickBooks allows only the Average Cost costing method for inventory. In 
Peachtree, however, you have the opportunity to change this method. 
Peachtree offers three different costing methods for inventory: FIFO (First In 
First Out), LIFO (Last In First Out), and Average Cost. To gain a better 
understanding of these methods, refer to the “Inventory” chapter of the 
Peachtree Accounting User’s Guide

Once a costing method is assigned to a stock item in Peachtree Accounting, it 
cannot be changed.Check with your accountant if you are unsure as to which 
costing method to use.

Company Information

The company information in QuickBooks and Peachtree is relatively similar 
with only a few exceptions. In QuickBooks, there are two areas for your 
company’s address: the Company Name and the Legal Name. In Peachtree, 
however, there is only the Company Name field. Furthermore, the Income 
Tax Form Used equates to the Form of Business. There are, however, four 
fields Peachtree requires that QuickBooks does not. These are:

• Company Telephone Number

• Company Fax Number

• State Unemployment ID

• Posting Method

Peachtree also lists the accounting method this company uses and provides 
you with audit trail and time and attendance options. For more information 
on these options, see the Peachtree Accounting User’s Guide.

Note
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Tasks

The following table lists the chief tasks associated with the main sections of 
QuickBooks and Peachtree.

 Major Tasks

Feature Main Task QuickBooks Peachtree

Inventory Setting Up 
Inventory Items

Purchases and Vendors/
Items and Services

Maintain Inventory Items 
window

Company 
Information

Adding or 
Editing 
Company 
Information

Company/Company Info Maintain Company 
Information window
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